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About Chancery SMS
Welcome to Chancery SMS® from Pearson. Chancery SMS is a software tool for managing 
student and family information in your school district.

Support Services Available
Chancery offers a full suite of documentation, online Help, and technical support to help you 
with your day-to-day tasks.

Documentation Included
The following documentation is included with Chancery SMS:

See For

Chancery SMS Guides The following guides are available in PDF format from our 
support web site at http://support.chancery.com:

• District Administration Guide: For district administrators, the 
District Administration Guide provides information about 
maintaining the centralized Chancery SMS solution, including 
setting up your district, adding schools to the district, and 
standardizing data across the district using setup lists.

• District User Guide: For district office staff, the District User 
Guide provides information about using Chancery SMS at a 
district level, including registering and enrolling students and 
working with student data.

• School Administration Guide: For school administrators, the 
School Administration Guide provides information about 
maintaining a school and performing administrative tasks.

• School Setup Guide: The School Setup Guide provides 
information about setting up schools in the district, including 
the steps to be performed as a district administrator and as a 
school administrator.

• School User Guide: For school office staff, the School User 
Guide provides information about using Chancery SMS at the 
school level, including how to take attendance, enter grades, 
and work with student data in the office.

• Chancery SMS in the Classroom: This guide covers the basics 
of using Chancery SMS at the homeroom and class level, 
including how to take attendance, enter grades, and work 
with student data in the classroom.
About Chancery SMS 1
Support Services Available



Chancery SMS Scheduling Guide
Chancery SMS Speciality Guides Additional feature-specific guides to supplement the standard 
guides are available in PDF format from our support web site at 
http://support.chancery.com:

• Address Validation Guide: For school and district 
administrators, the Address Validation Guide provides 
information about setting up address validation at the district 
and performing address validation tasks at the district and at 
schools.

• cTools Guide: This guide provides information about 
customizing Chancery SMS, along with instructions for using 
the customization features.

• Grading Setup Guide: For school administrators, the Grading 
Setup Guide provides information about setting up grading 
properties and performing grading-related tasks.

• Permissions Guide: For district administrators, this guide 
provides information about setting up permissions in 
Chancery SMS. The Permissions Guide explains the 
permission structure and provides information about each 
permission’s dependencies, effect on the system, options, 
and defaults. 

• Program Management Guide: For district and school 
administrators and district and school staff who enroll 
students and process applications, the Program Management 
Guide is a feature-specific guide that describes the process of 
setting up programs at the district and at schools and 
performing program-related tasks.

• Registration and Enrollment Quick Guide: For school and 
district staff, the Registration and Enrollment Quick Guide 
provides procedures for registering students in the district 
and enrolling students in schools.

• Scheduling Guide: For school administrators, the Scheduling 
Guide covers the process of setting up a school scheduling 
structure, as well as scheduling in elementary and secondary 
schools.

• Next-Year Preparation and Year-End Processing Guide: For 
district and school administrators, this guide covers all the 
steps required to close off the current school year and 
prepare for the next.

See For
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Getting Training
Training courses are available to help ensure you get every advantage from your student 
information system. We are committed to helping you put our solutions to work. Our broad 
training offerings are designed with you in mind so that you’ll receive the most suitable and 
effective training for your needs.

Choose from on site training or live online training. We can also create a customized training 
program to meet your district’s needs.

Phone us toll free at 1-800-999-9931 or see the Training area of our customer support web 
site at http://support.chancery.com for an up-to-date list of scheduled courses.

Chancery SMS Technical Guides Technical guides are available in PDF format from our support 
web site at http://support.chancery.com:

• Import/Export Guide: For district administrators, the 
Import/Export Guide describes the process for importing and 
exporting data into and out of Chancery SMS.

• Interoperability Guide: For district administrators, the 
Interoperability Guide covers how to integrate third-party 
applications with Chancery SMS using SIF and Import/Export 
functionality.

• Report Writer Guide: For district and school administrators 
and third-party report writers, the Report Writer Guide covers 
how to plan, build, and upload reports using the new 
reporting framework. The guide also includes an in-depth 
examination of this framework, extensive information about 
how to use Crystal Reports® functionality, and reference 
material about using previous reporting methods.

Chancery SMS Online Help Help is available by accessing the Help menu from the task bar.

Release Notes Release Notes are summaries of the new features and changes 
in the current release.

Installation Documentation The Installation Guide provides technical details for installing 
the entire Chancery SMS system.

The Upgrade Guide provides detailed instructions for upgrading 
from a prior version of Chancery SMS.

See For
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Getting Support
The following support programs are available by subscription only:

For more information about Technical Support Programs, phone Customer Service at  
1-800-999-9931.

Support Description

One-on-one Technical Support Talk to a technical support analyst to help solve problems 
and answer questions when software doesn’t produce the 
expected results. Analysts can use the telephone or Internet 
access to troubleshoot your issues.

Monday to Friday, 5 am to 5 pm Pacific Time 
Phone: 1-800-688-9939 
Fax: 1-800-446-5650 
Email: psstechsupp@pearson.com

Access to our web site http://support.chancery.com
In Chancery SMS, from the Help menu, click Support 
Website.

Our web site includes a searchable KnowledgeBase with 
frequently asked questions, tips, and troubleshooting 
instructions, as well as support forums for users to share 
experience and knowledge.

Software updates Releases of new versions with improved functions and 
software updates. Updates are provided free of charge for 
three months from your date of purchase and are included in 
the subscription to Support Programs.
4 About Chancery SMS
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Scheduling Overview
Scheduling involves specifying how courses or subjects are offered at your school, assigning 
teachers and rooms to courses or subjects, and finally creating student schedules. Typically, 
you create the initial schedule in a planning calendar. After you run Year End Processing 
(YEP), the planning calendar becomes the active calendar and you continue to make 
adjustments to the school schedule throughout the school year. Some scheduling tasks can 
only be completed in the planning calendar and others can only be completed in the active 
calendar. 

Chancery SMS provides two scheduling methods: elementary school and secondary school. 
Before you begin scheduling your school, determine the method best suited to your school 
and select the scheduling method you will use. 

NOTE

Once you create schedules, you cannot change the scheduling method.

Since scheduling is significantly different for elementary and secondary schools, the 
remainder of this guide is divided into two sections. Once you determine the type of 
scheduling your school requires, refer to the appropriate section for the type of scheduling 
your school uses:

• “Section 1: Elementary Scheduling” on page 15

• “Section 2: Secondary Scheduling” on page 121

Understanding Chancery SMS Scheduling Options (for 
Win School and Mac School Users)
This section is for former Win School and Mac School users only. If you are new to 
Chancery SMS, this is a summary of how Chancery SMS handles some of the Win School and 
Mac School scheduling options you are familiar with.

Option Description

Lookahead Master Schedule Builder (Schedule Classes) already examines all 
possible room and teacher combinations that can be assigned to 
each class before it actually schedules the class into the master 
schedule. 

Schedule only selected courses This is always on as only selected courses are scheduled.

Keep teachers in homerooms This is now in the Use Teacher Room Preferences option.

Ignore rooms and teachers You can achieve this by turning off the Use Teacher Room 
Preferences and Use Course Room Preferences options.

Allowable potential conflicts This is not needed as Master Schedule Builder uses a scheduling 
algorithm that minimizes conflicts.

Select teacher for class from 
course preferences or from load 
teachers

This is not needed as Master Schedule Builder uses both options.

Start scheduling with special 
courses or normal courses

This is not needed as Master Schedule Builder gives priority to 
the most constrained courses first. You can also select specific 
courses that you want to schedule first.

When problems occur, stop, 
pause, or continue

This is not needed as scheduling will always finish and generate a 
detailed log.
Scheduling Overview 5
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Differences Between Elementary and Secondary 
Scheduling Methods
Since scheduling in elementary schools can be significantly different from scheduling in 
secondary schools, Chancery SMS offers two methods of scheduling: elementary school and 
secondary school. 

The elementary school scheduling method is suitable for schools with the following 
characteristics:

• The school schedule is primarily structured around homerooms.

• The homeroom teacher teaches most of the subjects to the same group of students. You 
can adjust individual student schedules by transferring them to other classes, as well as 
by using subject exceptions and resource assignments to support special cases.

The secondary school scheduling method is suitable for schools with the following 
characteristics:

• Students choose some or all the courses they want to take.

• For each class, students go to a different room with a different group of students.

• Different bell schedules or different start and end dates for each term are needed to 
accommodate the needs of different groups of students. (Data mapping does not support 
different bell schedules.)

• Complex meeting patterns are required.

• Teams or “platoons” of students are rotated through a series of “exploratory” classes 
(middle schools).

Pre-check This information is in the Scheduling Pre-Check Report.

Optimize Master Schedule Builder (Schedule Classes) always optimizes the 
master schedule by moving classes to different meeting patterns 
(periods) in the school day to obtain a better master schedule.

Period scrambling This is not needed. Use meeting patterns to achieve this.

Doubles together This is not applicable in Chancery SMS as the meeting patterns 
defined for the class determine where doubles will be assigned in 
the master schedule.

Force same period each day This can be controlled at the course level by assigning specific 
courses a set of meeting patterns that load the sections of the 
course to the same period each day. 

Option Description
6 Scheduling Overview
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The following table shows the basic differences between the elementary school scheduling 
method and secondary school scheduling method, including differences in terminology:

Selecting the Scheduling Method
Once you decide which scheduling method is best suited to your school, select the scheduling 
method. The scheduling method you select determines the type of attendance, grading, and 
report cards that are available. 

You specify the scheduling method when you set up general attendance and scheduling 
settings for your school. 

NOTE

Once you create schedules, you cannot change the scheduling method (e.g., from elementary to 
secondary scheduling or secondary to elementary scheduling). 

To select the scheduling method:
1 Log on as a school administrator.

2 In the control bar, under Admin, click School Setup.

3 On the School Setup page, under School, click General Settings.

Elementary School Secondary School

Students usually stay together for most of the 
day in a room called the homeroom.

For each class, students usually go to a different 
room with different students.

The homeroom, if used, is usually only for 
announcements.

Students in each grade are usually assigned the 
same set of subjects, which they take for the 
whole school year.

Offers flexible terms that support any 
combination of semesters, quarters, or middle 
school style class rotations.

Students make individual course requests.

Uses the terms “subject” and “subject 
framework”.

You use the subject framework and subjects for 
scheduling.

Uses the terms “course” and “course catalog” or 
“course list”.

You use the course catalog or course list and 
courses for scheduling.

Subjects are offered as core or specialty 
subjects.

Courses are offered as required or elective 
courses.

The grading structure is relatively simple. The grading structure is more complex.

You can take once daily or twice daily 
attendance. You cannot take attendance by 
class.

You can take once daily, twice daily, or class 
attendance.

Chancery SMS uses the elementary school style 
of report cards, including grading table options.

Chancery SMS uses the secondary school style of 
report cards, including grading table options.
Scheduling Overview 7
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4 On the General Settings page, under Scheduling General Settings, select the method 
your school uses for scheduling.

5 Click OK.

Defining Contiguous Periods
Contiguous class periods are classes that span multiple periods but should be considered a 
single class, for example, a chemistry class and chemistry lab scheduled into adjacent 
periods. 

For attendance calculations when the attendance method is set to By Class and for 
instructional minute calculations, Chancery SMS can consider two classes scheduled into 
adjacent periods to be the same class. 

Multi-period classes are considered contiguous when the classes satisfy the following 
requirements:

• Both classes have the same name. For example, two consecutive classes named 
Chemistry and Chemistry Lab are always treated as two classes; while two consecutive 
classes named Science are considered a single class if they meet the passing minutes 
requirement.

• The number of passing time minutes between the two consecutive classes does not 
exceed the number specified in the “Class periods are contiguous if separated by no more 
than nn passing time minutes” field.

For example, if you set the passing time minutes to 8 minutes and your school allows 5 
minutes between classes for students to get to the next class then a two-period class is 
considered one contiguous class (5 is less than 8). If your school’s bell schedule has 10 
minutes between classes then a two-period class is considered two classes (10 is more 
than 8).

To specify the number of passing minutes for contiguous classes:
1 Log on as a school administrator.

2 In the control bar, under Admin, click School Setup.

3 On the School Setup page, under School, click General Settings.
8 Scheduling Overview
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4 On the General Settings page, under Scheduling General Settings, specify the maximum 
number of minutes that can separate contiguous classes.

5 Click OK.

Switching to the School Planning Calendar
If you are scheduling your school for the next calendar year, you may need to work in the 
planning calendar. The planning calendar gives you a different view of Chancery SMS so you 
can access only the features that apply to Next Year Preparation. You can switch between the 
active calendar and the planning calendar at any time. 

For more information about planning calendars, see the Chancery SMS School Setup Guide.

To switch calendars:
1 Log on as a school administrator.

2 Do one of the following:

• From the Actions menu, click Switch Calendar.

• In the control bar, click School Setup. On the School Setup page, under Calendar, click 
School Calendars.

3 On the School Calendars page, in the Work With column, click the button next to the 
calendar you want to work with.

4 Click OK.

Planning Calendar appears at the top of the control bar. 

Switch to a calendar by selecting 
Work With in the appropriate row
Scheduling Overview 9
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Working With Student Records
When you set up student schedules, you may need to work with student records. In 
Chancery SMS, there are several ways to open student records. For example, you can open a 
student record from any type of roster, such as a homeroom roster, class roster, or 
attendance roster. On any page that contains a list of students, you can click the student 
record you want to open.

Task Procedure

Open a student record from a 
homeroom roster

1 In the control bar, under Class, click Homerooms.

2 On the Homerooms page, in the HR column, click the 
homeroom the student is in.

OR

In the Roster column, click the Roster icon.

3 On the Roster page, click the student record you want to view 
or edit.

Open a student record from a list 
of search results

1 Perform a Quick, Basic, or Detailed Search.

2 On the Student Search Results page, from the Student Name 
column, click the student record you want to view or edit.
10 Scheduling Overview
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Open a student record from a 
saved list

1 On the Quick Search page, under Saved Lists, click the saved 
list the student is part of.

2 On the Student Search Results page, from the Student Name 
column, click the student record you want to view or edit.

Open a student record from the 
Scheduling page

(Elementary schools only)

1 In the control bar, under Admin, click Scheduling.

2 On the Scheduling page, under Step 5, click Student Search.

3 Perform a Basic or Detailed search or click Display All Records.

4 From the Search Results, from the Student Name column, click 
the student record you want to view or edit.

Task Procedure
Scheduling Overview 11
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Open a student record from the 
scheduling page

(Secondary schools only)

1 In the control bar, under Admin, click Scheduling.

2 If you are using the active calendar, on the Scheduling page, 
under Step 6, click Load Students.

OR

If you are using a planning calendar, on the Scheduling page, 
under Step 7, click Load Students.

3 Perform a Basic or Detailed search or click Display All Records.

4 From the Search Results, from the Student Name column, click 
the student record you want to view or edit.

Task Procedure
12 Scheduling Overview
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Data Mapping Constraints for Scheduling
As Chancery SMS continues to mature and we strive to improve and enhance the existing 
architecture, we do have some constraints on the systems due to “legacy” code 
development, code which dates back to the original versions of the product. The “legacy” 
architecture necessitates data setup constraints, which then require a data mapping process 
to consolidate the data in the common tables.

If your district relies on data mapping, make sure you understand and follow the documented 
data setup constraints. For more information, see the Data Mapping Constraints Technical 
Bulletin, available for download from the Chancery Support web site.

There are a number of scheduling data setup constraints to be aware of. If your scheduling 
data is not set up to support these constraints, data mapping might fail or data will not be 
reported or uploaded correctly. If you are not using data mapping, you do not need to set up 
your data to support these constraints. 

IMPORTANT NOTE

For Tennessee customers only: EIS Reporting requires data mapping. Make sure your data is set up to 
support these constraints.

NOTE

Schools maintaining data in Win School or Mac School are not required to run data mapping.

Period Structure
The period structure is part of a bell schedule. To set up a bell schedule, go to Scheduling > 
Bell Schedules > Add Period page. For more information, see “Setting Up Bell Schedules” on 
page 33 for elementary schools or “Setting Up Bell Schedules” on page 184 for secondary 
schools.

• Each day in the day pattern must have the same bell schedule/period structure, including 
the same periods and the same number of instructional minutes in periods with the same 
code. For example, if on Monday, period 1 had 50 instructional minutes, period 1 must 
have 50 instructional minutes for every day in the day pattern. Periods within one day 
can have different amounts of instructional minutes.

• Each day in the day pattern can have a maximum of 42 periods.

• Periods cannot overlap.

• If more than one scheduling group is defined (e.g., to support exception days), the bell 
schedule must be the same in both scheduling groups, that is, the period codes and 
period start and end times must be the same.

Special Days
Special Days are not supported. Use the same bell pattern for all days in the day pattern. You 
can create different meeting patterns based on the bell schedule to accommodate different 
class types.

For more information about setting up meeting patterns, see “Creating Meeting Patterns” on 
page 39 for elementary schools or “Setting Up Meeting Patterns” on page 190 for secondary 
schools. 
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Terms
Elementary school scheduling does not support multiple terms.

For Secondary Schools, define terms on the Scheduling > Term Sets > Add Term Set page. 
For more information, see “Setting Up Scheduling Term Sets” on page 173.

• You can define a maximum of 12 unique term ranges for each school year. If you can 
combine terms to form another term, that term does not count toward the maximum 
number of allowed terms. For example, if you have three term sets (year, quarters, and 
semesters) then the total number of terms is seven (1 + 4 + 2). However, since you can 
combine the quarters to form both the semesters and the year, only the four terms in the 
quarters are counted toward the maximum number of terms.

• Terms within the same term set cannot overlap.

Class Attributes
Based on the course catalog created at the district, create classes for all courses taught at a 
school. Class information for secondary schools is entered on the Scheduling > Master 
Schedule page. For more information, see “Creating the School Master Schedule” on 
page 265. For elementary schools, it is entered on the Scheduling > Class Setup page. For 
more information, see “Setting Up Classes” on page 71.

Each time a class meets, the room and each of the assigned teachers can differ from any 
other time a class meets.

Class Teachers
When you create classes, assign up to three teachers to a class. For secondary schools, this 
information is entered on the Scheduling > Master Schedule page. For more information, see 
“Creating the School Master Schedule” on page 265. For elementary schools, it is entered on 
the Scheduling > Class Setup page. For more information, see “Setting Up Classes” on 
page 71. 

• Teacher 1 maps to Main Teacher.

• Teacher 2 maps to Team Teacher.

• Teacher 3 maps to Teacher Aide.

Reservation Labels
Data mapping does not copy reservation labels. 
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In elementary school scheduling, all students are assigned to homerooms. Based on their 
homeroom assignments, students are automatically assigned to core classes. You can then 
adjust individual student schedules by assigning specialty classes, subject exceptions, or 
resource services. You can also transfer students to other classes. If desired, you can create 
a schedule structure and assign meeting patterns to classes. Using a schedule structure 
allows you to track instructional minutes for classes, but it is not required for elementary 
school scheduling. 

NOTE

For Tennessee customers only: EIS reporting does not use the schedule structure when calculating 
instructional minutes. Enter class schedule information in the Assigned Period and Duration fields by 
clicking the Custom link on the Class Setup page. For more information, see “Setting Up Classes by 
Subject” on page 75.

Scheduling in Planning and Active Calendars
Although you will likely adjust the scheduling setup throughout the school year, most 
scheduling tasks are completed in the planning calendar. When you schedule your 
elementary school in the planning calendar, you likely follow distinct steps. These steps are 
represented on the Scheduling page to help you proceed through the scheduling process. For 
each step, the Scheduling page shows statistics that help you determine the current status of 
the step.

NOTE

If the statistics do not seem correct, you can update statistics to refresh the calculations. For more 
information, see “Updating Statistics” on page 16. 

In the planning calendar, the steps do not include any tasks that must be completed in the 
active calendar, such as setting up resource services.

Planning Calendar 
Scheduling page 
includes 
scheduling steps 
available in the 
planning calendar.

The right column 
displays statistics 
that show the 
status of each 
step. 
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When you work in the active calendar, the Scheduling page still displays the tasks as steps. 
However, when you work in the active calendar, the initial schedule is usually already set up 
and you do not need to follow the steps in order. You will likely revisit steps as required. 

Updating Statistics
Scheduling statistics appear on the Scheduling page to indicate the status of the scheduling 
steps. As you work through the steps for scheduling, these statistics may not refresh 
automatically. If the numbers do not seem correct, you can update the statistics. 

NOTE

Updating statistics may affect performance in Chancery SMS. It should not be necessary to update 
statistics as part of your regular processing. If statistics are frequently incorrect, contact technical 
support for assistance. 

To update statistics:
1 Log on as a school administrator at an elementary school. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, from the Actions menu, click Update Statistics. 

4 Click OK. 

Elementary Scheduling Overview
The following steps describe the overall process of scheduling for elementary schools:

Step 1 - Set Up Basic Scheduling Elements
Make sure staff, rooms, and subjects are set up correctly for your school. See “Setting Up 
Basic Scheduling Elements” on page 23.

In the Active 
Calendar, 
scheduling tasks 
are shown as steps 
although once the 
initial schedule is 
set up, you need 
not follow the 
steps in order. 

The right column 
displays statistics 
that show the 
status of each 
step. 
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Step 2 - Set Up the Schedule Structure (optional)
If you want to track instructional minutes, you must set up the schedule structure. When you 
set up the schedule structure, you define scheduling groups, day patterns, bell schedules, 
meeting patterns, and scheduling defaults that are used to schedule classes for specific 
times. You can then create reports to track the number of minutes allocated to each class. 
For more information about the scheduling structure, see “Setting Up the Scheduling 
Structure” on page 27.

NOTE

For Tennessee customers only: EIS reporting does not use the schedule structure when calculating 
instructional minutes. Enter class schedule information in the Assigned Period and Duration fields by 
clicking the Custom link on the Class Setup page. For more information, see “Setting Up Classes by 
Subject” on page 75.

Step 3 - Set up Homerooms and Subject Scheduling Rules
Define constraints, set up homerooms, and build homeroom rosters then specify how 
subjects are scheduled. For more information about homerooms and subject scheduling, see 
“Setting Up Homerooms and Subject Scheduling Rules” on page 45.

Step 4 - Define Schedules for Classes
Adjust class schedules by changing assigned teachers, assigning additional teachers, 
assigning rooms, and assigning meeting patterns to classes. For more information about 
class schedules, see “Defining Schedules for Classes” on page 71. 

Step 5 - Assign Students to Homerooms and Classes
Create and adjust student schedules by assigning students to homerooms and classes. For 
more information about creating student schedules, see “Assigning Students to Homerooms 
and Classes” on page 87.

Step 6 - Setup Resource Services
This step is only available in the active calendar.

Create resource services and assign them to students. For more information about resource 
services, see “Setting Up Resource Services (active calendar only)” on page 93.

Permission to Work with Elementary School Scheduling
To work with Elementary School Scheduling, you need the following permissions:

To You need this permission Set to

Switch school calendars, e.g., 
switch to the school planning 
calendar

School Setup>Define School Calendars Yes

Specify calendar day exceptions 
and special days, such as 
holidays and professional 
development days, for the active 
calendar

School Setup>Calendar Day Exceptions Delete

Create and edit day types School Setup>Day Type Setup List Yes

View the subject framework School Setup>Subject Framework/Course 
Catalog

View
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Schedule core and specialty 
subjects

School Setup>Subject Scheduling Edit

School Setup>Subject Framework / Course 
Catalog

View or Edit

Add, edit, and delete buildings Facilities Management>Buildings Delete

School Setup>Secondary Scheduling Setup Yes

Add, edit, and delete rooms Facilities Management>Rooms Delete

School Setup>Secondary Scheduling Setup Yes

Set up the scheduling structure, 
including the following:

• Scheduling Groups

• Day patterns

• Bell Schedules

• Meeting patterns

• Scheduling defaults

School Setup>Secondary Scheduling 
Structure Setup

Yes

Define schedules for classes School Setup>Classes Yes

School Setup>Secondary Scheduling Setup Yes

Define class or homeroom 
constraints

School Setup>Define Constraints - School Delete

Schedule a student into a class 
for which they do not satisfy the 
defined constraints

School Setup>Override Constraints Yes

Assign default classes based on 
student homerooms

School Setup>Subject Scheduling Edit, Delete, or 
None

School Setup>Edit Student Schedules Yes

Re-assign default classes based 
on student homerooms

School Setup>Subject Scheduling Edit

School Setup>Edit Student Schedules Yes

Create resource services School Setup> Resource Services Delete

Update Statistics School Setup>Change Planning Schedule Yes

Assign resource services to 
students

Students>Resource Assignments Delete

Students>Edit Student Schedules Edit

Set up homerooms for 
scheduling

School Setup>Homerooms Delete

Assign homerooms to students Students>Assign Homerooms Yes

Make changes to student 
schedules, including adding, 
deleting, and transferring 
classes, transferring 
homerooms, adding subject 
exceptions, and assigning 
resource services

Students>Edit Student Schedules Yes

To You need this permission Set to
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By default, the school administrator role can perform all scheduling tasks. For more 
information about permissions, see “Controlling User Access” in the Chancery SMS District 
Administration Guide.

Understanding Chancery SMS Elementary School 
Scheduling Terminology
Before you begin the scheduling process at your elementary school, it is important to 
understand the terminology Chancery SMS uses relating to subjects and subject framework, 
such as the difference between a homeroom and a class, and how subjects relate to both. 
The following definitions help you understand this terminology as it relates to Chancery SMS:

If you want to assign specific meeting times to specific classes or create a multiple track 
schedule, you must set up the scheduling structure. The following definitions help you 
understand the terminology as it relates to elementary scheduling structures:

Term Definition

Homeroom A group of students, usually in the same grade, who spend most 
of their time together. In a homeroom, students have attendance 
taken and receive instruction in core subjects, such as Math, 
Language Arts, and Social Studies. For example, Homeroom 1-A 
is a Grade 1 homeroom where twenty-five Grade 1 students 
spend most of their time.

Class A group of students who meet regularly to receive instruction in a 
subject from a specific teacher. For example, Band 4 meets 
Tuesdays and Thursdays at 2 pm with Mr. Bell providing 
instruction for thirty Grade 4 students.

Subject A set of instructional topics and objectives taught to students, 
often for the entire school year. For example, Science is a subject 
that is taught to all Grade 4 students for the whole year.

Rooms Specify the location of classes not taught in the homeroom. 
Typically, in elementary schools, classes are taught in the 
homeroom. If a class is not taught in the homeroom, you can 
specify a different room. For example, all computer classes are 
taught in the computer lab in room 102.

Term Definition

Scheduling group A group of students that use the same bell schedule and meeting 
patterns. By default, elementary school scheduling includes two 
scheduling groups: homerooms and classes. 

Day pattern The cycle of days that your school uses. For example, your 
school can use a days-of-the-week pattern from Monday to 
Friday or it can use a relative-day pattern using a set number of 
days in a cycle, such as Day 1 to Day 4 in a four-day relative 
cycle. If your school does not use data mapping, you can add 
special days to your day pattern, such as parent-teacher 
interview days, professional development days, or early 
dismissal days.
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Once you understand the terminology, the next step is to understand the interrelation 
between grades, homerooms, classes, and subjects in an elementary school.

• You must assign all students in your school to a homeroom. A student’s current grade 
level must match a grade level assigned to their homeroom.

• You can choose to automatically assign subjects to a student, based on their grade level. 
As a result, all students in that grade receive instruction for the core subjects associated 
with the grade, such as Language Arts, Math, and Social Studies. A subject can be taught 
either in the homeroom or in a different room. For example, multiple homerooms in a 
grade can be scheduled to take Grade 5 PE together, which is taught in the Gymnasium.

• You can automatically assign students to classes based on their homeroom. For example, 
you can designate Social Studies 4 as a subject whose classes correspond to specific 
homerooms. As a result, students in Homeroom 4-A are automatically assigned to the 
Social Studies 4 (4-A) class.

• You can create classes to accommodate the number of students in a grade who are taking 
a subject. For example, if there are ninety students in Grade 3 who are taking Computer 
Applications and you want to limit the class size to fifteen students, you can create six 
classes.

• Students automatically receive a schedule of most of their core and specialty subjects 
(also known as non-academic subjects), based on the homeroom and grade assignment. 
You can then make adjustments to class rosters to accommodate exceptions, such as 
team teaching.

• If you want to track instructional minutes, you can assign scheduling groups, define day 
patterns, bell schedules, and meeting patterns, and then assign meeting patterns to 
specific classes. You can then create a custom report to show instructional minutes for 
those classes.

Bell schedule Consists of the start and end times of periods throughout the 
day. If your school does not use data mapping, you can have a 
different bell schedule for each scheduling group and for different 
days.

Meeting pattern A single period or series of periods when a class can meet. When 
you schedule classes, classes are given one or more meeting 
patterns. Meeting patterns are also used to set up tracks. 

Term Definition
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Using the Planning Schedule to Schedule the Next 
School Year
If you are working in a planning calendar, you set up scheduling elements and schedule 
students in a planning schedule. In elementary scheduling, the planning calendar always has 
one and only one planning schedule. You cannot delete the planning schedule, nor can you 
have more than one schedule in the planning calendar. For more information about planning 
calendars, see “Creating a Planning Calendar” in the Chancery SMS School Setup Guide.

• When you create a planning calendar, a new planning schedule is automatically created.

• You can make a copy of the active calendar schedule to be the planning schedule. This 
copies the schedule in the active calendar and overwrites the existing planning schedule, 
with the following characteristics:

• Only the fields that are available in the planning calendar are copied from the active 
calendar.

• All the fields that are available in the planning calendar are copied from the active 
calendar, that is, you cannot choose which scheduling elements or fields to copy to 
the planning calendar.

NOTE

Subjects are not copied from the school active calendar to the school planning calendar. Subjects 
are assigned to schools by the district. The Subject Framework must be published to schools for each 
calendar year.

• You can discard the changes you’ve made and create a new planning schedule, which 
overwrites the existing planning schedule. You can then build the planning schedule from 
scratch.

Creating Planning Schedules
The planning calendar always has one and only one planning schedule. You cannot delete the 
planning schedule, nor can you have more than one planning schedule. Once you create a 
planning calendar, a planning schedule is automatically created. If you want to copy 
scheduling elements from the active calendar or discard changes made to a planning 
schedule and build the planning schedule from an empty schedule, you can create a planning 
schedule.

To create a planning schedule:
1 Log on as a school administrator. 

2 Make sure you are using a planning calendar.

3 In the control bar, under Admin, click Scheduling.

4 On the Scheduling page, from the Actions menu, click Create Schedule > New.

OR

On the Scheduling page, from the Actions menu, click Create Schedule > Copy from 
active calendar.
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The following table shows how fields and data behave depending on how you create the 
planning schedule:

New Planning 
Schedule

Copy from Active 
Calendar When 
Subjects Are Assigned 
in Both Active and 
Planning Calendars

Copy from Active 
Calendar When 
Subjects Are Assigned 
Only in Planning 
Calendar

Staff List Same as in active calendar; changes in one calendar apply to both calendars

Room Setup

Scheduling 
Group

Two default scheduling 
groups: Homerooms and 
Classes

Copied from active 
calendar

Two default scheduling 
groups: Homerooms and 
Classes

Day Patterns
5 Regular Days and 0 
Special Days

Copied from active 
calendar

5 Regular Days and 0 
Special Days

Bell Schedules
None Copied from active 

calendar
None

Meeting Patterns
None Copied from active 

calendar
None

Scheduling 
Defaults

Default Scheduling 
Group for homerooms is 
Homeroom Default 
Scheduling Group for 
classes is Classes

Copied from active 
calendar

Default Scheduling 
Group for homerooms is 
Homeroom Default 
Scheduling Group for 
classes is Classes

Class Setup
None Copied from active 

calendar
None

Can Schedule 
flag

Cleared Copied from active 
calendar

Cleared

Automatically 
assign this 
subject to all 
students in 
grade x

Yes Students are assigned in 
the same way as the 
active calendar, that is, 
based on settings on the 
Edit Subject page and 
whether homerooms 
have been created

Yes

Default Teacher
Homeroom Teacher Copied from active 

calendar
Homeroom Teacher

Number of 
Rosters

One Roster per 
Homeroom

Copied from active 
calendar

One Roster per 
Homeroom
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Setting Up Basic Scheduling Elements
Basic scheduling elements include staff, rooms, and subjects. Although these elements are 
generally set up before you begin scheduling, you may want to verify that they are correct 
and make modifications, as necessary.

Checking Staff Lists
Before you begin scheduling classes, check that the staff list for your school is correct.

1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff List.

4 On the Staff Search page, search for specific teachers or click Display All Records.

Adding Teachers
If you need to add teachers to the staff list, use the following general procedure. For more 
information about setting up the staff list, see “Staff” in the Chancery SMS School Setup 
Guide. 

NOTE

If your school uses Active Directory, see the Chancery SMS Active Directory Integration Guide for more 
information about working with roles, accounts, and staff records. 

• Ensure the school has a Teacher role.

To display the Staff 
Demographic page for a 
teacher, click the teacher’s 
name.

To see a list of all teachers, click 
Display All Records.
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• For each teacher who will use Chancery SMS:

• Create a user account for the teacher.

• Assign the user account a Teacher role at the school.

For information about creating user roles and accounts, see “Controlling User Access” in 
the Chancery SMS School Setup Guide.

• Create a staff record for every teacher at the school.

Setting Up Rooms
Typically, rooms are set up when you set up your school. Before you begin scheduling 
subjects and classes, make sure rooms are set up correctly. You can open the Room Setup 
page from the Scheduling page.

To open the buildings page from the scheduling page:
1 Log on as a school administrator. 

2 In the control bar under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Room Setup.

4 On the Buildings page, click the number in the # Rooms column.

5 On the Rooms page, do one of the following:

6 On the Add Room or Edit Room page, enter or edit the information about the room. 

For more information, see “Setting Up Buildings and Rooms” in the Chancery SMS School 
Setup Guide.

To Do this

Add a room • From the Actions menu, click Add Room.

Edit a room • Select a room. From the Actions menu, click Edit Room.

OR

In the Room No. column, click the room number.

Delete a room 1 Select the room. 

2 From the Actions menu, click Delete Room. 

Skip the remaining steps.

NOTE
You cannot delete rooms that are assigned to classes.

To open the Rooms page, click the 
number in the # Rooms column.
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Reviewing the Subject Framework
The subject framework, with all the subjects and subject elements, is set up at the district. 
Your school is assigned a subject framework containing the subjects applicable to your 
school. 

If there are problems with your subject framework or subjects, contact your district 
administrator.

To display the subject framework:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click School Setup, and then click Subject Framework.

OR

In the control bar, under Admin, click Scheduling, and then click Subject Framework.

The Subject Framework page lists the core and specialty generic subjects taught in your 
school, along with the associated subject elements.

 
 
 

“Y” indicates the grades in 
which a subject is taught.
Click a “Y” to edit a 
subject, such as 
Language Arts 5, along 
with the specific subject 
elements associated with 
the selected grade.

To display subject 
details, click the 
generic subject name.

These are Subject 
Elements associated 
with the Mathematics 
generic subject.
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3 On the Subject Framework page, do any of the following:

To Do this

Display subject details • Click the Generic Subject Name. 

Modify subject scheduling • In the grade column, click the “Y” in the row for the subject 
you want to modify. For example, to modify the scheduling 
setup for grade 5 language arts, in the Language Arts row, 
click the “Y” in the Grade 5 column.

NOTE
Subject scheduling is set up later in the scheduling process, for more 
information, see “Scheduling Subjects” on page 62. 

Specify which grades a 
generic subject is taught in

1 Select the generic subject. 

2 From the Actions menu, click Schedule / Unschedule Generic 
Subject.

NOTE
If a student has been manually added to or removed from a class for the 
subject, you cannot remove the subject from the grade.
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Setting Up the Scheduling Structure
Chancery SMS allows you to set up scheduling structures to describe the days and times that 
homerooms and classes meet. If you set up meeting times, you can view student, teacher, 
and room schedules in a matrix format, search for classes according to their meeting time, 
and create custom reports to calculate the minutes of instruction students are scheduled to 
receive. For more information about creating custom reports, see the Chancery SMS Report 
Writer Guide.

In elementary school scheduling, a schedule structure is not required. Scheduled classes are 
particularly useful in the following two scheduling models:

• Self-contained homerooms

In this scheduling model, most classes are taught by the homeroom teacher and these 
classes are not assigned a specific instructional time. The teacher has flexibility for when 
and how they teach the subjects. Certain classes, such as Music and Physical Education, 
may be taught by a different teacher in a different room. These classes are assigned 
specific instructional times (meeting patterns).

• Fully-scheduled, discrete classes

In this scheduling model, most classes are still taught by the homeroom teacher, but 
every class is assigned a specific instructional time (meeting pattern). Some classes are 
still taught by a different teacher in a different room, and these classes are part of the 
fully-scheduled day for each student and teacher. 

NOTE

The scheduling structure can affect data mapping. For an overview of data mapping constraints, see 
“Data Mapping Constraints for Scheduling” on page 13. In addition, constraints related to specific 
features are mentioned in the procedures for setting up those features. 

Defining Scheduling Groups
Scheduling Groups are used to group different types of classes that meet in different ways. 
Each Scheduling Group can have its own distinct set of bell schedules and meeting patterns. 
For example, you can create a homeroom bell schedule with only A.M. and P.M. blocks and a 
class bell schedule that covers a six period day. 

Chancery SMS includes two default scheduling groups, one for homerooms and one for 
classrooms. You can modify or delete these default groups, as well as add scheduling groups 
to meet your school’s needs. 

NOTE

For data mapping, the bell schedule must be the same in all scheduling groups, that is, the period codes 
and period start and end times must be the same. You can create different meeting patterns based on 
the bell schedules to accommodate different class types.

To set up scheduling groups:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 2, click Scheduling Groups.
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4 On the Scheduling Groups page, do one of the following:

5 On the Edit Group page, enter or edit the following information as needed:

6 Click OK.

Editing Scheduling Group Defaults
When you create a homeroom or class, Chancery SMS automatically assigns it to a 
scheduling group. By default, Chancery SMS assigns homerooms to the homeroom 
scheduling group and classes to the classes scheduling group. You can change the scheduling 
groups assigned automatically. For example, you may want to use the same scheduling 
group for both homerooms and classes.

NOTE

When you change the scheduling group defaults, the change applies only to new classes or homerooms. 
The scheduling groups assigned to existing classes and homerooms do not change.

To change the scheduling group defaults:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 2, click Scheduling Defaults.

4 From the For Homerooms dropdown, select the scheduling group you want to be assigned 
to new homerooms.

To Do this

Add a scheduling group • From the Actions menu, click Add Group.

Edit a scheduling group • Click the name of the scheduling group you want to edit.

OR

Select the scheduling group you want to edit. From the Actions 
menu, click Edit Groups.

Delete a scheduling group Deleting scheduling groups also deletes its bell schedules and 
meeting patterns. 

You cannot delete a scheduling group that is specified as a 
default scheduling group or is assigned to any classes. For more 
information about editing default scheduling groups, see “Editing 
Scheduling Group Defaults” on page 28.

1 Select the scheduling group you want to delete. 

2 From the Actions menu, click Delete Group. 

3 Click OK and skip the remaining steps.

Field Description

Name Enter a unique scheduling group name.

Code Enter a short code of up to two characters. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Description Enter a description of up to 250 characters. (optional)
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5 From the For Classes dropdown, select the scheduling group you want to be assigned to 
new classes.

6 Click OK.

Specifying Day Patterns
A day pattern is the cycle of days that your school operates on. For example, your school can 
use a day-of-the-week pattern using Monday to Friday or it can use a relative-day pattern 
using a set number of days in a cycle, such as day 1 to day 4 in a four-day relative cycle. The 
day pattern is used to define which classes are offered on which days.

You can also set up special days when your school has a different bell schedule, such as days 
when your school has parent-teacher interviews, professional development days, and so on. 

NOTE

For data mapping, special days are not supported. Use the same bell schedule for all days. You can 
create different meeting patterns based on the bell schedule to accommodate different class types.

Using special days allows you to have a short relative-day cycle, while still accommodating 
special days that have a different schedule. For example, if you use a four-day relative cycle, 
but have an early dismissal day once a month, you can schedule a special day once a month 
on your calendar, instead of using a 30-day relative cycle with a different schedule every 30th 
day.

You can apply a relative day pattern to a specific date and have Chancery SMS begin using 
that relative day on that date. For example, if the school was unexpectedly closed due to 
heavy snow on Day 2, you can apply Day 2 to the following day. For more information, see 
“Applying Relative Day Patterns” on page 31. 

To set up a regular-day pattern or a special-day pattern:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.
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3 On the Scheduling page, under Step 2, click Day Pattern.

The Day Pattern page displays the regular and special days set up for the day pattern.

4 On the Day Pattern page, in the Regular Days section, enter information about your 
school’s regular day pattern. 

Field Description

Days of the Week If your school schedule uses days of the week as its day pattern, 
select Days of the Week. Your school schedule would then follow 
a Monday-to-Friday pattern.

If your school schedules classes on Saturdays or Sundays, make 
sure these days are set up as normal schools days in the Day 
Types setup list. For more information, see “Adding Day Type 
Codes” in the Chancery SMS School Setup Guide. 

Relative Days If your school schedule uses relative days as its day pattern, 
select this option. Your school schedule would then follow a 
relative day pattern, such as Day 1 to Day 4.

You must create the number of relative days and specify their 
day names and short codes. For example, you can set up a four-
day relative cycle called Day A to Day D, or an eight-day cycle 
called Day 1 to Day 8. 

To add relative days, from the Actions menu, click Add Regular 
Day.

Once you have created a relative day pattern and are working in 
the active calendar, you can apply the relative day patterns to 
specific dates in the school calendar. For more information about 
applying relative day patterns, see “Applying Relative Day 
Patterns” on page 31.

To change a Day of the Week 
code, click the code.
30 Setting Up the Scheduling Structure
Specifying Day Patterns



Chancery SMS Scheduling Guide
5 On the Day Pattern page, in the Special Days section, specify the pattern for special days. 

To add more than two special days, from the Actions menu, click Add Special Days.

6 Click OK

To delete days in a relative-day pattern:
You can only delete regular days if you are using a relative-day pattern.

1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 2, click Day Pattern.

4 Select a regular day. From the Actions menu, click Delete Regular Day.

OR

Select a special day. From the Actions menu, click Delete Special Day.

5 Click OK.

Applying Relative Day Patterns
You must complete this step in the active calendar.

If you are using relative day patterns, you must specify the date that the relative day pattern 
cycle begins. Throughout the school year, you can adjust the relative day pattern cycle, as 
required. For example, if the school was unexpectedly closed due to heavy snow on Day 2, 
you can apply Day 2 to the following day.

Although you typically set up relative day patterns in a planning calendar when you schedule 
classes, you must apply the relative day pattern to a specific date in the active calendar.

NOTE

You can only apply a relative day pattern if you set up scheduling to use relative day patterns. For more 
information about setting up relative day patterns, see “Specifying Day Patterns” on page 29.

Day Name If you are using Relative days, specify a day name for each day. 
To add more than five regular days, from the Actions menu, click 
Add Regular Days.

If you are using Days of the Week, you can only change the code 
names for the days of the week.

Code Enter a short code for each day name. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Field Description

Day Name Enter a Day name for each special day, for example, Early 
Dismiss or PTI.

Code Enter a short code for each day name. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Field Description
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You can apply a relative day pattern at any time. You cannot apply a relative day pattern to 
the past (days before today) if attendance has already been taken for those days. If you 
apply a relative day pattern to a future date and attendance has already been taken for those 
future dates, the attendance for those future dates is deleted. 

NOTE

If your district uses the Chancery SMS student behavior feature, student behavior actions assigned to 
students might assign attendance codes for those students. When you change relative days, all future 
attendance is deleted, including attendance codes assigned by student behavior actions. However, 
student behavior attendance codes are reassigned on a day-by-day basis when the day is initialized. 

To apply a day pattern:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click School Setup.

3 On the School Setup page, under Calendar, click Relative Day Pattern. 

The Relative Day Pattern page opens.

4 On the Relative Day Pattern page, from the “Start Pattern Using Day” dropdown, select 
the relative day that you want to apply to the specified date.

5 From the As of Date dropdown, select the date you want the relative day pattern to 
begin. 

6 Click Apply Day Pattern.

The Calendar Day List section refreshes to show your changes. 
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Setting Up Bell Schedules
Bell schedules specify the start and end times for periods throughout the day. You can define 
a different bell schedule for each scheduling group and for each day in the day pattern. For 
example, you can have one bell schedule for the homerooms scheduling group and a 
different bell schedule for the classes scheduling group.

NOTE

To support data mapping, note the following:

• Each day in the day pattern must have the same bell schedule/period structure, including the same 
periods and the same number of instructional minutes in periods with the same code. For example, 
if on Monday, period 1 had 50 instructional minutes, period 1 must have 50 instructional minutes for 
every day in the day pattern. Periods within one day can have different amounts of instructional 
minutes. 

• Each day in the day pattern can have a maximum of 42 periods.

• Periods cannot overlap.

• If more than one scheduling group is defined (e.g., to support exception days), the bell schedule 
must be the same in both scheduling groups, that is, the period codes and period start and end times 
must be the same.

To set up a bell schedule, add periods to the day and define the start and end times for each 
period.

Setting Up Bell Schedule Periods
You set up a bell schedule by adding periods to each day. You can set up the periods for one 
day and then copy those periods to other days in the bell schedule. To copy the periods from 
one day to other days, see “Copying Periods from One Day to Another Day” on page 36. 

After you set up periods for all days for a scheduling group, you can copy the bell schedule 
for all the days to other scheduling groups. To copy the periods for all days in one scheduling 
group to another, see “Copying Periods in All Days to Another Scheduling Group” on page 38.

NOTE

If you are making adjustments to an existing scheduling structure, use caution when copying periods or 
bell schedules to other days or scheduling groups. Copying deletes any existing setup in the target day or 
scheduling group, which may affect daily code calculation rules, meeting patterns, or exception day 
types.

To set up periods in a bell schedule:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.
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3 On the Scheduling page, under Step 2, click Bell Schedules.

The Bell Schedule page displays the current bell schedule configuration.
.

4 From the Scheduling Group dropdown, select the scheduling group you want to work 
with.

5 From the Day dropdown, select the regular day or the special day you want to define.

6 Do one of the following:

If you add or edit a period, the Add Period or Edit Period page opens.

NOTE

If your district runs data mapping, the maximum number of periods (number of meeting blocks for 
each day) you can create is 42. Periods cannot overlap and each day in the day pattern must have 
the same bell schedule/period structure, including the same periods and the same number of 
instructional minutes in periods with the same code. 

To Do this

Add a period • In the Actions menu, click Add Period.

Edit a period • Select a period. From the Actions menu, click Edit Period.

OR

Click the Details icon ( ) for the period you want to edit.

Delete a period 1 Select the period. 

2 From the Actions menu, click Delete Period. 

Skip the remaining steps.
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7 On the Add Period or Edit Period page, specify or edit the following information for the 
period:

Field Description

Start Time Enter the start time for the period.

The start time can be several minutes after the previous end 
time to allow students to get to their next class.

End Time Enter the end time for the period.

Period Name Enter a name for the period.

Period Label (short code) Enter a short code for the period.

Print on Schedules If checked, this period is displayed on student or teacher 
schedules. If you do not want to display this period, such as for 
before or after school periods, deselect this checkbox.

Use for Classes If checked, this period is available for meeting patterns to 
schedule classes.

Include in Daily Attendance 
Code Calculation Rules

This option only applies if attendance is taken by class. Currently, 
schools using elementary school scheduling cannot take 
attendance by class. 

Include in Instructional/ 
Attendance Minutes 
Calculations

Select this option if you want this period included in instructional 
or attendance minutes calculations. For more information about 
instructional minutes calculations, see the Chancery SMS 
Instructional Minutes Calculation Technical Bulletin. 

NOTE
You cannot change this value if the period is part of a meeting pattern and 
attendance has been taken for a class using that meeting pattern.

This Period is Part of Regular 
School Hours

Select this option if you want the period to be included in 
instructional minutes calculations as regular school hours. For 
example, if your school offers academic programs in the 
evenings or on weekends and you want them included when you 
calculate instructional minutes for regular school hours. 

NOTE
If you want a period to be included in regular school hours for some classes, 
but not others, create two scheduling groups. Select “This period is part of 
regular school hours” in one scheduling group and deselect it in the other. 
Then schedule classes using the appropriate scheduling group. 
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8 Click OK. 

The Bell Schedule page displays the periods defined for the day. To view details about a 
period, pause your mouse over the Details icon ( ) in the Details column. 

9 To add more periods, repeat Steps 6 to 8.

Copying Periods from One Day to Another Day
After you set up the periods for one day, you can copy them to other days so you don’t have 
to set up the same periods for every day in the day pattern. If other days have a similar bell 
schedule, you can copy the periods, and then change the days that are different.

After you copy periods, making changes to the periods in one day does not affect the periods 
in the other day.

For This Period Only Enter the amount of instruction time in the period.

The instruction time is usually the number of minutes between 
the start and end time. For example, if a period starts at 9:00 
and ends at 9:50, the instruction time is usually 50 minutes. If 
you leave this field blank, the result of this calculation is used 
when you click OK.

There may be periods where the instruction time is less than the 
meeting time. For example, if a gym class meets for 65 minutes 
but there is 10 minutes for changing then enter 55 as the 
instruction time.

NOTE
For data mapping, the instructional minutes for periods with the same code 
must be the same for all days in the day pattern and in all scheduling groups. 
For example, if period 1 is assigned 50 instructional minutes on Monday, 
period 1 must have 50 instructional minutes for all the other days of the 
week and in all scheduling groups.

Passing Time Minutes to 
Include for Blocked Classes

Use this when a class spans more than one period and there is 
non-scheduled time between periods, such as time between 
classes for students to get to the next class.

For example, if your schedule has four minutes between classes 
for students to go to the next class, and a chemistry class spans 
two periods, you can specify whether that four minutes is 
instruction time or not.

Using this example, if your two-period Chemistry class totals 70 
minutes and includes one period in the classroom and one period 
in the lab, with students using the four minutes between periods 
to go from the classroom to the lab then you would enter 66 in 
the “For this period only” field, and 4 in the “Passing time 
minutes to include for blocked classes” field.

However, if the two-period chemistry class is both in the lab then 
the four minutes would be considered instruction time and you 
would enter 70 in the “For this period only” field and 0 in the 
“Passing time minutes to include for blocked classes” field.

Field Description
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NOTE

When you copy periods to another day, any periods already defined in that day are overwritten. If you 
are making adjustments to an existing day, use caution when copying periods to other days. Changing 
the periods set up for an existing day may affect daily code calculation rules, meeting patterns, or 
exception day types.

To copy periods:
1 Log on as a school administrator. 

2 In the control bar, click Scheduling.

3 On the Scheduling page, under Step 2, click Bell Schedules.

4 On the Bell Schedules page, after you define periods for one day, click “Copy to Other 
Days” beside the Day dropdown. 

For information about adding periods, see “Setting Up Bell Schedule Periods” on page 33.

To copy a period to another day of 
the week, select the period and 
then click Copy to Other Days.
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5 On the Copy to Days page, from the Available column, select the days you want to copy 
and move them to the Copy to Days column.

6 Click OK. Click OK to confirm.

Copying Periods in All Days to Another Scheduling Group
After you set up periods for all days for a scheduling group, you can copy the bell schedule 
for all the days to other scheduling groups. This option makes it easy to set up the bell 
schedules for all your scheduling groups.

NOTE

When you copy to another scheduling group, the bell schedule in the receiving scheduling group is 
overwritten. If you are making adjustments to an existing bell schedule, use caution when copying to 
other scheduling groups. Changing the bell schedules set up for an existing day may affect daily code 
calculation rules, meeting patterns, or exception day types.

After you copy periods, making changes to the periods in one day does not affect the periods 
in another day.

To copy periods in all days to another scheduling group:
1 Log on as a school administrator.

2 In the control bar, click Scheduling.

3 On the Scheduling page, under Step 2, click Bell Schedules.

To move days from one 
column to the other, use the 
arrows.
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4 On the Bell Schedules page, after you define periods for all days in a scheduling group, 
click “Copy to Other Groups”. For information about adding periods, see “Setting Up Bell 
Schedule Periods” on page 33.

5 On the Copy to Groups page, from the Available column, select the scheduling groups you 
want to copy and move them to the Copy to Scheduling Groups column.

6 Click OK. Click OK to confirm.

Creating Meeting Patterns
After you set up bell schedules, you can set up meeting patterns. A meeting pattern is a 
series of periods when a class can meet. You define a meeting pattern, and then specify the 
periods and days it meets. 

Once all required meeting patterns are created for your school, the schedule structure setup 
is complete. When you set up classes, you can assign meeting patterns, as appropriate. For 
more information about setting up classes, see “Setting Up Classes” on page 71.

To set up meeting patterns:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

To copy the bell schedule to another 
scheduling group, click Copy to 
Other Groups.
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3 On the Scheduling page, under Step 2, click Meeting Patterns.

4 On the Meeting Patterns page, enter the following information:

5 On the Meeting Patterns page, in Meeting Patterns for Scheduling Group, select the 
scheduling group you want to work with.

Field or Section Description

Meeting Patterns for 
Scheduling Group

Select the scheduling group you want to work with.

Name Displays the name of the meeting pattern.

Short Name Displays the short name of the meeting pattern. 

Description Provides a summary of the days and periods when this meeting 
pattern meets.

View of selected meeting 
patterns

Displays a timetable grid.

You can select one or more meeting patterns then click Update 
View to see how the meeting patterns fit in a timetable grid.

Update View Updates the timetable grid with the selected meeting patterns. 

After you select or deselect meeting patterns, click Update View 
to update the timetable grid.

To see the periods 
when a specific 
meeting pattern 
meets, select a 
meeting pattern and 
then click Update 
View.

Meeting patterns for 
the scheduling 
group.
40 Setting Up the Scheduling Structure
Creating Meeting Patterns



Chancery SMS Scheduling Guide
6 Do one of the following:

If you add or edit a meeting pattern, the Add Meeting Pattern or Edit Meeting Pattern 
page opens.

7 On the Add Meeting Pattern or Edit Meeting Pattern page, specify or edit the following 
information for the meeting pattern:

To Do this

Add a meeting pattern • In the Actions menu, click Add Meeting Pattern.

Edit a meeting pattern • Select a meeting pattern. From the Actions menu, click Edit 
Meeting Pattern.

OR

Click the name of the meeting pattern you want to edit.

Delete a meeting pattern 1 Select the meeting pattern. 

2 From the Actions menu, click Delete Meeting Pattern. Skip the 
remaining steps.

Field Description

Meeting Pattern Name Enter a descriptive name for this meeting pattern so that you can 
easily see when this meeting pattern meets.

Short Name Enter a descriptive short name for this meeting pattern. Use 
meaningful short names so you know what they mean when 
displayed on other pages.

Shows the periods 
defined in the bell 
schedule. For more 
information about setting 
up the bell schedule, see 
“Setting Up Bell 
Schedules” on page 33.
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8 Click OK.

Setting Up Meeting Patterns for Blocked Periods - Example
If your school wants to offer classes in blocked periods, create meeting patterns that use 
multiple, consecutive periods. 

NOTE

Do not use the Add More Detail link on the Class Setup page to create double periods by assigning 
multiple meeting patterns to the class.

To create a blocked period meeting pattern:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Meeting 
Patterns.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Meeting 
Patterns.

5 On the Meeting Patterns page, in Meeting Patterns for Scheduling Group, select the 
scheduling group you want to work with.

6 In the Actions menu, click Add Meeting Pattern.

7 On the Add Meeting Pattern page, enter a name and short name for the blocked meeting 
pattern; for example, enter Period 1-2 and P1-2.

Meeting Pattern Select the periods when this meeting pattern meets. For 
example, if this meeting pattern meets in period 1 on Day 2 and 
Day 4, select Day 2, Period 1 and Day 4, Period 1.

Field Description
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8 On the Meeting Pattern panel, select the periods to include in the blocked meeting 
pattern. 

9 Click OK.

Viewing Meeting Patterns
You can view a visual representation of defined meeting patterns. 

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 2, click Meeting Patterns. 

Select the periods the blocked class 
meets in; for example, this meeting 
pattern offers classes in period 1 and 
2 on Mondays, Tuesdays, and 
Fridays.
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4 On the Meeting Patterns page, select the meeting pattern you want to view.

5 Click Update View.

Select the meeting patterns 
you want to view.

Click Update View to see a 
visual representation of the 
meeting pattern.
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Setting Up Homerooms and Subject 
Scheduling Rules
In elementary schools, all students are assigned to a homeroom. Typically, core classes are 
assigned based on the student’s homeroom assignment. However, you may need to modify 
student schedules by assigning specialty classes, transferring students to a different classes, 
entering subject exceptions, or assigning resource services. 

Working with Constraints
You can use constraints to control the distribution of students in classes. Schools that use 
elementary scheduling can assign constraints to classes or homerooms. 

For elementary schools, Chancery SMS supports Restriction constraints, which allow you to 
control the distribution of students in classes and homerooms. For example, you can create 
an all-girl physical education class. 

Constraints can be created at the district or at the school. Constraints created at the district 
are available to all schools in the district. If you modify a district-defined constraint at a 
school, Chancery SMS creates a copy of the constraint at the school level. Schools cannot 
delete district-defined constraints. When you create or edit constraints at the school, you can 
also make the constraint mandatory for specific subjects and/or homerooms.

Once constraints are defined, you apply or remove the constraint for specific classes and/or 
for homerooms. If a constraint is mandatory for a subject or homeroom, you cannot remove 
it from any class for that subject or homeroom. 

Creating and Editing Constraints
Restriction constraints allow you to control the distribution of students in classes and 
homerooms according to specific criteria. For example, you can ensure that no more than 
10 percent of the students in a class have special needs or restrict specific homerooms to 
students for whom English is their second language.

Creating and editing constraints involves three basic steps:

• Step 1: Define Constraints

• Step 2: Select Student Criteria

• Step 3: Select Subjects or Homerooms 

Step 1: Define Constraints
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 
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3 On the Scheduling page, under Step 3, click Constraints.

The Constraints page opens.

4 On the Constraints page, do one of the following:

To Do this

Add a constraint • From the Actions menu, click Add Constraint.

Modify a constraint • Click the constraint name.

OR

Select the constraint. From the Actions menu, click Edit 
Constraint.

NOTE
If you modify a district-defined constraint, it is saved at the school as a 
school-defined constraint. The district-defined constraint is not changed and 
is still available at the district and at the school.

Delete a constraint 1 Select the constraint. 

2 From the Actions menu, click Delete Constraint. 

Skip the remaining steps.

NOTE
You cannot delete district-defined constraints. You can delete school-defined 
constraints that are based on district-defined constraints.
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If you add or edit a constraint, the Add Constraint or Edit Constraint page opens.

5 On the Add Constraint or Edit Constraint page, expand the Define Constraint panel and 
enter or edit the following information:

Field Description

Name Enter a name for the constraint. The name must be unique within 
the school.

NOTE
If you modify a district-defined constraint, a school-defined version of the 
constraint is saved for your school. The district-defined version is not 
changed and is still available to apply to classes.

Defined At View-only. Indicates whether the constraint was created at the 
district or at the school.

Program Constraint Select this checkbox if the constraint applies to the specialized 
activities or courses outside of regular academic studies available 
through Program Management. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Track Program Attendance 
for Classes with this 
Constraint

This checkbox is available if the Program Constraint checkbox is 
selected. 

Select this checkbox if you want Program Management to include 
classes that are assigned this restriction in instructional minute 
calculations.

For more information about Program Management, see the 
Chancery SMS Program Management Guide.
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6 Under “Complete the following phrase to define the constraint”, enter the following 
information to construct the constraint statement:

7 Continue with “Step 2: Select Student Criteria” on page 49. 

Field Description

First dropdown Select the constraint strength, that is, whether the constraint 
must be applied or should be applied. 

If you select “Must contain”, automated scheduling processes will 
not schedule students if the constraint is not satisfied. When 
manually scheduling students that do not meet the criteria, you 
must have the Override Constraints permission set to “Yes” to 
add the student to the class.

If you select “Should contain”, automated scheduling processes 
attempt to meet the specified constraint criteria, but if another 
class or homeroom is not available, Chancery SMS will schedule 
students who do not match the criteria. When manually 
scheduling students that do not meet the criteria, Chancery SMS 
displays a warning but does not prevent the student from being 
added to the class.

Second dropdown Select the constraint range from the following options:

• At most - the maximum number of students that can have the 
specified criteria.

• All - all students assigned to this class or homeroom must 
have the specified criteria. This option is equivalent to “must 
contain 100%”. 

• No - no students assigned to this class or homeroom can have 
the specified criteria. This option is equivalent to “must contain 
0%”. 

Text box Enter the constraint value, that is, the number or percent of 
students required for the constraint.

For percent values, enter a number between 0 and 100.

For numeric values, enter a number between 0 and 9999. 

%/# Select whether the constraint value is a number or a percentage.

Third dropdown Select the constraint matching criteria. Students can either 
match or not match the defined criteria.
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Step 2: Select Student Criteria
After you define the constraint, you must specify the criteria that students must match to be 
eligible for the classes the constraint is assigned to. 

To select student criteria:
1 On the Add Constraint or Edit Constraint page, expand the Select Student Criteria panel.

2 If the Program Constraint check box is not selected under the Define Constraint panel, 
construct criteria statements for the eligibility rule using the eligibility control. For more 
information about using the eligibility control, see “Working with the Eligibility Control” on 
page 51.

To Do this

Add a criteria statement to 
the eligibility rule

1 From the Category dropdown, select the type of data to be 
added.

2 Under Search By, from the first dropdown, select the field or 
function.

3 From the second dropdown, select the appropriate operator 
(e.g., equals).

4 From the third dropdown, enter or select the appropriate 
value.

If you selected a function in step 2, additional dropdowns are 
available under “Where the following conditions apply.

5 If available, under “Where the following conditions apply”, 
from the first dropdown, select the condition.

6 If available, from the second dropdown, select the appropriate 
operator (e.g., equals).

7 If available, from the third dropdown, select a value.

8 Click Add Criteria.

Delete a criteria statement 
from the eligibility rule

1 In the Eligibility Criteria list box, click the statement to 
highlight it.

2 Click Remove.

If the Program 
Constraint 
checkbox is 
selected under 
the Define 
Constraint 
panel, the page 
shows program 
selection options 
here. 
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3 If Program Constraint is selected under the Define Constraint panel, specify the programs 
that the constraint applies to by entering the following information:

4 Continue with “Step 3: Select Subjects or Homerooms” on page 50. 

Step 3: Select Subjects or Homerooms
Once you have defined a constraint (see “Step 1: Define Constraints” on page 45) and 
selected student criteria (see “Step 2: Select Student Criteria” on page 49), you are ready to 
assign the constraint to subjects or homerooms. 

When you assign constraints to a subject or homeroom, you indicate how the constraint 
applies to classes for that subject or homeroom. Constraints may apply by default, be 
available, or be mandatory for subjects and homerooms.

Add a logical operator to 
define the relationships 
between statements

1 Click AND or OR.

2 Add a criteria eligibility statement to the logical operator. 

NOTE
Eligibility rules using multiple criteria must conform to the “Rule of Two”. 
Each operator must have a pair of items nested underneath. Item pairs can 
be either two criteria OR one criteria and an operator (AND/OR).

Move a statement to another 
location in the eligibility rule

• Click and drag the statement to the new location.

Validate the rule • Click Validate.

Field Description

Program Category Select the appropriate program category.

Program Select the program the constraint applies to.

Available sessions/Selected 
sessions

To assign the constraint to a session, select the session from the 
Available Sessions list and move it to the Selected Sessions list. 

To remove the constraint from a session, select the session from 
the Selected Sessions list and move it to the Available Sessions 
list.

To Do this
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To assign constraints to subjects and homerooms:
1 On the Add Constraint or Edit Constraint page, expand the Selected Subjects/Homerooms 

panel.

2 To assign the constraint to subjects, select the Constraint is for Subject checkbox. In the 
Available Subjects list, select the subjects the constraint applies to and move them to the 
Selected Subjects list.

3 To assign the constraint to homerooms, select the Constraint is for Homerooms checkbox. 

4 From the Constraint Is dropdown, select one of the following options:

5 Click OK.

Working with the Eligibility Control
The Eligibility control allows you to construct eligibility rules. For constraints, the eligibility 
rules are used to determine if students are eligible for classes based on the applied 
constraints. 

The Eligibility control is made up of two sections:

• The statement builder – a collection of fields known as Search By sets that you can use to 
construct the individual criteria statements.

Option Description

Available The constraint is available to homerooms and classes for the 
selected subjects. It is not automatically applied to individual 
classes or homerooms.

Default The constraint is applied by default to newly created homerooms 
and newly created classes for the selected subjects, but can be 
removed for specific classes or homerooms.

Mandatory The constraint is applied to all classes for the selected subjects 
and all selected homerooms.

You cannot remove the constraint for the classes or homerooms.
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• The Eligibility Criteria section – a list box that contains the entire eligibility rule, including 
the logical operators (AND/OR) that connect the statements.

Using the Statement Builder
The statement builder has three sections: a Category selector, a primary Search By 
statement, and, for some statements, an additional set of “where” clauses. To add a 
statement to the eligibility criteria, click Add Criteria. 

Statement Builder

Eligibility Criteria

Left term Operator Right term

Category of student 
data

Search By statement

Where clause 
(appears if function 
selected in Search By 
statement)

Click to add the 
statement to the 
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To construct a statement, you first select a category of student data. For example, 
Demographics.

In each category, you will find all the existing properties in the database that could be 
relevant to calculating eligibility for that particular category. 

The Search By section is made up of a left term, an operator (e.g., equals, is greater than or 
equal to, contains, etc.), and a right term. Using these components, you construct the main 
search statement to be added to the eligibility control. 

IMPORTANT NOTE

All eligibility rule criteria open text field searches are case sensitive.

Depending on the category you select, from the left term, you can select either a field or a 
function.

The options available for specifying a criteria depends on whether you select a field or a 
function from the left term dropdown:

• Field

In its simplest form, a field is any single piece of data stored in the database, such as a 
student’s gender. When you select a basic field as the left term, you can specify an 
operator and right term then add the statement to the eligibility rule; no additional 
controls are generated.

functions

fields

Basic fields include only one 
Search By set.
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Some fields include an additional Search By set below the first, which allows you to 
search for specific information related to the selected field. For example, if you select a 
setup list, such as Ethnicity, an additional dropdown allows you to select another left 
term, such as description or code, and specify an operator and right term; for example, 
“Ethnicity Description equals Asian”. 

• Function

A function is a predefined tool used to construct statements about complex data that 
require you to specify limiting or “where” clauses. For example, if you specify that a 
student must have a cumulative GPA of 3.5, the system will look at all cumulative GPA 
definitions. However, if you use a cumulative GPA function, additional Search By sets are 
automatically generated to allow you to select a specific GPA definition. 

When you select a function, a section called “Where the following conditions apply” 
appears below the Search By section. Any limiting terms necessary to extract the 
appropriate data are preset. Once you select the operator and right term for the first 
Search By set and all associated where clauses, you can add the statement to the 
eligibility rule. 

NOTE

For some functions, the options available in the right term dropdown for some parameters depend 
on whether you are defining the rule at the district level or at the school level. If you are defining 
the rule at the district level, you can select from a list of values defined at any school in the district. 
If you are defining the rule at the school level, you only see values defined at that school. If an 
eligibility rule is created at the district using a value that is defined at some but not all schools, and 
then the rule is run at a school that does not have the value defined, no students at the school will 
match the criteria. 

For example, suppose a district has two schools that each create a cumulative GPA definition. School 
A calls the definition “Weighted Cum GPA” and School B calls the definition “Weighted Cumulative 
GPA”. Then, at the district, you create an eligibility rule. When you set the Cumulative GPA 
definition parameter, the list of Cumulative GPA definitions includes both “Weighted Cumulative 
GPA” and “Weighted Cum GPA”. If you create the eligibility rule that specifies the “Weighted Cum 
GPA” definition, when the rule is run at School B, no students match the criteria. 

For a description of the functions available for each category, see the Chancery SMS 
Eligibility Technical Bulletin.

Some field include an additional 
Search By set.

When you select a 
function in the first 
Search By dropdown, 
you can specify 
conditions in the 
“Where the following 
conditions apply” 
section.

For some 
functions, the 
values available 
in this dropdown
depend on 
whether you are 
defining the rule
at the district 
level or at the 
school level.
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Creating Eligibility Rules
The Eligibility Criteria section of the control groups together the individual statements into an 
eligibility rule.

The eligibility rule as a whole is displayed in the list box in the Eligibility Criteria section. This 
list box is organized in a tree structure, similar to the folders on a computer, and the 
branches of this tree are called nodes. When you construct a statement and click Add 
Criteria, the statement is added below the selected node, or to the bottom of the rule if a 
node was not selected.

If you have more than one statement in your rule, you must add logical operators to group 
them meaningfully. For example, if students are required to meet all the criteria in your rule, 
the first node under Criteria should be AND; all the statements would then hang off that 
node. If, on the other hand, students are only required to meet one out of a list of criteria, 
the first node should be OR. Additional nodes can be added to allow a combination of these 
operators.

To add operators, click the node to which you want to add the operator and then click the 
AND or OR button. You can then drag the statements to the appropriate node. You can also 
drag whole nodes to different locations in the list box or remove statements completely.

NOTE

When dragging a statement or operator, make sure the cursor is directly above the node before releasing 
it.

Eligibility Rules and Null or Empty Values
When the Chancery SMS eligibility control processes eligibility rule criteria that references a 
field that is empty, it evaluates as false unless it uses the “is empty” operator. 

For example, if the student’s Date of Birth field is empty, the following criteria would evaluate 
as true:

age is empty

Node

Logical operators

Statement

Completed rule
(displays after the 
rule is saved)

Tree structure
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However, the following criteria would evaluate as false:

age does not equal 12

For best results, before calculating eligibility, make sure student data is complete and 
correct. 

Applying Constraints to Classes and Homerooms
After you set up constraints, you can apply or remove them for specific classes and/or 
homerooms. The constraints in the Available Constraints, Selected Constraints, and 
Mandatory Constraints lists depend on how constraints were assigned to subjects and/or 
homerooms. (See “Step 3: Select Subjects or Homerooms” on page 50).

If a constraint is available to subjects and/or homerooms, it is available to all classes for the 
selected subjects and/or all homerooms, but is not applied unless selected for specific classes 
or homerooms. If a constraint is set to default for subjects and/or homerooms, it is applied 
when homerooms or classes for that subject are created. You can manually remove the 
constraint from classes and homerooms. If the constraint is mandatory for subjects and/or 
homerooms, it is automatically applied to all homerooms and all classes for selected subjects 
and it cannot be removed. 

Chancery SMS provides several methods for applying constraints to specific classes and 
homerooms.

• From the Apply Constraints page – allows you to work with both classes and homerooms 
and shows detailed information about the constraint you are working with. For more 
information, see “Applying Constraints Using the Apply Constraints Page” on page 56.

• From the Class Setup page – shows detailed information about classes while you assign 
constraints. For more information, see “Setting Up Classes by Subject” on page 75.

• From the Homeroom Details page – shows detailed information about homerooms while 
you assign constraints. For more information, see “Setting Up Homerooms for 
Scheduling” on page 59.

Applying Constraints Using the Apply Constraints Page
The Apply Constraints page allows you to work with both homerooms and classes at the 
same time. It also shows detailed information about the constraints you are working with.

1 Log on as a school administrator.

2 In the control bar, click Scheduling.
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3 On the Scheduling page, click Constraints.

The Constraints page opens.

4 On the Constraints page, do one of the following:

• In the list of constraints, select the constraint you want to apply to classes or 
homerooms. From the Actions menu, click Apply Constraint.

• Click the number in the # of Classes column.

• Click the number in the # of HRs column.

The Apply Constraints page opens.

Class selector 
appears if 
constraint is 
available to 
subjects.

Homeroom 
selector 
appears if 
constraint is 
available to 
homerooms.
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5 On the Apply Constraints page, review the following information:

6 Under the Select Classes/Homerooms panel, do the following:
 

7 Click OK.

Field Description

Type Displays the type of constraint, i.e., Restriction.

Program Const Indicates whether the constraint applies to the specialized 
activities or courses outside of regular academic studies available 
through Program Management. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Track Program Att Indicates whether Program Management includes classes that 
are assigned this restriction in instructional minute calculations. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Strength Indicates how the constraint is applied to subjects and 
homerooms. 

Available indicates that it is available to all classes for the 
selected subject or all homerooms, but is not applied unless 
selected for specific classes or homerooms.

Default indicates that it is applied to newly created homerooms 
or newly created classes for selected subjects. You can manually 
remove the constraint from classes and homerooms.

Mandatory indicates that it is automatically applied to all 
homerooms or all classes for that subject and it cannot be 
removed.

Name Shows the name of the constraint.

Description Shows the definition of the constraint. 

To Do this

Assign the constraint to 
specific classes

1 From the Subject dropdown, select the subjects you want to 
display.

OR

Select All.

2 In the Available Classes list, select the classes and move them 
to the Selected Classes list.

NOTE
If the constraint is mandatory for the subject, you cannot remove it from 
classes and the list is not available.

Assign the constraint to 
specific homerooms

• In the Available Homerooms list, select the homerooms and 
move them to the Selected Homerooms list. 

NOTE
If the constraint is mandatory for the homerooms, you cannot remove it from 
homerooms and the list is not available.
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Setting Up Homerooms for Scheduling
You typically add homerooms when you initially set up your school. For more information 
about adding homerooms when you set up your school, see “Setting Up Homerooms” in the 
Chancery SMS School Setup Guide. Before you schedule your school for the year, verify 
existing homerooms and add, edit, or delete homerooms, as necessary.

In elementary school scheduling, students normally receive most of their instruction in their 
homeroom. In addition, attendance is taken in the homeroom. 

After you schedule subjects, you can assign students to homerooms. For more information 
about assigning students to homerooms, see “Assigning Students to Homerooms and 
Classes” on page 87.

To set up homerooms:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Homerooms.

4 On the Homerooms page, do one of the following:

5 On the Add Homeroom page or Edit Homeroom page, enter or edit the following 
information:

To Do this 

Add a homeroom • From the Actions menu, click Add Homeroom. 

Edit a homeroom • Click the homeroom number (in the HR column) of the 
homeroom you want to modify.

OR

Select the homeroom you want to modify. From the Actions 
menu, click Edit Homeroom.

Delete a homeroom Before you delete a homeroom, make sure all students assigned 
to that homeroom are re-assigned to new homerooms. Also, 
make sure no teachers are assigned to the homeroom.

1 Select the homeroom that you want to delete. 

2 From the Actions menu, click Delete Homeroom.

3 Click OK and skip the remaining steps.

Field Description

Homeroom Name Assign a name to the homeroom, usually a number, such as 6A.

Room Select the classroom number.

Capacity Enter, the maximum number of students allowed in this 
homeroom.

Teacher Assign a teacher for this homeroom. If applicable, assign up to 
two more teachers for the homeroom.

Grade Select one or more grades. If a homeroom is for a split class, 
select two grades, such as Grades 2 and 3 for a Grade 2/3 split 
class.
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6 On the Constraints panel, review the constraints assigned to the homeroom.

Constraints that are available to, but not applied to the homeroom, are listed in the 
Available Constraints list. Constraints that are applied to the homeroom are shown in the 
Selected Constraints list. Constraints that are mandatory for the homeroom are shown in 
the Mandatory Constraints list. For more information about Homeroom constraints, see 
“Working with Constraints” on page 45.

7 To change the constraints applied to this homeroom, select the constraint in the Available 
Constraint or Selected Constraint list and move it to the appropriate list. 

Attendance Indicate when attendance is taken for this homeroom. In 
elementary school scheduling, you can take full day or half day 
attendance. You cannot take class attendance; however, you can 
take supplementary attendance for individual classes. For more 
information, see the Chancery SMS School Setup Guide. 

Scheduling Group If your school uses a schedule structure, select a scheduling 
group. By default, homerooms are assigned to the Homeroom 
scheduling group. 

Changing the scheduling group changes the set of meeting 
patterns available. For more information, see “Setting Up the 
Scheduling Structure” on page 27.

Meeting Pattern If you want to assign meeting times and the scheduling structure 
is set up, select a meeting pattern. 

For more information about setting up scheduling structures, see 
“Setting Up the Scheduling Structure” on page 27.

Default Attendance Code Specify the attendance code to be assigned to students in this 
homeroom if an attendance code is not explicitly entered.

For more information about attendance, see the Chancery  SMS 
School Setup Guide. 

Field Description
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NOTE

Mandatory constraints cannot be removed from the homeroom. 

NOTE

The following step (Step 8) and the related fields are for Tennessee customers only.

8 Tennessee customers only: In the State Reporting Panel, enter or edit the following 
information:

Field Description

State Course Code If students are scheduled into self-contained homerooms, specify 
a four-digit SDE Course code. If students are scheduled into 
fully-scheduled, discrete classes, leave this value blank for 
homerooms.

Track The number assigned to the Instructional program (Track) to 
uniquely identify the instructional program within the school.

Default is “N/A” or blank which extract as Track 99.

Assigned Period Enter “Period 1”.

Constraints available to 
homerooms, but not 
applied to this 
homeroom.

Constraints applied to 
this homeroom.

Select constraints in the Available 
Constraints list or Selected Constraints 
list and click the arrows to move them 
between the lists.

These constraints 
cannot be removed 
from this homeroom.
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9 Click Save.

Printing a List of Homerooms
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Homerooms.

4 On the Homerooms List page, click the Print View icon ( ) to preview your report in the 
PDF Viewer then click the browser print button.

Scheduling Subjects
When you schedule subjects, you specify how subjects are assigned to students and how 
classes are created for the subjects. 

After the staff, rooms, subject framework, and schedule structure are set up, you can 
schedule subjects. The Subject Scheduling page displays a list of all subjects and shows 
scheduling information. From this page, you can open the Edit Subject page to change the 
scheduling setup for a class or open the Class Setup page to assign classes to subjects, as 
well as assign teachers or rooms to classes.

NOTE

The subjects and subject elements available for scheduling are defined in the Subject Framework, 
which is set up at the district. If you have questions or concerns about the subjects available at your 
school, contact your district administrator.

Duration Set this value to the duration of the student’s standard day 
including lunch, e.g., 420 minutes.

Multi-Age Specify whether the homeroom includes students who are in 
different grade levels. For example, a split-grade homeroom is a 
type of multi-age homeroom which includes students from two or 
more grades.

Field Description

To preview a report in the PDF 
Viewer, click the Print View 
icon.
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To display the Scheduling Subjects page:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Subject Scheduling.

The Subject Scheduling page displays a list of all available subjects.

The Subject Scheduling page displays the following information:

Field Description

Subject Name Lists all subjects for each grade they are offered.

To set up subject scheduling, click the subject name. 

For detailed information about setting up subject scheduling, see 
“Setting Up Subject Scheduling” on page 64.

Grade The grade the subject is offered for.

Designation Indicates whether the subject is a core or specialty subject. 

Auto-Assign Indicates whether the subject is automatically assigned to all 
students in the grade level. 

You can change the auto-assign value when you set up subject 
scheduling. For more information about setting up subject 
scheduling, see “Setting Up Subject Scheduling” on page 64.

# Classes Indicates the number of classes created for the Subject. 

To schedule classes, click the number of classes for the subject 
you want to schedule. If classes are already scheduled, the Class 
Setup page automatically filters the classes to show only the 
classes for the selected subject.

For more information about scheduling classes, see “Setting Up 
Classes” on page 71.

To set up subject scheduling, 
click the subject name.

To schedule classes, click 
the # Classes.
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Setting Up Subject Scheduling
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Subject Scheduling and then click the name 
of the subject you want to schedule.

The Edit Subject page displays information about the subject, including scheduling 
information.

4 On the Edit Subject page, in the Schedule section, indicate how a subject is to be 
scheduled:

Option Description

Can schedule To create classes for this subject, select Can Schedule.

IMPORTANT NOTE
If classes are already scheduled and you deselect this checkbox and click OK, 
the existing classes are deleted.

The top of the page 
shows subject details.
64 Setting Up Homerooms and Subject Scheduling Rules
Scheduling Subjects



Chancery SMS Scheduling Guide
5 Click OK.

If a subject is taught in a room other than the homeroom, manually adjust the room 
when scheduling the class. For more information, see “Setting Up Classes” on page 71.

Scheduling Core and Specialty Subjects
After you set up your teachers and homerooms and generic subjects, schedule the core and 
specialty subjects taught in your school. Core subjects are usually taught to all students in a 
grade. Specialty subjects might be taught to all or some students in a grade. When you 
schedule a core or specialty subject, students can be automatically assigned to that subject 
roster by grade level association.

Student To quickly assign students to a subject, select “Automatically 
assign this subject to all students in grade n”. The selected grade 
depends on which grade is associated with this subject in the 
subject framework. When you create student schedules, all 
students in the specified grade level are assigned a class for this 
subject. For more information about creating student schedules, 
see “Creating Student Schedules” on page 87.

To have complete control over which students are assigned to 
this subject, select “School will assign this subject to individual 
students”.

Default teacher Indicate the teacher you want to assign to this subject. Select 
Homeroom Teacher or select Specify and select a teacher from 
the dropdown. 

NOTE
If you select Specify, you cannot select the homeroom teacher from the 
dropdown.

If team teaching is used for this class, select “School plans to use 
team teaching”.

Number of rosters Indicate how you want to create rosters.

If you select “One roster per homeroom”, Chancery SMS creates 
one roster for each homeroom. For example, if there are three 
Grade 5 homerooms, this option creates three Language Arts 5 
rosters.

OR

You can specify the number of rosters. For example, if a 
computer lab has a limited number of computers, you might 
have to create more rosters than there are homerooms for this 
subject.

If you create two or more rosters, all students are placed in the 
first roster, by default. You can manually transfer students to 
other rosters later. For more information about transferring 
students, see the following topics:

• “Changing Classes Assigned to Students” on page 103

• “Modifying Homeroom and Class Rosters” on page 114

If you specify the number of rosters, you must also specify a 
default teacher other than the homeroom teacher.

Option Description
Setting Up Homerooms and Subject Scheduling Rules 65
Scheduling Subjects



Chancery SMS Scheduling Guide
For example:

• Language Arts is a core subject with a number of subject elements that are taught to all 
students in Grades 1 through 6. See “Example 1: Scheduling a Language Arts 5 Core 
Subject” on page 66.

• Art is a specialty subject taught to all students in Grades 5 and 6. This subject is taught 
by a specialty teacher in the Art Room. See “Example 2: Scheduling a Creative Arts 5 
Specialty Subject” on page 68.

• Computers 5 is a specialty subject taught to all Grade 5 students. However, because 
there are only fifteen computers in the Computer Lab, you must create ten Computers 5 
classes to accommodate 150 Grade 5 students. See “Example 3: Scheduling a 
Computers 5 Specialty Subject” on page 69.

Example 1: Scheduling a Language Arts 5 Core Subject
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Subject Scheduling and then click the name 
of the subject you want to schedule. For this example, click Language Arts 5.
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4 On the Edit Subject page, under Schedule, indicate how a subject is to be scheduled.

5 Make sure Can Schedule is selected.

6 To quickly assign students to a subject, select “Automatically assign this subject to all 
students in grade 5”. 

The specified grade depends on which grade is associated with this subject in the subject 
framework.

7 Indicate the teacher you want to assign to this subject. For this example, select 
Homeroom Teacher.

8 Indicate how you want to create rosters. For this example, select “One roster per 
homeroom”. If there are three Grade 5 homerooms, choosing this option creates three 
Language Arts 5 rosters.

If you select “One roster per homeroom”, classes are automatically created based on the 
number of homerooms and you cannot manually add classes to the subject. You must 
also specify a default teacher.

The top of the page 
shows subject details.
Setting Up Homerooms and Subject Scheduling Rules 67
Scheduling Subjects



Chancery SMS Scheduling Guide
9 Click OK.

If a subject is taught in a room other than the homeroom, manually adjust the room 
when scheduling the class. For more information, see “Setting Up Classes” on page 71.

Example 2: Scheduling a Creative Arts 5 Specialty Subject
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Subject Scheduling and then click the name 
of the subject you want to schedule. For this example, click Creative Arts 5.

4 On the Edit Subject page, under Schedule, indicate how a subject is to be scheduled.

For this example, select “School will assign this subject to individual students”. 

5 Make sure Can Schedule is selected.

6 Indicate the teacher you want to assign to this subject. For this example, select Specify, 
and then select a teacher other than the homeroom teacher from the list of teachers.

The top of the page shows 
subject details.
68 Setting Up Homerooms and Subject Scheduling Rules
Scheduling Subjects



Chancery SMS Scheduling Guide
7 Indicate how you want to create rosters. If the number of rosters for this subject is 
different from the number of homerooms in the subject’s grade level, select Specify, and 
then enter the number of rosters you want to create.

In this example, not all Grade 5 students are required to take Creative Art, so you need 
fewer rosters than the number of homerooms. For this example, create four rosters.

8 Click OK.

9 On the Subject Scheduling page, in the # Classes column, click the number of classes 
created for Creative Arts 5.

10 On the Class Setup page, in the # Students column, click the number of students 
assigned to the first roster. 

11 On the Class Roster page, from the Actions menu, click Add Students.

12 Search for and add students to the roster. Click OK.

13 Repeat Steps 10 to 12 for the next roster.

14 Click OK. 

Example 3: Scheduling a Computers 5 Specialty Subject
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 3, click Subject Scheduling.

4 On the Subject Scheduling page, click the name of the subject you want to schedule. For 
this example, click Computers 5.

5 On the Edit Subject page, under Schedule, indicate how a subject is to be scheduled.

For this example, select “School will assign this subject to individual students”. 

6 Make sure Can Schedule is selected.

7 Indicate the teacher you want to assign to this subject. For this example, select Specify, 
and then select a teacher other than the homeroom teacher from the list of teachers.

8 Indicate how you want to create rosters. If the number of rosters for this subject is 
different from the number of homerooms in the subject’s grade level, select Specify, and 
then enter the number of rosters you want to create.

In this example, the Computer Lab might have a limited number of workstations. In order 
for each student in the class to get their own computer, you need to create more rosters 
than there are homerooms. For this example, create ten rosters.

If you create two or more rosters, all students are placed in the first roster by default. 
You can manually transfer students to other rosters later. For more information about 
transferring students, see the following topics:

• “Changing Classes Assigned to Students” on page 103
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• “Modifying Homeroom and Class Rosters” on page 114

9 Click OK, and click OK again.

If a subject is taught in a room other than the homeroom, manually adjust the room 
when editing a schedule. For more information, see “Setting Up Classes” on page 71.

The top of the page 
shows subject details.
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Defining Schedules for Classes
When you define schedules for classes, you assign teachers and rooms to classes. In 
addition, if you want to track instructional minutes and have set up the scheduling structure, 
you can also assign meeting patterns to classes. 

NOTE

For Tennessee customer only: EIS reporting does not use the schedule structure when calculating 
instructional minutes. Enter class schedule information in the Assigned Period and Duration fields by 
clicking the Custom link on the Class Setup page. For more information, see “Setting Up Classes by 
Subject” on page 75.

Setting Up Classes 
After you set up staff, rooms, homerooms, subjects, and the schedule structure (if desired), 
you can adjust the setup of individual classes. You can change the teachers assigned to 
classes, assign additional teachers to classes, assign classes to rooms, and assign meeting 
patterns to classes. 

When classes are created, they are assigned to the default scheduling group. For more 
information about scheduling groups, see “Defining Scheduling Groups” on page 27.

You can use the Class Setup page to work with classes by subject, by teacher, or by room. 
For more information about setting up classes, see the following topics:

• “Setting Up Classes by Subject” on page 75

• “Setting Up Classes by Teacher” on page 80

• “Setting Up Classes by Room” on page 82
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To open the Class Setup page:
1 In the control bar, click Scheduling. 

2 On the Scheduling page, under Step 4, click Class Setup. 

The Class Setup page opens.

The following table describes the fields available in the Search Results on the Class Setup 
page and indicates any differences for the By Subject, By Teacher, or By Room options.

Click a tab to work with 
classes by subject, teacher, 
or room.
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NOTE

You can change the columns displayed on this page. For more information, see “Changing Display 
Options in the Search Results Sections” on page 74.

Field Description

List The working lists of your recent searches. 

Status Indicates whether the class has any conflicts. 

This column is blank until you click Save after making changes. 
It is also blank when the class has no conflicts.

This column may contain the following icons:

A teacher conflict for this class - that is, this class is 
scheduled but the teacher is scheduled for another class in 
the same period.

A room conflict for this class – that is, this class is 
scheduled but the room is assigned to another class at the 
same time.

Class Name The name of the class. 

Chancery SMS automatically creates a class name that indicates 
the generic subject name and the grade level. It also adds the 
homeroom number in round brackets (if One Roster per 
Homeroom is selected for the class) or the class number in 
square brackets (the number of rosters are specified for the 
class). You can change the default class name on the Class Setup 
page.

Term If the schedule structure is set up and the class is assigned a 
meeting pattern, this field displays the term the class is offered 
in. 

NOTE
For schools using elementary scheduling, only full year term (FYT) is 
available. 

Meeting Pattern If the schedule structure is set up and the class is assigned a 
meeting pattern, this field displays the class meeting pattern. 

In elementary school scheduling, you do not need to assign a 
meeting pattern to classes unless you want to track instructional 
minutes or use supplementary attendance.

NOTE
For Tennessee customers only: EIS reporting does not use the schedule 
structure when calculating instructional minutes. Enter class schedule 
information in the Assigned Period and Duration fields by clicking the Custom 
link on the Class Setup page. For more information, see “Setting Up Classes” 
on page 71.

Teacher The teacher assigned to the class. 

Room The room where the class is taught. If the class is taught in the 
homeroom, this field displays the homeroom number. 

# Students The number of students currently scheduled for the class. This 
number includes students who are scheduled to start the class in 
the future and excludes students who have been withdrawn from 
the class. 

Capacity Does not apply to schools using elementary scheduling. 
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Changing Display Options in the Search Results Sections
The Class Setup page has tabs to allow you to set up classes by class, by teacher, or by 
room. Each tab includes search panels that allow you to search for specific classes, teachers, 
or rooms. On each of these search panels, you can change the information displayed in the 
search results section. 

To change the information displayed on the screen:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 Click the By Class, By Teacher, or By Room tab.

5 From the Edit menu, do one of the following:

6 In the Available Columns list, select the columns you want to display, and then click  
to move them to the Selected Columns list.

Class # Does not apply to schools using elementary scheduling.

Class Code The code for the class. 

Course # The subject number of the subject associated with the class.

Course Alternate Name Does not apply to schools using elementary scheduling.

Course Name The subject name of the subject associated with the class.

Course Short Name Does not apply to schools using elementary scheduling.

Scheduling Group If the schedule structure is set up and the class is assigned a 
meeting pattern, this field displays the scheduling group 
assigned to the class. 

State Course # Does not apply to schools using elementary scheduling. 

Teacher 2 If additional teachers are assigned to the class, this field displays 
the second teacher’s name. 

Teacher 3 If additional teachers are assigned to the class, this field displays 
the third teacher’s name.

Team Does not apply to schools using elementary scheduling.

Flag A “T” in this column indicates that the class is being taught by a 
teacher other than the homeroom teacher.

An “S” in this column indicates that the class has students from 
outside the homeroom.

On this tab Do this

Class Click Choose Columns > Class Search Results

Teacher Click Choose Columns > Teacher Search Results

Room Click Choose Columns > Room Search Results

Field Description
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7 Use the  and  buttons to set the display order.

8 Click OK.

Setting Up Classes by Subject
When you set up classes by subject, classes are grouped by subject heading so you can 
easily see which classes have been created for each subject. 

NOTE

If, on the Edit Subject page, a subject is configured to have one roster for each homeroom, classes are 
created automatically based on the number of homerooms and you cannot add classes to the subject. 

To schedule classes for subjects:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 On the Class Setup page, click the By Subject tab. 

To set up classes by subject, 
click the By Subject tab.
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5 Expand the Course Search panel and search for subjects.

OR

Click Display All Records.

6 On the Class Setup page, do one of the following:

To Do this

Add a class to a subject • Click the Add button next to the subject and enter information 
about the class in the Class Information and Class Schedule 
sections. 

NOTE
If a subject does not have an Add Class button, the subject is configured to 
have one roster for each homeroom and you cannot add classes to the 
subject.

By default, if 
Number of Rosters 
is “One per 
homeroom” on the 
Edit Subject page, 
class names show 
the homeroom 
number in 
brackets.

By default, if 
Number of Rosters 
is “Specify” on the 
Edit subject page, 
class names show 
the class number in 
square brackets.

An Add Clas
button appe
beside the 
subject nam
Number of 
Rosters is 
“Specify” on
Edit Subject
page.

To open the Edit 
Subject page, click the 
generic subject name.

To display the class 
roster, click the # 
students.
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7 On the Class Information panel, enter the following information, as required:

Edit class information • Click in the row of the class you want to edit, being careful not 
to click a link. When you click in the row for a class, the focus 
moves to that class.

The Class Information, Class Constraints, State Reporting 
(Tennessee customers only), and Class Schedule sections 
open at the bottom of the page.

Delete a class for a subject 1 Select the class you want to delete. 

2 From the Action menu, click Delete Class Schedules. Click OK 
and skip remaining steps.

NOTE
When Can Schedule is selected for a subject and the Number of Rosters is set 
to “Specify”, the first class that Chancery SMS creates is used for automatic 
scheduling. You can rename this class, but you cannot delete it. If you want 
to delete all classes, on the Edit Subject page, deselect Can Schedule. 
Deselecting Can Schedule also removes the subject from the Class Setup 
page.

Individual classes for a room cannot be deleted. To remove all classes for a 
homeroom, delete the homeroom.

Field Description

Name Chancery SMS automatically creates a class name that indicates 
the generic subject name and the grade level. It also adds the 
homeroom number in round brackets (if one roster per 
homeroom is selected for the class) or the class room number in 
square brackets (if the number of rosters are specified for the 
class). 

You can change the class name.

NOTE
To ensure class names are visible on screens and reports, limit the length of 
the name to 25 characters. 

Code Enter a code for the class (optional).

Scheduling Group Select the scheduling group this class belongs to. Classes must 
be assigned to a scheduling group, even if you are not using a 
schedule structure. For more information about scheduling 
groups, see “Defining Scheduling Groups” on page 27.

Class Comment Additional information about the class. You can enter up to 270 
characters.

Use Homeroom Classroom If this class is taught in the homeroom classroom, select this 
option. If this option is selected, you cannot specify a room in 
the Class Schedule section for this class. 

Collect Attendance Select this option, if your school uses supplementary attendance 
and you want to collect supplementary class attendance for this 
class. For more information about supplementary class 
attendance, see the Chancery SMS School Setup Guide.

NOTE
All classes that collect supplementary attendance must be assigned a 
meeting pattern. 

To Do this
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NOTE

The following steps (Steps 8 to 10) are for Tennessee customers only.

8 Tennessee customers only: Click Custom.

9 Tennessee customers only: On the State Reporting panel, enter the following 
information and click Apply:

10 Tennessee customers only: Click OK.

11 On the Class Constraints panel, review the constraints for the class.

Constraints available, but not applied, to this class are listed in the Available Constraints 
list. Constraints applied to this class are shown in the Selected Constraints list. 
Constraints that are mandatory for this class are shown in the Mandatory Constraints list. 

For more information about constraints, see “Working with Constraints” on page 45.

Default Attendance Code If your school uses supplementary class attendance and 
supplementary class attendance is collected for this class, 
specify whether the attendance code should be assigned to this 
class by default. For more information about default attendance 
and supplementary class attendance, see the Chancery SMS 
School Setup Guide. 

Field Description

Track The number assigned to the Instructional program (Track) to 
uniquely identify the instructional program within the school. If 
no tracks are used, leave blank, which extracts as Track 99.

Assigned Period Period of the day the class is to meet.

Duration Period duration in minutes, excluding lunch.

If your school uses self-contained homerooms and pullouts, the 
duration set for pullout classes is not included in the student’s 
standard day.

If your school uses fully-scheduled, discrete classes, the total 
duration for all traditional classes must be equal to the student’s 
standard day excluding lunch. 

Field Description
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12 To change the constraints applied to this class, select the constraint in the Available 
Constraint or Selected Constraints list and move it to the appropriate list. 

NOTE

Mandatory constraints cannot be removed from the class.

13 On the Class Schedule panel, enter the following information:

14 To add another class schedule for the class, click Add More Detail and enter the class 
schedule information. 

NOTE

For Tennessee customers only: EIS Reporting does not support additional information entered using 
the Add More Detail option.

15 Click Save.

Field Description

Meeting Pattern To assign specific meeting times for the class, select a meeting 
pattern. For more information about meeting patterns, see 
“Creating Meeting Patterns” on page 39.

Teacher Select the teacher who teaches the class.

Other Teacher If the class uses team teaching, select up to two additional 
teachers for the class. 

For more information about team teaching, see “Working with 
Team Teaching” on page 83.

Room If “Use homeroom as classroom” option is not selected on the 
Class Information panel, select the room where the class is 
taught. 

If the class is taught in the homeroom, you cannot specify 
another room.

Constraints 
available to this 
course, but not 
applied to this class.

Constraints applied 
to this class.

Select constraints in the Available Constraints 
list or Selected Constraints list and click the 
arrows to move them between the lists.

These constraints 
cannot be removed 
from this class.
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Setting Up Classes by Teacher
When you set up classes by teacher, classes are grouped under a teacher heading so you can 
easily see which teachers are assigned to which classes. The teacher heading displays the 
teacher name plus their teacher number. 

You can change the columns displayed in the Teacher Search Results and Class Search 
Results sections. For more information, see “Changing Display Options in the Search Results 
Sections” on page 74.

To assign a class to a teacher:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 On the Class Setup page, click the By Teacher tab. 

5 In the Teacher Search panel, search for a teacher.

6 In the Class Search panel, search for a class. 

7 In the Class Search Results, select the class you want to assign.
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8 In the Teacher Search results, next to the teacher you want to assign the class to, click 
Add. 

You can assign a class to up to three teachers.

9 Click Save.

To delete a class from a teacher:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 On the Class Setup page, click the By Teacher tab. 

5 On the Teacher Search panel, search for teachers.

6 In the Teacher Search Results, select the class you want to delete for a teacher. 

7 From the Actions menu, click Remove from Schedule.

8 Click Save.

Search for teachers.

Search for and select 
classes.

Next to the teacher you want to 
assign the class to, click Add.
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Setting Up Classes by Room
When you set up classes by room, classes are grouped under rooms so you can easily see 
which rooms are assigned to which classes. Classes taught in a homeroom are listed under 
the room assigned to the homeroom. 

You can change the columns displayed in the Room Search Results and Class Search Results 
sections. For more information, see “Changing Display Options in the Search Results 
Sections” on page 74.

To add a class to a room:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 On the Class Setup page, click the By Room tab. 

5 On the Room Search panel, search for a room. 

6 On the Class Search panel, search for a class. 

7 In the Class Search Results, select the class you want to assign.

8 In the Room Search Results, next to the room you want to assign the class to, click Add. 

Classes can only be assigned to one room. If the class is already assigned to a room, 
assigning to another room changes the room assignment for the class. 

9 Click Save.

Search for rooms.

Search for and select 
classes.

Next to the teacher you 
want to assign the class to, 
click Add.
Note that when you click 
Add, the class is reassigned 
from room 2a to room 1.
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To delete a class from a room:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 4, click Class Setup.

4 On the Class Setup page, click the By Room tab. 

5 On the Room Search panel, search for a room.

6 In the Room Search Results, select the class you want to delete from the room.

7 From the Actions menu, click Remove from Schedule.

8 Click Save.

Working with Team Teaching
Team teaching is useful when scheduling multiple teachers for subjects, especially core 
subjects. To accommodate teacher interests and qualifications, student learning level, and 
teaching assistants, set up your subjects to allow for team teaching as needed.

You can set up team teaching in two ways:

• Change the teacher for team teaching classes

• Transfer students between team teaching classes

Example of Changing Teachers for Team Teaching Classes
This example of team teaching illustrates how you might modify class schedules so a specific 
teacher is assigned to a specific subject. For example, Grade 3 students are required to take 
Language Arts. In your school, Mr. Smith teaches all the Language Arts 3 classes.

1 Set up a subject, such as Language Arts 3, with the following scheduling options 
selected:

• Students: automatically assign this subject to the selected grade

• Default teacher: Homeroom Teacher and School Plans to Use Team Teaching

• Number of classes: One Roster per Homeroom

For more information about setting up subjects, see “Reviewing the Subject Framework” 
on page 25.

2 On the Scheduling page, under Step 4, click Class Setup.

3 On the Class Setup page, click the By Subject tab.

4 In Subject Search, search for all classes in which “Uses Team Teaching” equals “Yes”.

5 Select the first Language Arts 3 class you want to set up for team teaching.

6 In the Class Schedule section, from the Teacher dropdown, select Mr. Smith and click 
Save. 

7 Select the next Language Arts 3 class and repeat Step 6. Repeat this step until you have 
assigned a teacher to all Language Arts 3 classes. Click OK.

On the Classes page, note the Flag column. A “T” in this column indicates that the class is 
being taught by a teacher other than the homeroom teacher. 
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Example of Transferring Students to Team Teaching 
Classes
This example illustrates how you might use team teaching to assign specific students to 
certain teachers. For example, grade 5 has three levels of Math: weaker, regular, and 
stronger. Your school has three Grade 5 homerooms: 5-A, 5-B, and 5-C. The 5-A teacher 
teaches the weaker group, the 5-B teacher teaches the regular group, and the 5-C teacher 
teaches the stronger group. You can transfer your Grade 5 students from their default class 
roster to the class roster that best suits their mathematics ability.

1 Set up the Math 5 subject with the following scheduling options selected:

• Students: Automatically Assign This Subject to the Selected Grade

• Default teacher: Homeroom Teacher and School Plans to Use Team Teaching

• Number of classes: One Roster per Homeroom

2 On the Scheduling page, under Step 4, click Class Setup.

3 Select Math 5 (5-A), Math 5 (5-B), and Math 5 (5-C).

4 From the Actions menu, click “Transfer Students between Classes”. 

5 At the top of the page, select Math 5 (5-A). In the list of students for the selected classes, 
select the weaker math students in Math 5 (5-B) and Math 5 (5-C). Click “Transfer to 
Selected Class”.

6 Repeat Step 4 and 5 to transfer the regular students into Math 5 (5-B) and again to 
transfer the stronger students into Math 5 (5-C).

7 Return to the Classes page.

On the Classes list, note the Flag column. An “S” in this column indicates that the class 
has students from outside the homeroom.

Scenarios of Team Teaching
The following are some team teaching scenarios you might encounter in your school, which 
you can accommodate by changing the teacher assigned to a homeroom, class, or subject 
roster.

Scenario 1:

Swap rosters to accommodate teacher interests and qualifications.

The Homeroom 6-A teacher excels at teaching Math while the Homeroom  
6-B teacher excels at teaching Social Studies.

Set up Math 6 and Social Studies 6 as subjects that allow team teaching. Edit the Class 
Schedule for these classes so that the Homeroom 6-A teacher provides instruction for both 
Math classes and the Homeroom 6-B teacher provides instruction for both Social Studies 
classes.
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Scenario 2:

Two teachers are assigned to one homeroom, but teach different subjects. This is also 
referred to as co-teaching.

Homeroom 4-A is a homeroom with shared teaching responsibilities provided by Mr. Jones 
and Mrs. Garcia.

Edit the Class Schedule for Homeroom 4-A so Mr. Jones teaches Math while Mrs. Garcia 
teaches Social Studies.

Scenario 3:

Miss Smith is the primary teacher in Homeroom 5-B. In addition, a Teaching Assistant is 
assigned to Homeroom 5-B.
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Assigning Students to Homerooms and 
Classes
Build homeroom rosters by assigning students to homerooms. Before building homeroom 
rosters, set up the homerooms for your school. For more information about setting up 
homerooms, see “Setting Up Homerooms for Scheduling” on page 59.

If constraints are applied to a homeroom or class, the constraints are enforced at the time 
you assign students to homerooms or stand-alone classes. If the student does not fit the 
criteria, Chancery SMS displays an error message. If you have permission to override 
constraints, you can override the constraint to schedule the students into specific classes. For 
more information about constraints, see “Working with Constraints” on page 45.

Based on the student’s homeroom assignment, Chancery SMS assigns students to core 
classes and creates class rosters. For more information, see “Creating Student Schedules” on 
page 87. You can then adjust the class roster by transferring students to different classes.

All students in your school must be assigned to a homeroom. To quickly determine which 
students have yet to be assigned to a homeroom, search for students, and sort your search 
results by homeroom (HR). Students with an N/A homeroom are displayed together. 

NOTE

You can also change the information displayed on the Student Search Results page. For more information 
about changing the display, see “Changing Display Options on the Student Search Results Page” on 
page 91.

Creating Student Schedules
In elementary schools, student class schedules are often based on their homeroom 
assignments. If subject options are set up to automatically assign the subject to all students 
in a grade, you can have Chancery SMS automatically create class schedules based on the 
student’s homeroom and grade assignments. After you assign students to homerooms, 
create student schedules to automatically assign students to classes based on their 
homeroom assignment. In general, you will create student schedules when scheduling in the 
planning calendar and early in the active calendar. 

NOTE

You cannot create student schedules if grades or attendance have been entered for the student. 

For information about setting subject options, see “Scheduling Subjects” on page 62.

To create student schedules:
1 Log on as an school administrator. 

2 In the control bar, click Scheduling. 

3 On the Scheduling page, under Step 5, click Create Student Schedules. 
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4 On the Create Student Schedules page, select one of the following options:

5 Click OK. 

Transferring Homerooms from Student Search Results
In elementary school scheduling, all students must be assigned to a homeroom. The Transfer 
Homeroom page provides additional information about the distribution of students within 
homerooms that can assist you in assigning homerooms. On the Student Search Results 
page, where you select students to transfer, you can customize the display to show such 
information as gender and ethnic category, which may help you build balanced homeroom 
rosters. For more information about customizing the display, see “Changing Display Options 
on the Student Search Results Page” on page 91.

NOTE

You can also change a student’s homeroom assignment on the Student Demographics page. However, the 
Transfer Homeroom page provides more detailed information about the available homerooms. For more 
information about enrolling students and assigning homerooms, see the Chancery SMS School Setup 
Guide.

Option Description

All students Creates the student class assignments for all subjects that 
are set up to automatically assign the subject to all 
students in a grade. 
If a student already has auto-created class assignments for 
some of these subjects, these classes are cleared from their 
schedules and recreated as of the first day of school. 

Manually assigned or modified class schedules are not 
changed. 

NOTE
In the active calendar, if you manually drop a class and re-assign the 
student to another class using the effective date option, “First Day of 
School”, the class change is deleted and the student is reassigned to 
their auto-generated class (except if both classes belong to the same 
subject; in this case the student must be manually reassigned). 

If you want to ensure this type of class change is not deleted, set the 
effective date to be the second day of school. However, be aware that 
this could affect grading and attendance at your school.

In the planning calendar, if you select this option, manually dropped 
classes are recreated in the students’ schedules.

Students with no 
auto-scheduled classes

Creates student class assignments for subjects that are set 
up to automatically assign the subject to all students in a 
grade only if an auto-created class for that subject does not 
already exist. 

If a student already has auto-created class assignments for 
some subjects, these classes are not cleared from their 
schedules. 

Manually assigned or modified class schedules are not 
changed. 
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To transfer student homerooms:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Student Search.

4 Perform a basic or detail search, or click Display All Records.

5 On the Student Search Results page, select the students you want to assign to a 
homeroom.

For example, choose a group of Grade 5 students that you want to assign to a Grade 5 
homeroom.

To help you determine the best homeroom assignment for specific students, you can 
adjust the information displayed on the student search page in the following ways:

• To display incoming or withdrawn students, click Edit > Include Incoming Students or 
Edit > Include Withdrawn Students (current year). You might want to include 
incoming students in the search results so you can assign pre-enrolled students to 
homerooms.

• To select columns to display on the page, click Edit > Choose Columns.

• To sort information in columns, click the column heading or, to create a sort order, 
click Edit > Sort.

6 From the Actions menu, click Transfer Homeroom.

7 On the Transfer Homeroom page, select the homeroom you want to transfer the selected 
students to, such as Homeroom 1-A.

8 Click OK.

To adjust the balance and mix of students in a homeroom, repeat this procedure as many 
times as required.

Check to see if the homeroom 
has enough space to 
accommodate the selected 
students.
An exclamation mark indicates 
the homeroom is full.

The numbers correspond to the 
Ethnic Categories.
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Changing Class Assignments
If subjects are set up to automatically assign classes to all students in a specified grade, the 
student’s schedule automatically includes these classes. From the student’s schedule, you 
can change automatic class assignments and assign classes that are not automatically 
assigned, such as specialty subjects. 

To change class assignments:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Student Search.

4 Search for the students and, in the Search Results, select the students you want to 
transfer. 

5 From the Actions menu, click Open Student > Schedule.

6 If you are working in the active calendar, in Changes Effective, select the date you want 
the change to take effect.

7 Do one of the following:

To Do this

Add a class to the student’s 
schedule

1 If you are working in the active calendar and Change Reasons 
are required, in the Change Reason dropdown, select the 
reason you are changing the student’s schedule.

2 In the Class Search section, search for the class you want to 
add. Select the class and click Add Class. 

If you are working in the 
active calendar, specify 
the date you want the 
change to take effect.

The Change Reason 
dropdown is available in 
the active calendar if 
change reasons are set up 
at the district.
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8 Click Save.

Changing Display Options on the Student Search 
Results Page
1 Log on as a school administrator.

2 On any Student Search Results page, from the Edit menu, click Choose Columns.

3 On the Choose Columns page, select the columns that you want to display.

For example, to ensure all homerooms have a balance of boys and girls, along with a mix 
of ethnic categories, you might select the following columns: 

• Name

• Homeroom

• Gender

Drop a student from the 
class roster

1 If you are working in the active calendar and Change Reasons 
are required, in the Change Reason dropdown, select the 
reason you are changing the student’s schedule.

2 From the student’s schedule, select the class you want to 
remove. Click Drop Class.

Transfer a student to a 
different class

1 If you are working in the active calendar and Change Reasons 
are required, in the Change Reason dropdown, select the 
reason you are changing the student’s schedule.

2 In the Class Search section, search for the class you want to 
add. From the student’s schedule, select the class you want to 
remove. Click Transfer Class.

To Do this

To display a column, click an item in 
the Available Columns list, and then 
click the -> button.
To remove a column, click an item in 
the Selected Columns list, and then 
click the <- button.

To set the column order, select an 
item, and then click the Up or Down 
arrow. 
The order of the list (from top to 
bottom) corresponds to the order of 
the columns (from left to right).
Assigning Students to Homerooms and Classes 91
Changing Display Options on the Student Search Results Page



Chancery SMS Scheduling Guide
• Ethnic Category

4 To return to the Student Search Results page, click OK.

5 From the Edit menu, click Sort.

6 On the Sort page, indicate how you want the data to be sorted.

NOTE

You can sort your data by columns not visible on the screen. For example, you might not see the 
Gender column, but you can still sort by gender.

7 Click OK.
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Setting Up Resource Services (active 
calendar only)
In addition to core and specialty subjects, you can set up resource services. For example, 
you can set up resource services for Remedial Reading and Math, Speech Therapy, Gifted and 
Talented Enrichment, and so on.

Resource services are typically taught by a resource teacher (who often moves between 
several schools). The resource service is usually taught in a small group or on an individual 
basis, either in a “pull-out” format where students are moved to another room for the class, 
or in an “inclusion” format where students are taught the resource service in the regular 
classroom.

You do not have to create classes for resource services. You can specify when each student 
receives a service, and whether it is given in an inclusion or in a pull-out format.

NOTE

For Tennessee customers only: Resource services are not displayed on the District Setup > Schools > 
Classes page. As a result, resource services are not reported to EIS. To include special education classes 
in EIS reports, do not set up special education classes as resource services. Create a subject and 
schedule a class, as you would with regular classes.

Creating Resource Services

To create a resource service:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 6, click Resource Services.

4 From the Actions menu, click Add Resource Service.

The Add Resource Service page opens.
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5 On the Add Resource Service page, enter the necessary information.

6 Click OK.

To change resource services:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 6, click Resource Services.

4 Click the resource service name you want to change.

OR

To change multiple resource services, select the resources services you want to change. 
From the Actions menu, click Edit Resource Services.

5 Change the information for the selected resource services. Click OK.

Assigning Resource Services to Students
After resource services are set up, you can schedule students to receive the resource service. 
For more information about setting up resource services, see “Creating Resource Services” 
on page 93.

You can also schedule resource services for individual students from the Student Schedule 
page. For more information, see “Scheduling Resource Assignments” on page 107.

To schedule resource assignments:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 6, click Resource Roster.

4 On the Resource Roster page, from the View dropdown, select a specific resource service, 
a specific resource assignment, or All Resource Assignments.

To display students who have received a resource service in the past or are scheduled to 
receive resource services in the future, but who are not currently receiving resource 
services, from the Edit menu, click Show Incoming Students or Show Past Students.

Field Description

Resource Service Name Enter a resource service name, such as Reading Recovery.

Short Name Enter a short name.

Service Number Enter the resource service number.

Related Subject Select a subject or subject element.

Default Teacher If necessary, select the default teacher for this resource service.
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5 Do one of the following:

When you add or edit a resource assignment, the Add Resource Assignment or Edit 
Resource Assignment page opens.

6 On the Add Resource Assignment or Edit Resource Assignment page, enter or edit the 
necessary information.

To Do this

Add a resource assignment • From the Actions menu, click Add Resource Assignment.

Edit a resource assignment • Click the name of the resource assignment you want to edit.

OR

Select the resource assignment you want to edit. From the 
Actions menu, click Edit Resource Assignment.

Delete a resource 
assignment

1 Select the resource assignment you want to delete. 

2 From the Actions menu, click Delete Resource Assignment. 

3 Click OK and skip the remaining steps.

Field Description

Student Name Click Select Student to search for and select a student.

Resource Service Select a resource service. After you save this record, this field 
becomes view-only.

Related Subject Shows any related subjects defined for the resource service.

Comment Enter a comment of up to 500 characters, such as the reason the 
student is assigned this resource service.
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7 Click OK.

To keep track of resource assignment changes, or to copy the same resource information 
to multiple students, see “Tracking Resource Assignment Changes” on page 96.

Tracking Resource Assignment Changes
The schedule of a student’s resource assignments might change during the school year. For 
example, the amount of time they receive the resource service might increase from 120 
minutes to 180 minutes each week beginning on November 1. You might need to track both 
the old and new schedules. You can change the student’s resource assignment end date to 
October 31, duplicate the resource assignment, and change its start date to November 1 and 
its minutes per week to 180.

When several students take the same resource service together, duplicate the resource 
assignment and change the student information.

To duplicate a resource assignment:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 6, click Resource Roster.

4 On the Resource Roster page, select the student whose resource assignment you want to 
duplicate. 

If necessary, from the View dropdown, select an option to narrow the list of students.

5 From the Actions menu, click Copy Resource Assignment.

Start and End date Enter the dates that the resource assignment will start and end.

If a student’s resource schedule changes during the year, you 
can duplicate the student’s resource assignment and change the 
scheduling information. See “Tracking Resource Assignment 
Changes” on page 96.

Instructional Model Select whether this resource service is taught in the regular 
classroom, or if it is taught in another room. If it is taught in a 
different room, specify the room.

Teacher Select up to three teachers for the resource assignment.

Minutes Per Week Enter the number of minutes this student receives this resource 
service each week.

Meeting Times Enter the time that the student and teacher will meet for the 
resource assignment.

Field Description
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6 To assign the resource service to another student, on the Add Resource Assignment page, 
click Select Student beside the student name. In the Select Student dialog, choose 
another student and click OK.

OR

To change resource information for the same student, change the roster information such 
as the resource service, start and end dates, minutes per week, or the meeting time.

For example, if a student’s resource assignment changes from 120 to 180 minutes each 
week starting November 1, enter 180 minutes and a start date of November 1. Then, in 
the student’s old resource assignment, change the end date to October 31.

7 Click OK.
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Working with Student Schedules
If subjects are set up to automatically assign the subject to all students in a grade, when you 
assign students to homerooms and create student schedules, Chancery SMS schedules 
students into automatically-generated classes. You can then view student schedules and 
make any necessary adjustments.

NOTE

Student schedules display the student’s schedule as of the end of the school year. To see changes made 
to the student’s schedule and their effective date, from the Actions menu, click View Change History. 
For more information about Change History, see “Viewing Change History” on page 108.

Opening Student Schedules
You can use the Student Schedule page to view and adjust individual student schedules. 
From this page, you can also assign subject exceptions, manually assign classes, or assign 
resource assignments. 

You can open student schedules for individual students from the Student Demographics 
page, or you can go directly to the student schedule for one or more students from any 
student search results page. 

NOTE

The Open Student>Schedules option on the Student Search Results page offers a quick way to open 
student schedules and allows you to open multiple student schedules at one time. 

Task Procedure

Open a student schedule from 
the Student Demographics page

1 Open the student record you want to view. 

For information about opening student records, see “Working 
With Student Records” on page 10. 

2 On the Student Demographics page, in the control bar, click 
Schedule.
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Understanding the Student Schedule Page
This section provides an overview of the Student Schedule page. For detailed procedures 
about using the Student Schedule page, see the following topics:

• “Changing Classes Assigned to Students” on page 103

• “Transferring Homerooms from Student Schedules” on page 104

• “Using Subject Exceptions” on page 105

• “Scheduling Resource Assignments” on page 107

• “Viewing Change History” on page 108

Opening Student Schedules 
From Student Search Results

1 Log on as a school administrator.

2 Search for a student.

3 From the Student Search Results, select the students whose 
schedules you want to view. 

4 From the Actions menu, click Open Student>Schedule. 

5 If you selected more than one student, on the Student 
Schedule page, click Prev and Next to page through the open 
student schedules.

Task Procedure
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The Student Schedule page displays the following information:

NOTE

To change the information displayed on this page, from the Edit menu, click Choose Columns.

Field Description

Term Indicates which term the subject is taught in. 

In elementary schools, all subjects are scheduled for the full year 
term (FYT).

Meeting Pattern Indicates the meeting pattern assigned to the class. 

In elementary school scheduling, assigning meeting patterns to 
classes is optional.

For information about assigning meeting patterns to classes, see 
“Setting Up Classes” on page 71.

Class Name Indicates the name of the class. 

To display the class roster, click the class name.

Teacher Indicates the teacher assigned to teach this class. 

For more information about assigning teachers to classes, see 
“Setting Up Classes” on page 71.

Room Indicates the room assigned to the class.

For information about assigning rooms to classes, see “Setting 
Up Classes” on page 71.

Details Click the icon to view additional information about the class and 
subject.
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Assigning and Reassigning Default Classes
For subjects set up to automatically assign the subject to all students in a grade, default 
classes are assigned to students based on their homeroom assignment. In general, the 
default classes are assigned when you create student schedules during the scheduling 
process. For more information, see “Creating Student Schedules” on page 87. However, if a 
student enrolls in a school after schedules are created, you may want to assign default 
classes for individual students. If you have the Subject Scheduling permission set to “Yes”, 
you can also recreate an individual student’s schedule by reassigning default classes. 

IMPORTANT NOTE

When you assign or reassign default classes, Chancery SMS recreates classes based on homeroom and 
grade. If a student is transferred from one homeroom to another in the middle of the school year, 
Chancery SMS generates a set of class assignments for the student’s previous homeroom or grade from 
the first day of school to the transfer day, then another set of class assignments for the new homeroom 
or grade from the transfer day to the last day of school. The Effective Date option is not considered. 
Manually added classes are not changed.

To assign default classes:
1 Log on as a school administrator.

2 Open a student record. 

3 In the control bar, click Schedule. 

4 On the Student Schedule page, click Assign Default Classes. 

NOTE

If the Assign Default Classes button is not available or is replaced with the Reassign Default Classes 
button, this student already has at least one default class assigned. 

5 Click OK. 

Changes Effective If you are working in the active calendar, specify the date the 
changes will take effect. The specified date will apply to all 
changes made.

NOTE
If you set the effective date to “First Day of School” and manually drop or 
transfer classes from a student’s schedule, if you then create student 
schedules for all students, the dropped classes are re-added to the student’s 
schedule. If you enter a specific date (i.e. not the first day of school), the 
classes are not re-added. For more information about creating student 
schedules, see “Creating Student Schedules” on page 87.

Change Reason In the active calendar, this dropdown appears if change reasons 
are defined at the district. Change reasons may be required or 
optional. 

If change reasons are required, you must enter a different 
change reason code for each change (add, drop, transfer) made 
to the students schedule.

Select the reason the students schedule is being changed.

Field Description
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To reassign default classes:
1 Log on as a school administrator. 

2 Open a student record. 

3 In the control bar, click Schedule. 

4 On the Student Schedule page, click Reassign Default Classes. 

NOTE

If the Reassign Default Classes button is not available, make sure you have the Subject Scheduling 
permission set to “Yes”. If the Assign Default Classes button is available, the student does not 
currently have any default classes assigned. 

5 Click OK. 

Changing Classes Assigned to Students
NOTE

Student schedules display the student’s schedule as of the end of the school year. To see changes made 
to the student’s schedule and their effective date, from the Actions menu, click View Change History. 
For more information about Change History, see “Viewing Change History” on page 108.

If subjects are set up to automatically assign classes to all students in a specified grade, once 
you create student schedules, the student’s schedule automatically includes these classes. 
For more information about creating student schedules, see “Creating Student Schedules” on 
page 87.

From the student’s schedule, you can change automatic class assignments and assign classes 
that are not automatically assigned, such as specialty subjects. On the Student Schedule 
page, you can add, drop, or transfer courses in the student’s schedule. 

To change classes assigned to students:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 If you are working in the active calendar, from the Changes Effective dropdown, select 
when you want the changes to take effect.

NOTE

If you set the effective date to “First Day of School” and manually drop or transfer classes from a 
student’s schedule, if you then create student schedules for all students, the dropped classes are re-
added to the student’s schedule. If you enter a specific date, the classes are not re-added. For more 
information about creating student schedules, see “Creating Student Schedules” on page 87.

4 Do one of the following:

To Do this

Add a class to the student’s 
schedule

1 If you are working in the active calendar and change reasons 
are set up at the district, select the reason the student’s 
schedule is being changed.

2 In the Class Search section, search for the class you want to 
add. Select the class and click Add Class. 
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5 Click Save.

Transferring Homerooms from Student Schedules
You can change a student’s homeroom assignment from within the student schedule. You can 
also assign a new homeroom directly from a student search. For more information about 
assigning homerooms from a student search, see “Transferring Homerooms from Student 
Search Results” on page 88.

NOTE

Student schedules display the student’s schedule as of the end of the school year. To see changes made 
to the student’s schedule and their effective date, from the Actions menu, click View Change History. 
For more information about Change History, see “Viewing Change History” on page 108.

To change homeroom assignments:
1 Log on as a school administrator.

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 On the Student Schedule page, from the Actions menu, click Transfer Homeroom.

Remove a class from the 
student’s schedule

1 If you are working in the active calendar and change reasons 
are set up at the district, select the reason the student’s 
schedule is being changed.

2 From the student’s schedule, select the class you want to 
remove. Click Drop Class.

Transfer the student from a 
class into a different class

1 If you are working in the active calendar and change reasons 
are set up at the district, select the reason the student’s 
schedule is being changed.

2 In the Class Search section, search for the class you want to 
add. From the student’s schedule, select the class you want to 
remove. Click Transfer Class.

To Do this
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4 On the Transfer Homeroom page, select the homeroom you want to assign the selected 
student to.

5 Click OK.

6 In the Class Change Options dialog, specify when you want the change to take effect and, 
if required, select the reason the student’s homeroom is being changed. Click OK. 

7 Click OK.

The student’s homeroom is changed and all classes taught in the homeroom class are 
changed to classes taught in the new homeroom.

NOTE

Manually scheduled classes are not changed. 

Using Subject Exceptions
Subject exceptions allow you to adjust student schedules to meet individual student needs.

NOTE

Tennessee customers only: Subject exceptions are not included in EIS reporting.

If a student is working at a level ahead of or behind their peers, but still in the regular 
classroom, you can record that the student is taking a subject exception. For example, if you 
have a Grade 3 student who is working at a Grade 4 level in Math, you can assign the student 
to Math 4 without removing the student from the Math 3 classroom. 

Before you schedule subject exceptions, be sure you understand how exceptions affect 
grading. For more information, see “Understanding Scheduling Exceptions and the Impact on 
Grading” on page 106.

If you want to assign special services to students for short periods of time, you can assign 
resource services. For more information about resources services, see “Setting Up Resource 
Services (active calendar only)” on page 93 or “Scheduling Resource Assignments” on 
page 107.

Check to see if the 
homeroom has enough 
space to accommodate 
the selected students.
An exclamation mark 
indicates the homeroom 
does not have enough 
space to accommodate 
the selected students.

The numbers correspond 
to the Ethnic Categories.
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Adding and Ending Subject Exceptions
To assign a student to a different class within their regular classroom, add a subject 
exception. To return the student to their regular class, end the subject exception. When you 
end a subject exception, Chancery SMS retains a record of the subject exception unless the 
subject end date is the same as its start date. 

To assign a subject exception:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 On the Student Schedule page, select the class you want to exempt. From the Actions 
menu, click Add Subject Exception.

4 On the Add Subject Exception page, select the subject the student will take in place of the 
current subject. Click OK.

5 In the Class Change Options dialog, specify when you want the change to take effect and, 
if required, select the reason the subject exception is being applied. Click OK. 

To end a subject exception:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 From the Changes Effective dropdown, select when you want the change to take effect.

4 Select a class with a Subject Exception that you want to end.

5 From the Actions menu, click End Subject Exception.

The Student Schedule page displays the student’s revised schedule. If the subject 
exception end date is the same as its start date, the subject exception icon ( ) 
disappears.

Understanding Scheduling Exceptions and the Impact on 
Grading
In most cases, when you schedule subjects, the students are graded in the class rosters to 
which they are assigned. For example, a student in Math 4 (Homeroom 4-A) is graded in the 
Math 4 (Homeroom 4-A) roster.

There are some exceptions:

• Remedial or Advanced Instruction (Same Classroom) – When a Math 4 student has a 
subject exception for Math 5, this student receives Math 5 level instruction within the 
Math 4 classroom. That means the student is still in the Math 4 roster and will be graded 
in that roster using Math 4 skills and measures.

• Remedial or Advanced Instruction (New Classroom) – When a student is taking Advanced 
Math 5 instead of regular Math 5 and receiving that instruction in a different room, set up 
Advanced Math 5 as a subject. The advantage of scheduling this class as a separate 
subject is that you can then use unique skills and measures on the report card. However, 
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if you want to use the same skills and measures on the report card as regular Math 5, you 
do not have to create a separate subject. Instead, set the number of classes for Math 5 
so that there is an extra class which you can use for the Advanced Math 5 group. In this 
scenario, grade students using the same skills and measures as regular Math 5.

• Elective Subject Elements – When students have the option of taking more than one 
elective to fulfill the requirements for a class, the best solution is to set up the generic 
subject, such as Music, and then set up the subject elements, such as Choir and Band. 
When you set up the subject framework this way, the subject elements appear on the 
report cards for all students in the applicable grade levels. Teachers then enter grades for 
those students taking Choir as their Music 6 elective while marking Band as N/A, and vice 
versa. All students will appear in the Music 6 class roster, regardless of which elective 
they choose to complete.

Scheduling Resource Assignments
From the Student Schedule page, you can add or delete resource assignments for individual 
students. Assign resources to students who require extra attention because they may be 
struggling or advanced. For example, resource services include Remedial Reading and Math, 
Speech Therapy, Gifted and Talented Enrichment, and so on.

Before you add a resource assignment to a student schedule, you must set up resource 
services. For more information about setting up resource services, see “Setting Up Resource 
Services (active calendar only)” on page 93.

If you want to assign the same resource service to multiple students, use the Resource 
Roster. For more information about assigning resource services to multiple students, see 
“Assigning Resource Services to Students” on page 94.

To add a resource assignment to a student’s schedule:
1 Log on as a school administrator.

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 From the Actions menu, click Add Resource Assignment.

4 On the Add Resource Assignment page, enter the required resource service information. 

5 Click OK.

The Student Schedule page displays the student’s revised schedule. The Resource 

Assignment icon ( ) indicates resource assignments.

To delete a resource assignment from a student’s schedule:
NOTE

When you delete a resource assignment, you delete all record of the assignment. If you want to end a 
resource assignment without deleting the entire record, adjust the End Date for the resource 
assignment.

1 Log on as a school administrator.

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.
Working with Student Schedules 107
Scheduling Resource Assignments



Chancery SMS Scheduling Guide
3 Select a Resource Assignment.

4 From the Actions menu, click Delete Resource Assignment.

5 Click OK.

The Student Schedule page displays the student’s revised schedule. 

Viewing Change History
Use Chancery SMS to view a history of changes for each class that a student has enrolled in. 
For example, you can view when a student has transferred from one class to another or when 
they changed homerooms. For each change, you can specify the effective date, select a 
change reason, and include a comment.

The schedule change history is only available in the active calendar and only shows changes 
over time. For example, if a class is added and dropped as of the same day, the change is not 
recorded in the change history. 

To view a student’s change history:
1 Log on as a school administrator.

2 Open a student schedule. 

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 On the Student Schedule page, from the Actions menu, click View Change History.

The Schedule Change History page displays a list of the changes made to the student’s 
schedule.

4 To change the effective date, change reason, or comment for a specific schedule change, 
in the Start column, click the start date or select the schedule change and click Edit.

To see the change reason 
description, pause the cursor 
over the change reason code.
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5 On the Edit Change page, make the necessary changes and click OK.

Reversing Student Schedule Changes
From the Change History page, you can reverse some changes made to the student’s 
schedule. You can only undo the last change within each set of changes. If a change can be 
undone, a “Y” appears in the Can Undo column.

To undo a change to the students schedule:
1 Log on as a school administrator.

2 Open a student schedule.

For more information about opening student schedules, see “Working with Student 
Schedules” on page 99.

3 On the Student Schedule page, from the Actions menu, click View Change History.

4 Select the change you want to reverse.

There must be a “Y” in the Undo column.

5 Click Undo Last or Undo Selection. Click OK.
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Working with Homeroom and Class 
Rosters
Rosters provide a list of students assigned to a homeroom or class. Generally, you assign 
students to a homeroom and they are automatically assigned to classes based on their 
homeroom assignment. If a class is set up so the school assigns students, you can manually 
assign the class to specific students. For more information about setting up classes, see 
“Setting Up Classes” on page 71.

You can use rosters to view a list of students assigned to a class or homeroom and make 
adjustments, as required. 

Viewing Class Rosters
1 Log on as a school administrator. 

2 In the control bar, under Class, click Classes.

3 On the Classes page, click the class you want to view.

OR

On the Classes page, click the Roster icon ( ) for the class you want to view. 

Select a class to view.

To view the class roster, 
click the class name or 
click the roster icon.

By default, the class name 
includes room numbers. Numbers 
in round brackets indicate the 
homeroom number and numbers 
in square brackets indicate the 
class number (if the number of 
rosters is specified for the class). 

If meeting patterns are 
assigned to a class, the 
assigned meeting 
pattern appears in the 
Meeting Pattern 
column.

If supplementary class 
attendance is collected for 
the class, an Attendance 
icon appears in the 
Attendance column. 
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4 On the Class Roster page, you can change the information displayed on the screen. For 
more information about changing the roster display, see “Changing the Information 
Displayed on Roster Pages” on page 113.

Viewing Homeroom Rosters
1 Log on as a school administrator. 

2 In the control bar, under Class, click Homerooms.

To open a student record, 
click the student name.
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3 On the Homerooms page, click the homeroom you want to view.

OR

On the Homerooms page, click the Roster icon ( ) for the homeroom you want to view.

On the Homeroom Roster page, you can change the information displayed on the screen. 
For more information about changing the roster display, see “Changing the Information 
Displayed on Roster Pages” on page 113.

Changing the Information Displayed on Roster Pages
To assist you in adjusting homeroom and class rosters, you can change the student 
information displayed on class and homeroom roster pages. You can display incoming or 
withdrawn students and you can change the columns included on the page. 

To change the information displayed on the screen:
1 Log on as a school administrator.

2 Open a class or homeroom roster.

For information about opening class rosters, see “Viewing Class Rosters” on page 111. 
For information about opening homeroom rosters, see “Viewing Homeroom Rosters” on 
page 112.

3 From the Edit menu, click Choose Columns > Class Search Results.

4 In the Available Columns list, select the columns you want to display, and then click  
to move them to the Selected Columns list.

5 Use the  and  buttons to set the display order.

6 Click OK.

To view the homeroom roster, 
click the homeroom name or 
click the roster icon.
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To include withdrawn or incoming students:
1 Log on as a school administrator.

2 Open a class or homeroom roster. 

For information about opening class rosters, see “Viewing Class Rosters” on page 111. 
For information about opening homeroom rosters, see “Viewing Homeroom Rosters” on 
page 112.

3 From the Edit menu, click Include Incoming Students.

OR

From the Edit menu, click Include Withdrawn Students (current year).

Modifying Homeroom and Class Rosters
At the beginning of the school year, finish your schedule by transferring students to correct 
homeroom, class, and subject assignments. You can adjust the rosters for all classes and 
subjects to incorporate team teaching or group students by ability. For more information 
about adjusting a roster at the beginning of the school year, see “Transferring Homerooms” 
on page 118.

During the school year, transfer students to assign them to a new class or subject, as 
required. For example, a group of students might take Music for the first half of the year and 
Art for the second half of the year. For more information about transferring students during 
the school year, see “Changing Class Rosters” on page 114.

Changing Class Rosters
You can adjust class rosters in a planning calendar when you create the initial schedule. After 
school starts, you may need to adjust class rosters from time to time. For example, you may 
need to adjust a class roster to complete the following tasks:

• Assign walk-in students to a class.

• Find the best homeroom for a student and manually adjust a student’s schedule.

• Schedule a student to receive or stop receiving resource services partway into the school 
year.

• Adjust a student’s schedule based on individual student needs, such as moving a student 
to a faster or slower paced Math class. This change can be made at the start of the school 
year or partway through the school year.

To add, drop, or transfer students:
1 Log on as a school administrator.

2 Open a class roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 111.
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3 On the Class Roster page, do one of the following:

4 If you are working in the active calendar, in the Class Change Options dialog, specify the 
date you want these students to be added, enter a comment, and, if available, select a 
change reason. Click OK.

NOTE

If you set the effective date to “First Day of School” and manually drop or transfer classes from a 
student’s schedule, if you then create student schedules for all students, the dropped classes will be 
re-added to the student’s schedule. For more information about creating student schedules, see 
“Creating Student Schedules” on page 87. If you specify a specific date, even if the date is the same 
date as the first day of school, the classes are not re-added when you create student schedules. 

5 Click Save.

Adding Groups of Students to Other Classes
You can select a group of students and add them to several classes, one after another. For 
example, after you add students to the first term Music class, you can add the entire group of 
students to the second term Art class.

1 Log on as a school administrator.

2 Open a class roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 111.

3 On the Class Roster page, select the students you want to add to another class.

To Do this

Add a student to the class 1 From the Actions menu, click Add Student. 

2 In the Select Student dialog, select the students you want to 
add. Click OK.

Drop a student from the 
class

• Select the students you want to drop. From the Actions menu, 
click Drop Students.

Transfer students to a 
different class

1 Select the students you want to transfer. 

2 From the Actions menu, click Transfer Students.

3 On the Transfer to Class page, select the class you want to 
transfer them into. Click OK.

In the active calendar, the 
Change Reason dropdown 
appears if change reasons 
are setup at the district. 
Change reasons may be 
required or optional.
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4 From the Actions menu, click Add Another Class.

5 From the Class dropdown, select the class for these students. Click OK.

6 If you are working in the active calendar, in the Class Change Options dialog, specify the 
date you want these students to be added, enter a comment, and, if available, select a 
change reason. Click OK.

Assigning Groups of Students to Classes
From Class rosters and Homeroom rosters, you can select a group of students and assign 
them to specific classes. 

1 Log on as a school administrator.

2 Open a class or homeroom roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 111. For more information about opening homeroom rosters, see “Viewing 
Homeroom Rosters” on page 112.

Shows the number of 
students selected.

In the active calendar, the 
Change Reason dropdown 
appears if change reasons 
are setup at the district. 
Change reasons may be 
required or optional.
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3 On the Class or Homeroom roster, select the students you want to assign to classes. 

4 From the Actions menu, click Assign > Classes.

The Assign Classes page opens.

5 On the Assign Classes page, in the Class Search panel, search for and select the classes 
you want to add to or remove from the students’ schedules.

6 If you are working in the active calendar, in Changes Effective, select the date you want 
to change to take effect. 

NOTE

If you set the effective date to “First Day of School” and manually drop or transfer classes from a 
student’s schedule, if you then create student schedules for all students, the dropped classes will be 
re-added to the student’s schedule. If you specify a specific date (not the first day of school), the 
classes are not re-added. For more information about creating student schedules, see “Creating 
Student Schedules” on page 87.

7 If you are working in the active calendar and change reasons are set up at the district, in 
the Change Reasons dropdown, select a reason for the change.

Indicates the number of students 
whose schedules will be changed.

In the active calendar, you must 
specify the date you want changes to 
take effect. 

In the active calendar, the Change 
Reason dropdown appears if change 
reasons are defined at the district. 
Change Reasons may be required or 
optional. The selected change 
reasons applies to all changes made 
on this page.
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8 Click Add Class or Drop Class.

The added or dropped classes appear in the Add Classes or Drop Classes lists.

9 Click Apply.

Transferring Homerooms
You can transfer students between homerooms from the Roster page. This method is 
particularly useful at the beginning of the school year when you are setting up schedules. 

To transfer students to different homerooms:
1 Log on as a school administrator. 

2 Open a homeroom roster.

For more information about opening homeroom rosters, see “Viewing Homeroom 
Rosters” on page 112.

3 On the Roster page, select the students you want to assign to another homeroom. From 
the Actions menu, click Transfer Homeroom.

When you click Add 
Class, the selected 
classes are added to the 
Add Classes field.

When you click Drop 
Class, the selected 
classes are added to the 
Drop Classes field.

To transfer classes, add 
one class and drop one 
class then select 
Transfer.
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4 On the Transfer Homeroom page, select the new homeroom you want to transfer the 
selected students to.

5 Click OK.

6 If you are working in the active calendar, in the Change Options dialog, specify the date 
you want these students to be added, enter a comment, and, if available, select a change 
reason. Click OK.

Check to see if the 
homeroom has enough 
space to accommodate 
the selected students.
An exclamation mark 
indicates the homeroom 
does not have enough 
space to accommodate 
the selected students.

The numbers 
correspond to the Ethnic 
Categories.

In the active calendar, the 
Change Reason dropdown 
appears if change reasons 
are set up at the district. 
Change reasons may be 
required or optional. 
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Section 2: Secondary Scheduling
In secondary scheduling, students may be assigned to homerooms, but they usually only 
spend short periods of time in their homeroom. For each class, students go to different 
rooms with different groups of students. For secondary scheduling, you must set up the 
scheduling structure to define terms, day patterns, bell schedules, and meeting patterns. 
Based on student course requests and teacher preferences, Chancery SMS can generate 
teacher and student schedules, which can be printed and distributed to students and 
teachers. 

Permission to Work with Secondary Scheduling
To work with scheduling at a secondary school, you need the following permissions:

To You need this permission Set to

Assign classes to students, teachers and 
rooms

School Setup>Assign Classes Yes

Assign courses to students School Setup>Assign Course Requests Yes

Create resource services School Setup>Resource Services Delete

Assign resource services to students Students>Resource Assignments Delete

Set up or change the school schedule School Setup>Secondary Scheduling 
Setup 

Yes

School Setup>Subject Scheduling Edit

View your school schedule School Setup>Subject 
Framework/Course Catalog

View or Edit

School Setup>Subject Scheduling View or Edit

Add, edit, and delete buildings Facilities Management>Buildings Delete

School Setup>Secondary Scheduling 
Setup

Yes

Add, edit, and delete rooms Facilities Management>Rooms Delete

School Setup>Secondary Scheduling 
Setup

Yes

Create and schedule reservation labels School Setup>Secondary Scheduling 
Setup

Yes

Create and edit meeting patterns School Setup>Secondary Scheduling 
Structure Setup

Yes

Define class constraints. School Setup>Define Constraints - 
School

Delete

Add, delete, or switch planning 
schedules

School Setup>Change Planning Schedule Yes

Update scheduling statistics School Setup>Change Planning Schedule Yes

Create student schedules, including 
adding and removing course requests

Students>Edit Student Schedules Yes

Schedule walk-in students School Setup>Edit Student Schedules Yes
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By default, the school administrator role can perform all scheduling setup tasks. For more 
information about permissions, see the Chancery SMS Permissions Guide and “Controlling 
User Access” in the Chancery SMS District Administration Guide.

Assign default classes based on student 
homerooms

School Setup>Subject Scheduling Edit, Delete, 
or None

School Setup>Edit Student Schedules Yes

Reassign default classes based on 
student homerooms

School Setup>Subject Scheduling Edit, Delete, 
or None

School Setup>Edit Student Schedules Yes

Assign students to classes when doing so 
results in the class size exceeding the 
specified capacity

Classes - exceed capacity Yes

Transfer grades from a dropped class to 
an added class

Grading>Transfer Grades and 
Attendance

Yes

Students>Edit Student Schedules Yes

Delete grades entered for a dropped 
class

Grading>Transfer Grades and 
Attendance

Yes

Grading>Enter Grades for All Classes Yes

Grading>Edit Grades from Other 
Teachers

Yes

Grading>Modify Grades for Completed 
Periods

Yes

Students>Edit Student Schedules Yes

Reassign attendance for transferred 
classes

Grading>Transfer Grades and 
Attendance

Yes

Students>Edit Student Schedules Yes

Delete attendance for dropped classes Grading>Transfer Grades and 
Attendance

Yes

School Setup>Clear Attendance Yes

Students>Edit Student Schedules Yes

View grade transfers and attendance 
reassignments in the Audit Log

School Setup>View Audit Log Yes

To You need this permission Set to
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Typical Scheduling Scenarios of Secondary and Middle 
Schools

Typical Scheduling Timetable
For a school where the school year runs from September to June, the following is an example 
of when you might want to set up the course catalog and schedule students. If your school 
year runs on different dates, adjust the dates accordingly.

Be sure to also include the Next-Year Preparation and Year-End Processes in your scheduling 
timetable. For more information, see the Chancery SMS Next-Year Preparation and Year-End 
Processing Guide.

Some scheduling tasks must be completed at the district before you can schedule your 
school. Make sure the following tasks are completed at the district: 

• School boundaries for each school are correct for the coming school year and the 
Projected Schools Map matches these boundaries so that students’ projected schools are 
correct in Chancery SMS. 

• The start and end dates for the coming school year are defined.

Secondary School Middle School

School publishes required and elective course 
offerings.

School determines core courses that all students 
take.

School determines exploratory courses that 
students rotate through.

School might offer optional courses that students 
may request.

Students make course requests based on 
graduation plans and general interest.

School defines team loading rules for classes and 
teachers that keep groups of students together 
for some or all courses.

School determines the number of classes or sections for each course based on staffing and facilities.

School builds master schedule to schedule classes into terms, meeting patterns, rooms, and 
teachers.

Time Period Activity

January Publish the school course catalog.

February to March Enter student course requests.

Distribute course request confirmations to students.

April Build the master schedule.

Load student schedules.

May to June Distribute student schedules to students.

May to August Manually adjust the master schedule in the planning calendar.

Manually adjust student schedules in the planning calendar.

July to August Perform Year-End Processing.

August to next June Manually adjust student schedules in the active calendar.

Manually adjust the master schedule in the active calendar.
Section 2: Secondary Scheduling 123
Typical Scheduling Scenarios of Secondary and Middle Schools



Chancery SMS Scheduling Guide
• The course catalog for the coming school year is updated to include any new courses the 
district is offering. 

• When the course catalog is updated, courses are assigned to each school so each school 
has its own updated course catalog.

• Projected schools for students are assigned and the Next-Year Preparation process is 
completed. 

Scheduling in Planning and Active Calendars
Although you will likely adjust the scheduling setup throughout the school year, most 
scheduling tasks are completed in the planning calendar. When you schedule your secondary 
school in the planning calendar, you likely follow distinct steps. These steps are represented 
on the Scheduling page to help you proceed through the scheduling process. For each step, 
the Scheduling page shows statistics that help you determine the current status of the step. 

NOTE

If the statistics do not seem correct, you can update statistics to refresh the calculations. For more 
information, see “Updating Statistics” on page 125. 

In the planning calendar, the steps do not include any tasks that must be completed in the 
active calendar, such as setting up resource services.

Planning Calendar 
Scheduling page 
includes 
scheduling steps 
available in the 
planning calendar.

The right column 
displays statistics 
that show the 
status of each 
step. 
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When you work in the active calendar, the Scheduling page still displays the tasks as steps. 
However, when you work in the active calendar, the initial schedule is usually already set up 
and you do not need to follow the steps in order. You will likely revisit steps as required. In 
the active calendar, the Scheduling page does not include steps that only apply to the 
planning calendar, such as creating and selecting planning schedules.

Updating Statistics
Scheduling statistics indicate the status of the scheduling steps, such as allocating teachers 
and scheduling students. These statistics appear on the following pages: the Scheduling, 
Student Scheduling, Student Loader, and Course Request Tally pages. As you work through 
the steps for scheduling, these statistics may not refresh automatically. If the numbers do 
not seem correct, you can update the statistics.

NOTE

Updating statistics may affect performance in Chancery SMS. It should not be necessary to update 
statistics as part of your regular processing. If statistics are frequently incorrect, contact technical 
support for assistance. 

To update statistics:
1 Log on as a school administrator at a secondary school. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, from the Actions menu, click Update Statistics. 

In the Active 
Calendar, 
scheduling tasks 
are shown as steps 
although once the 
initial schedule is 
set up, you need 
not follow the 
steps in order. 

The right column 
displays statistics 
that show the 
status of each 
step. 
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4 On the Update Statistics page, select the statistics you want to update:

5 Click OK. 

Secondary Scheduling Overview
When working in the planning calendar, you generally follow a set of scheduling steps in the 
order shown on the Scheduling page. In the active calendar, you can perform most of the 
tasks available in the planning calendar in any order. In addition, you can define resource 
services and assign resource assignments, which cannot be done in a planning calendar. 
Although it is not necessary to perform tasks in a specific order in the active calendar, the 
Scheduling page still shows the available tasks as a series of steps. Setting up resource 
services is shown as Step 7. For most tasks, the description and procedures provided for the 

Select To update

Calendar Statistics On the Scheduling page:

• Room Setup (# rooms)

• Staff Setup (# teachers)

• Course Setup (# courses assigned to school)

• The total number of students used in Course Request Tally and 
Load Students statistics.

Scheduling Statistics On the Scheduling page:

• Scheduling Groups (# groups)

• Scheduling Term Sets (# term sets)

• Day Patterns (# days)

• Bell Schedules (# bell schedules)

• Meeting Patterns (# meeting patterns)

• Class Loading Rules (# class rules)

• Team Loading Rules (# teams)

• Course Offerings and Meeting Patterns (# courses with 
offerings configured)

• Class Scheduling Options (Overallocation # %)

• Course Request Tally (# students with requests)

• Teacher Allocations (# teachers allocated)

• Master Schedule (# classes scheduled)

• Load Students (# students with full schedules)

Course Statistics The Course Search options (Detail tab) on the Course Request 
Tally page 

Student Requested Loads On the Load Students page:

Requested Load

Student Scheduled Loads On the Load Students page:

Scheduled Load

Potential Conflicts (between 
student requests)

Conflict Matrix page
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planning calendar steps also apply to the tasks in the active calendar, except where 
differences are indicated. For more information about setting up resource services, see 
“Setting Up Resource Services (active calendar only)” on page 313.

The following steps describe the overall process of scheduling for secondary schools in the 
planning calendar:

Step 1 - Configure Scheduling Aspects of Rooms, Staff and Courses
Although rooms, staff, and courses are generally set up when you set up your school, verify 
that they are set correctly and apply any scheduling requirements. See “Configuring Rooms, 
Staff, & Courses” on page 131.

Step 2 - Create Planning Schedules
Planning calendar only.

If you are working in a planning calendar, you can create multiple planning schedules to try 
out different scheduling options. You can copy scheduling properties from the active calendar 
or from other planning calendars. For more information about creating grading tables, see 
“Using Planning Schedules” on page 165.

Step 3 - Set up Schedule Structure
Set up the basic structure of your school schedule, including defining scheduling groups, 
scheduling term sets and scheduling terms, the day pattern, bell schedules, and meeting 
patterns. In the active calendar, this is step 2. For more information about schedule 
structures, see “Setting Up the Scheduling Structure” on page 171.

Step 4 - Configure Student Loading Rules
Student loading rules allow you to ensure that specific courses are scheduled in a certain 
way, such as always being scheduled in sequence or to balance the schedule so that electives 
are not all scheduled in the same term. Chancery SMS uses two types of student loading 
rules: class loading rules and team loading rules. For more information about student loading 
rules, see “Configuring Student Loading Rules” on page 197.

Step 5 - Configure Terms and Meeting Patterns for Courses
Assign default terms and meeting patterns to courses. Later, when you schedule teachers 
and students into courses, only those courses that have been assigned terms and meeting 
patterns are available for scheduling. For more information about assigning terms and 
meeting patterns to classes, see “Configuring Terms and Meeting Patterns for Courses” on 
page 223.

Step 6 - Create the School’s Master Schedule
In the planning calendar, you can build a master schedule for the school. The master 
schedule specifies how teachers are scheduled, analyses student course requests, and finally 
assigns teachers and rooms to classes. For more information about creating the school’s 
master schedule, see “Creating the School Master Schedule” on page 265.

Step 7 - Load Student Schedules
Run the student loader to automatically assign students to classes based on student course 
requests and the defined student loader rules. For more information about loading student 
schedules, see “Loading Student Schedules” on page 307.
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Step 8 - Select the planning schedule that will become active when YEP is run 
(planning calendar only)
In the planning calendar, you can create multiple planning schedules to try out different 
scheduling options. When you run Year End Processing (YEP), only one planning schedule can 
be active. You must select the planning schedule you want to use before you run YEP. For 
more information, see “Selecting a Planning Schedule (planning calendar only)” on page 319.

Understanding Chancery SMS Secondary School 
Scheduling Terminology
Before you begin the scheduling process at your school, it is important to understand the 
terminology Chancery SMS uses relating to courses and the course catalog, such as the 
difference between a period and a class, and how courses relate to both. The following 
definitions help you understand this terminology as it relates to Chancery SMS.

Term Definition

Period A time slot on a particular day in which a class may be held.

Class A group of students that meets regularly to receive instruction in 
a course from a specific teacher. For example, Band 4 meets 
Tuesdays and Thursdays at 2 pm, with Mr. Bell providing 
instruction for 30 Grade 9 students. A class includes the 
following:

• course name and number

• class name and number

• at least one meeting pattern

• at least one teacher

• at least one room

• students

Course A set of instructional topics and objectives taught to students for 
some duration of time (a full year, a semester, a six-week 
rotation, etc.).

Term set A way to segment the school year. Within each term set is a 
number of terms. For example, you can have one term for the 
whole year or you can break up a year into two, three, or any 
number of terms. You can call the term sets semesters, 
trimesters, or any other name. You can define any number of 
term sets and any number of terms.

Day pattern The cycle of days that your school uses. For example, your 
school can use a days-of-the-week pattern from Monday to 
Friday or it can use a relative-day pattern using a set number of 
days in a cycle, such as Day 1 to Day 4 in a four-day relative 
cycle.

You can add special days to your day pattern, such as 
parent-teacher interview days, professional development days, 
or early dismissal days.

Meeting pattern A single period or series of periods when a class can meet. When 
you create the master schedule, classes are given one or more 
meeting patterns.
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Once you understand the terminology, the next step is to understand the interrelationship 
between periods, meeting patterns, courses, and classes.

A school determines how many classes of each course need to be offered in a given school 
year based on student course requests. These classes are scheduled into terms with meeting 
patterns, teachers, and rooms. All these elements form the school’s master schedule.

For example, if you define a meeting pattern called MWF-A to meet in period 1 every Monday, 
Wednesday, and Friday, and assign MWF-A to the class Biology 12-1 then students who are 
assigned this class will have Biology 12-1 in those time slots on their schedules.

You can create classes to accommodate the number of students requesting, or assigned to, a 
course. For example, if there are 90 students with course requests for Computer Applications 
and you want to limit the class size to 15 students, you would create 6 classes.

Bell schedule Consists of the start and end times of periods throughout the 
day. You can have a different bell schedule for each scheduling 
group and for different days.

Special scheduling day or 
exception day

A day that has a different bell schedule. For example, on parent-
teacher interview days, afternoon periods may be excluded and 
students have a shorter instruction day.

Student schedule The set of classes that a student is scheduled to attend.

Class schedule The set of one or more terms, meeting patterns, teachers, and 
rooms in which a class is scheduled to meet.

Class roster A list of all the students scheduled to attend a particular class.

Teacher schedule The set of classes that a teacher is scheduled to teach.

Master schedule The set of all classes that have been created for a school, with 
their associated terms, meeting patterns, teachers, and rooms.

Term Definition
Section 2: Secondary Scheduling 129
Understanding Chancery SMS Secondary School Scheduling Terminology



Chancery SMS Scheduling Guide
130 Section 2: Secondary Scheduling
Understanding Chancery SMS Secondary School Scheduling Terminology



Configuring Rooms, Staff, & Courses
Rooms, staff, and courses are typically set up when you set up your school; however, it is a 
good idea to check the settings and make any necessary changes before scheduling your 
school. 

Although you can update staff and rooms in both the active and planning calendars, there is 
only one set of staff and one set of rooms that are used by both the active and planning 
calendars. Therefore, any changes you make to staff or rooms, whether in the active 
calendar or the planning calendar, affect the data in both calendars. Courses are assigned by 
the district and must be published for each calendar year. For further information, see the 
Chancery SMS District Administration Guide.

Setting Up Rooms for Scheduling
Buildings and Rooms are generally set up when you set up your school. You can check the 
room set up from the Scheduling page so you can make any corrections before you schedule 
classes. 

To open the buildings page from the scheduling page:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Room Setup.

4 On the Buildings page, click the number in the # Rooms column.

5 On the Rooms page, do one of the following:

6 On the Add Room or Edit Room page, enter or edit the information about the room. 

For more information, see “Setting Up Buildings and Rooms” in the Chancery SMS School 
Setup Guide.

To Do this

Add a room • From the Actions menu, click Add Room.

Edit a room • Select a room. From the Actions menu, click Edit Room.

OR

In the Room No. column, click the room number.

Delete a room 1 Select the room. 

2 From the Actions menu, click Delete Room. 

Skip the remaining steps.

To open the Rooms page, click the 
number in the # Rooms column.
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Setting Up Staff for Scheduling
Staff records are generally created when you set up your school properties. When you begin 
scheduling classes, you may want to review and modify staff records and specify properties 
used for scheduling, such as teacher scheduling load and time restrictions. You can also 
create “placeholder” teachers to account for staff expected to be added for the next school 
year. In the planning calendar, when you allocate teachers, the Master Schedule Builder uses 
these properties to schedule teachers. 

For more information about creating and maintaining staff records, see “Setting Up Staff 
Records” in the Chancery SMS School Setup Guide. 

Staff scheduling defaults that define a full-time teaching load must be set at the district to 
enable school users to set the staff scheduling properties for individual teachers. Once the 
defaults have been set, the values are reflected in the records of individual staff members. 
The values can then be adjusted at the school level as required, and the following staff 
scheduling properties can be set to facilitate automated scheduling:

• Scheduling load 

• Course and room preferences

• Time restrictions

NOTE

The scheduling load for a teacher is a numeric value that determines how many courses a teacher should 
be scheduled to teach based on course scheduling loads. The course scheduling loads are values assigned 
to individual courses, usually based on the number of hours of instruction. For example, the district 
could set course scheduling loads at 1.0 for courses that meet six hours a week over one term, and 0.5 
for courses that meet three hours a week for one term. A teacher with a scheduling load of 4.0 would 
have to teach four courses worth 1.0 or eight courses worth 0.5 (or any combination that adds up to the 
same value) to be considered full-time.

Setting Staff Scheduling Properties
Use Chancery SMS to define scheduling properties for individual teachers at the school level. 
These properties define the teacher’s scheduling load for each term, and include course 
preferences, room preferences, and time restrictions to be taken into consideration during 
scheduling.

Enter course preferences for teachers who only teach specific courses. Enter room 
preferences so Master Schedule Builder will attempt to assign teachers to specific rooms. 
Enter time restrictions for part time teachers who are not available for specific days or times. 

NOTE

Course preferences, room preference, and time restrictions are set only for staff members who can be 
scheduled to teach courses. For school administrators, secretaries, and teachers on leave-of-absence, 
do not enter this information.

To set staff scheduling properties:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff Setup.
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4 On the Scheduling Staff List page, search for a specific staff record or click All Staff or All 
Placeholders.

5 Under Staff Search Results, click the staff member name.

6 On the Staff Scheduling Properties page, expand the Teaching Load panel.

7 For Scheduling Load, select District Default to use the default set by the district (shown in 
parentheses) or select Override to specify a value different from the district default. 

NOTE

You cannot set the scheduling load to zero.

8 Expand the Course Preferences panel.
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9 Do one of the following:

10 Under Preferred Courses, select a course and, in the Preference dropdown, select the 
preference level. Repeat for each preferred course. 

To Do this

Add a preferred course by 
searching for courses

1 Perform a Basic or Detail search. 

2 From the Search Results, select the courses. 

3 Click Add.

Add specific courses by 
entering course numbers 

1 In the Course Number field, enter the course numbers. 

2 Enter multiple course numbers separated by commas.

3 Click Add.

Use the course search 
options to search for 
specific courses. 
Select courses in the 
search results and 
click Add.

To add specific 
courses by course 
number, enter course 
numbers separated 
by commas. Click 
Add.
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NOTE

Preference levels range from 1 to 9, with 1 being the highest. Master Schedule Builder does not 
automatically schedule any course with a preference of 9, so this preference level can be used to 
denote courses that are to be scheduled manually. The default preference is 5.

11 Expand the Room Preferences panel.

12 In the Available Rooms list, double-click or use the arrows to move selected rooms to the 
Selected Rooms list. 

In the Selected Rooms list, the order of the rooms indicates the preference priority. If 
required, use the up and down arrows to organize selected rooms in order of preference.

13 Expand the Time Restrictions panel.

To add a room to the preferred room list, 
select a room in the Available rooms list and 
then click the -> button. 

To set the order of preference 
for selected rooms, select a 
room and use the up and down 
arrows to set the order.
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14 Do one of the following:

15 Click OK.

Creating Placeholders for Scheduling
Use Chancery SMS to create a placeholder for scheduling purposes. This feature is used 
when courses need to be scheduled, but a specific teacher is not yet available to assign 
because hiring is not complete. In this situation, a placeholder is created with the appropriate 
preferences and restrictions, and this placeholder record is used in lieu of an actual staff 
member to complete the schedule.

To create placeholder teachers:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff Setup.

4 On the Scheduling Staff List page, from the Actions menu, click Create Placeholder.

5 On the Staff Scheduling Properties page, in the Name field, enter a name for the 
placeholder. 

NOTE

Placeholders are given a one-word name that functions as a last name for search purposes.

To Do this

Indicate that the teacher is 
available for scheduling 
during all regular school 
hours

• Select “Teacher is available at all times”.

Indicate that the teacher is 
not available for scheduling 
on specific days

1 Select “Teacher is not available at the following times”.

2 Under Full-day Restrictions, select the days the teacher is 
unavailable.

NOTE
If your school uses relative days, do not enter teacher time restrictions.

Indicate that the teacher is 
not available for scheduling 
at specific times

1 Select “Teacher is not available at the following times.”

2 From the Actions menu, click Add Time Restriction. Select the 
Day, Start Time, and End Time for the restriction.

3 Select the checkbox for the new time-of-day restrictions.

NOTE
If your school uses relative days, do not enter teacher time restrictions.

Remove a time restriction 1 Under Time-of-Day Restrictions, select the restriction you 
want to remove. 

2 From the Actions menu, click Delete Time Restriction. 

3 Click OK.
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6 In Departments, from the Available Departments list, select the departments the 
placeholder is available for and move them to the Selected Departments list.

7 Expand the Teaching Load panel.

8 For Scheduling Load, select District Default to use the default set by the district (shown in 
parentheses) or select Override to specify a value different from the district default. 

NOTE

You cannot set the scheduling load to zero.

9 Expand the Course Preferences panel and do one of the following:

10 Under Preferred Courses, select a course and, in the Preference dropdown, select the 
preference level. Repeat for each preferred course. 

NOTE

Preference levels range from 1 to 9, with 1 being the highest. Master Schedule Builder does not 
automatically schedule any course with a preference of 9, so this preference level can be used to 
denote courses that are to be scheduled manually. The default preference is 5.

11 Expand the Room Preferences panel.

To Do this

Add a preferred course by 
search for courses

1 Perform a Basic or Detail search. 

2 From the Search Results, select the courses. 

3 Click Add.

Add specific courses by 
entering course numbers 

1 In the Course Number field, enter the course numbers. Enter 
multiple course numbers separated by commas. 

2 Click Add.

Select departments and 
use the arrows to move 
them between the 
Available Departments 
and Selected 
Departments lists.
Configuring Rooms, Staff, & Courses 137
Setting Up Staff for Scheduling



Chancery SMS Scheduling Guide
12 In the Available Rooms list, double-click or use the arrows to move selected rooms to the 
Selected Rooms list. 

In the Selected Rooms list, the order of the rooms indicates the preference priority. If 
required, use the up and down arrows to organize selected rooms in order of preference.

13 Expand the Time Restrictions panel and do one of the following:

14 Click OK.

Converting Placeholders to Staff Members
Use Chancery SMS to convert an existing placeholder to a staff member and transfer all the 
placeholder’s scheduling properties to the staff record. This is used when a staff member is 
hired to teach the courses previously scheduled using the placeholder record. When the 
record is converted, the new staff member record adopts the preferences and restrictions 
from the placeholder and takes its place in the schedule. The placeholder record is then 
deleted.

To convert a placeholder record to a staff member record:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff Setup.

4 On the Scheduling Staff List page, search for a specific staff record or click All 
Placeholders.

5 Under Staff Search Results, select the placeholder record.

To Do this

Indicate that the placeholder 
is available for scheduling 
during all regular school 
hours

• Select “Teacher is available at all times”.

Indicate that the placeholder 
is not available for 
scheduling on specific days

1 Select “Teacher is not available at the following times”.

2 Under Full-day Restrictions, select the days the placeholder is 
unavailable.

NOTE
If your school uses relative days, do not enter teacher time restrictions.

Indicate that the placeholder 
is not available for 
scheduling at specific times

1 Select “Teacher is not available at the following times.”

2 From the Actions menu, click Add Time Restriction. Select the 
Day, Start Time, and End Time for the restriction.

3 Select the checkbox for the new time-of-day restrictions.

NOTE
If your school uses relative days, do not enter teacher time restrictions.

Remove a time restriction 1 Under Time-of-Day Restrictions, select the restriction you want 
to remove. 

2 From the Actions menu, click Delete Time Restriction. 

3 Click OK.
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6 From the Actions menu, click Convert Placeholder.

7 On the Convert Placeholder Teacher to Staff Member page, search for a specific staff 
record or click All Staff.

8 Under Staff Search Results, select the staff member record to substitute for the 
placeholder record.

9 Click OK.

Deleting Teacher Course Preferences
Master Schedule Builder schedules teachers based on their course preferences. To indicate 
that a teacher cannot be scheduled by automated scheduling processes, remove all their 
course preferences.

NOTE

Teachers without course preferences can still be manually scheduled. 

To make teachers ineligible for scheduling:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff Setup.

4 On the Scheduling Staff List page, search for a specific staff record or click All Staff or All 
Placeholders.

5 Under Staff Search Results, click the staff member name.

6 On the Staff Scheduling Properties page, expand the Course Preference panel.

7 Under Course Preferences, do one of the following:

8 From the Actions menu, click Delete Preferred Course. Click OK to confirm.

9 Click OK.

To Do this

Select all course preferences • Select the checkbox in the Preferred Courses heading.

Select specific course 
preferences

• Select the checkbox for the specific course preferences.
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Setting Up Courses
Schools that use the secondary school scheduling method use courses for scheduling.

The course catalog and its courses are set up at the district. The courses are then assigned to 
schools. Even though the district can assign the same course to multiple schools, each school 
has its own list of courses.

NOTE

Courses must be assigned and published for schools for each calendar year. Courses in the school active 
calendar are not automatically available in the school planning calendar. If courses are not available in 
the planning calendar, contact your district administrator. 

At the school, you can assign room types or room preferences to courses. If you want to 
change other settings for courses, contact your district administrator.

Searching for Courses
A Course Search panel is available on several pages and enables you to find specific courses. 
The following table shows the pages that include a Course Search panel and how to navigate 
to the page:

The Course Search panel provides two ways to search for courses: Basic and Detail.

A Basic search allows you to enter up to three search criteria and the search results return 
records that match all specified criteria. A Detail search provides more flexibility. You can 
define multiple criteria and then specify whether records must match all the specified criteria 
or any of the criteria.

Page Navigation

Course List School Setup > Courses

Scheduling > Course Setup

Scheduling > Course Offerings and Meeting Patterns

Grading > Courses

District Setup > Course Catalog > Courses

Course Request Tally Scheduling > Course Request Tally

Teacher Allocations Scheduling > Teacher Allocations

Master Schedule Scheduling > Master Schedule

Student Schedule Student Demographics > Schedule
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To open the Course Search panel:

• Navigate to a page that has a Course Search panel, such as the Course List page, and 
expand the Course Search panel.

To use previously defined search criteria:
1 Navigate to a page that has a Course Search panel.

2 From the List dropdown, select the search criteria you want to use.

Performing a Basic Course Search
In a Basic course search, you can enter up to three search criteria and returned records 
match all defined criteria. 

Each criteria has three parts:

• a field name

• an operator

• a value

The following criteria finds courses whose name contains the word “art” and would find  
AP Art, AP Language Arts, Honors Language Arts 10, and so on.

• Field Name = Course Name

• Operator = Contains

To expand the 
Course Search 
panel, click .
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• Value = art

Add the following criteria to find courses whose name contains the word “art” AND whose 
course number ends with “50”.

• Field Name = Course Number

• Operator = Ends with

• Value = 50

To perform a Basic search:
1 Navigate to a page with a Course Search panel and expand the Course Search panel.

2 From the left dropdown in the first row, select a field name.

3 From the middle dropdown in the first row, select an operator.

4 In the right field in the first row, enter a value, if applicable.

Operator Finds records where the field...

Contains Includes the value anywhere in the field

Does not equal Is anything but the value

Ends with Ends with the value

Equals Exactly matches the value

Is empty Does not contain a value

Is not empty Contains any value

Starts with Starts with the value

Field Operator Value

Criteria 1

Criteria 2

Criteria 3
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5 Repeat Steps 2 to 4 for the second and third rows (optional).

6 Click Search.

Performing a Detail Course Search
In a Detail course search, you can enter multiple search criteria and specify whether returned 
records match all defined criteria or any defined criteria. 

Each criteria has three parts:

• a field name

• an operator

• a value

The following criteria finds courses whose name contains the word “art” and would find  
AP Art, AP Language Arts, Honors Language Arts 10, and so on.

• Field Name = Course Type

• Operator = Equals

• Value = Academic

Field Name Operator Value

Criteria 
definition

Selected Criteria
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Add the following criteria to find courses whose course type equals “academic” AND whose 
course subject area does not equal “art”.

• Field Name = Course subject area

• Operator = Does not equal

• Value = art

To perform a Detail search:
1 Navigate to a page with a Course Search panel and expand the Course Search panel.

2 Click the Detail tab.

3 From the left dropdown in the first row, select a field name.

4 From the middle dropdown in the first row, select an operator.

5 In the right field in the first row, enter or select a value from the dropdown, if applicable.

6 Click Add Criteria.

7 To add more criteria to your search, repeat Steps 2 to 5 (optional).

8 Select whether you want your search to match All Criteria or whether you want to match 
Any Criteria.

To remove a criteria from the search, highlight the criteria and click Remove.

Operator Finds records where the field...

Contains Includes the value anywhere in the field

Does not equal Is anything but the value

Ends with Ends with the value

Equals Exactly matches the value

Is empty Does not contain a value

Is not empty Contains any value

Starts with Starts with the value

To search for 
courses whose 
type is 
“academic” OR 
whose subject 
area is not “art”, 
select Any 
Criteria.

To search for 
courses whose 
type is 
“academic” AND 
whose subject 
area is not “art”, 
select All 
Criteria.
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9 Click Search.

The Search Results page displays a list of possible matches. If there are many courses, 
you may need to scroll or click Prev/Next to find the course you’re looking for.

If you’re not satisfied with your search results, click  to open the Search Criteria panel, 
modify your search criteria then click Search.

Displaying Inactive Courses
Courses are set as active or inactive at the district. You can include inactive courses in the 
course list. If you need to change the inactive status of a course, contact your district 
administrator. 

NOTE

When a course is made active, it is active for all schools in the district that are assigned that course.

To display inactive courses:
1 Log on as a school administrator. 

2 In the control bar, click District Setup.

3 On the District Setup page, under District, click Course Catalog. 

4 On the Course Catalog page, under Step 3, click Courses.

5 From the Edit menu, select Show Inactive Courses.

Reviewing Course Scheduling Properties
Most course scheduling properties are set at the district. You can review the properties 
associated with courses on the Course Scheduling page. At the school, you can also specify 
room preferences for courses. Master Schedule Builder uses the settings on this page to build 
the schedule for your school. 

To display course scheduling information:
1 Log on as a school administrator.

2 In the control bar, click Scheduling. 

3 On the Scheduling page, under Step 1, click Course Setup.
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4 On the Course List page, select the courses you want to review. From the Actions menu, 
click Edit Course Scheduling.

The following table describes the information displayed on the Course Scheduling page:

Field or Section Description

General Scheduling section

Scheduling load This value is summed with the scheduling load values for 
other courses that a student requests to determine whether 
the student has a full course load for the year.

This field is also used to determine a teacher’s scheduling 
load.

The total scheduling load for a student or teacher cannot 
exceed 99.99. If you set the scheduling load for course to 
1.0, students could take 99 courses before they reach the 
maximum allowed. If you set the scheduling load for courses 
to 20, students could only take four courses before they 
reach the maximum allowed.
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5 Click Save.

To display course details:

• On the Course Scheduling page, in the control bar, click Course Details.

The Course Detail page shows the following fields:

Maximum Students

Minimum Students

Optimal Students

The maximum, minimum, and optimal number of students 
that the class for this course should have.

The values set at the district for this course become the 
initial values for these fields at the school.

Schools can change these values on the Scheduling > Course 
Request Tally page by selecting these columns from Edit > 
Choose columns. Using the Course Request Tally page to 
change these fields only affects the planning schedule in 
which the change is made. It does not affect other planning 
schedules, other schools, or the district.

Prerequisites & Corequisites section

Prerequisites and corequisites Specifies the course prerequisites and corequisites set by the 
district.

Rooms section

Room Required If a room is required, select either Preferred room types or 
Preferred rooms.

If you select Preferred rooms, you can select one or more 
preferred rooms. 

Select the rooms in the Available list and move them to the 
Selected list. Then use the up and down arrow buttons to set 
the order of preference. The first room in the Selected list is 
the highest preference, and so on.

If you select Preferred rooms, you must also choose one or 
more alternate room types that can be used if the preferred 
rooms are not available. 

Copy When you are setting up courses, you can use the Copy link 
to the right of the section heading to copy course information 
and just change the fields that are different.

You can copy course information that is available in the 
planning calendar. In the active calendar, you can only copy 
course grading and course offerings information.

Field or Section Description

Course Number The course number must be unique; no two courses in the entire 
district can have the same course number.

You can include alphabetic characters in the course number, such 
as 101A.

Course State Number If required, enter the state-assigned course number.

Course Name Enter the course name.

Course Short Name Enter a short name of up to 10 characters.

Field or Section Description
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Assigning Rooms to Courses
You can indicate that a course requires a room and specify preferred room types or specific 
rooms. When classes are created for the course, the classes are assigned to the rooms based 
on the preferred room or room type. 

To assign rooms to courses:
1 Log on as a school administrator. 

2 In the control bar, click Scheduling. 

3 On the Scheduling page, under Step 1, click Course Setup.

4 On the Course Setup page, select the courses you want to assign to rooms. From the 
Actions menu, click Edit Course Scheduling. 

Course Alternate Name If you wish, enter an alternate name.

Course Description Enter the course description.

Course Subject Area Select the subject area that has been set up in Chancery SMS 
Subject Area.

Course Type Select the course type that has been set up in Chancery SMS 
Course Type.

Department Select the department that has been set up in Chancery SMS 
Department.

Course Is Specify whether the course is required, an elective, or a study 
hall course.

Study hall courses cannot collect grades.

Collect Attendance If attendance is not collected for this course, such as some study 
halls, deselect this checkbox.

Field or Section Description
148 Configuring Rooms, Staff, & Courses
Setting Up Courses



Chancery SMS Scheduling Guide
5 On the Course Scheduling page, under Rooms, select Room Required.

6 Select Preferred Room Type and, from the list of available room types, select the 
preferred room types and move them to the Preferred Room Types list. Use the up and 
down arrows to set the order of preference.

OR

Select Preferred Rooms and, from the list of available rooms, select the preferred rooms 
and move them to the Preferred Rooms list. Use the up and down arrows to set the order 
of preference. Then, choose one or more alternate room types that can be used if the 
preferred rooms are not available.

7 Click Save. 

Reserving Periods in Student, Teacher, or Room 
Schedules
Reservation labels are used at secondary schools to reserve periods for teachers, students, 
and rooms. Reservation labels are similar to courses and use the course scheduling 
framework. You can assign reservation labels manually using the walk-in scheduler and 
Master Schedule Builder or allow the Master Schedule Builder or Student Loader to assign 
them automatically based on teacher preferences and student course requests. 

NOTES

Reservation labels do not have course numbers and do not collect grades or attendance. 

Data mapping does not copy reservation labels and Reservation labels are not copied to the planning 
calendar during Next-Year Preparation. 
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You can use any of the following three types of reservation labels:

Creating Reservation Labels
Reservation labels are created at the school level to give schools the flexibility to create 
reservation labels, as required. Once created, reservation labels can be scheduled in the 
same way as other courses. 

NOTE

You cannot collect attendance or grades for reservation labels.

To create a reservation label:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Course Setup.

Type Description

Teacher Use teacher reservation labels to reserve times in teacher 
schedules for activities such as preparation periods or lunch 
monitoring. Teacher reservation labels are not available for 
students to request and cannot be assigned to students. For 
more information about how to use teacher reservation labels, 
see the following examples:

• “Manually Assigning Teacher Preparation Periods - Example” 
on page 152.

• “Automatically Assigning Teacher Preparation Periods - 
Example” on page 154.

NOTE
Although similar to teacher time restrictions, teacher reservation labels are 
tied to the scheduling structure and are used for reserving specific periods 
for class preparation, lunch monitoring, and so on. Teacher time restrictions 
are not tied to a specific schedule and are used for indicating when part time 
teachers are available. Time restrictions do not print on teacher schedules, 
while reservation labels can be printed on schedules. 

Student Use student reservation labels to assign early or late starting 
times for schools that use extended days or to reserve specific 
periods to accommodate student extracurricular activities. You 
can also use student reservation labels to reserve times for both 
teachers and students for activities such as tutoring or 
counseling sessions. For more information about how to use 
student reservation labels, see the following examples:

• “Automatically Assigning Students to Early or Late Starting 
Times - Example” on page 156.

• “Manually Assigning Students to Early or Late Start Times - 
Example” on page 159.

• “Setting Up Reservation Labels for Student/Teacher Meetings - 
Example” on page 161.

Room Use Room reservation labels to reserve rooms without assigning 
teachers or students to the room, for example, to be used by an 
outside group.
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4 On the Course List page, from the Actions menu, click Add Reservation Label.

The Add/Edit Reservation Label page opens.

5 On the Add Reservation Label page, enter the necessary information:

Field Description

Name Enter a name for the reservation label of up to 99 characters.

Short Name Enter an abbreviated name of up to 11 characters. The short 
name is displayed on screen and in reports.

NOTE
The reservation label short name is also used as the reservation label course 
number.

Type Select the type of reservation label. 

• Teacher - the reservation label can be assigned to teachers 
only.

• Student - the reservation label can be assigned to students, 
teachers, and rooms.

• Room - the reservation label can be assigned to rooms only.

NOTE
Once the reservation label type is set, it cannot be changed.

Scheduling Load Specify the scheduling load associated with the reservation label. 
If the reservation label does not affect the teaching load for 
teachers or class load for students, you can leave this value as 
zero.

Max. Students For Student reservation label types only.

Enter the maximum number of students that can be assigned to 
an instance (like a class) of this reservation label. 1-999.

Min. Students For Student reservation label types only.

Enter the minimum number of students that can be assigned to 
an instance of this reservation label. 1-999.
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6 Click Save.

7 On the Course List page, search for Course Subject Area equals Reservation Labels.

8 In the Number Column, click the name of the reservation label. 

9 On the Add/Edit Reservation Label page, in the control bar, click Reservation Offerings.

10 On the Course Offerings page, select the default Scheduling Group and Allowed Offerings 
and, in the Meeting Patterns pane, specify the meeting patterns available to the 
reservation label. 

11 Click Save.

Manually Assigning Teacher Preparation Periods - Example
This example illustrates a method for assigning a specific preparation period to a teacher. The 
preparation period uses the same meeting patterns that have been created for other courses 
and is assigned directly to the teacher’s schedule. 

To create a reservation label:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Course Setup.

4 On the Course List page, from the Actions menu, click Create Reservation Label. 

The Add/Edit Reservation Label page opens.

Opt. Students For Student reservation label types only.

Enter the optimal number of students that can be assigned to an 
instance of this reservation label. 1-999.

Print on Reports If selected, the reservation label is printed on reports, such as 
teacher or student schedules.

NOTE
Reports must be designed to check this option. 

Field Description
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5 On the Add Reservation Label page, enter the following information:

6 Click Save.

7 On the Course List page, expand the Course Search panel and search for Course Subject 
Area equals Reservation Labels.

8 In the Number column, click PP.

9 In the control bar, click Course Offerings.

10 On the Course Offerings page, select the Scheduling Group and assign all the meeting 
patterns. Click Save.

To assign the preparation period:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Master Schedule.

4 On the By Course tab, search for Course Subject Area equals Reservation Labels. 

5 In the Preparation Period heading bar, click Add Class. 

6 Select the class.

Field Setting

Name Prep Period

Short Name PP

Type Teacher

Scheduling Load 0

Print on Reports Y

NOTE
Reports must be designed to check this flag. By default, reservation labels 
are included on reports.
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7 In the Class Schedule panel, in Meeting Pattern, select the meeting pattern you want to 
assign and, in Teacher, select the teacher.

8 Repeat Steps 4 to 6 to add a preparation period to each teacher you want to assign a 
preparation period. Click Save.

Automatically Assigning Teacher Preparation Periods - 
Example 
This example illustrates a method for automatically assigning preparation periods to teachers 
based on teacher preferences. The preparation period uses the same meeting patterns that 
have been created for other courses and classes are assigned when classes are scheduled in 
the Master Schedule.

To create a reservation label:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Course Setup.

4 On the Course List page, from the Actions menu, click Create Reservation Label. 

5 On the Add Reservation Label page, enter the following information:

6 Click Save.

7 On the Course List page, expand the Course Search panel and search for Course Subject 
Area equals Reservation Labels.

8 In the Number column, click PP.

9 In the control bar, click Course Offerings.

10 On the Course Offerings page, select the Scheduling Group and assign all the meeting 
patterns. Click Save.

To assign teacher preferences:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Staff Setup.

4 Search for the teachers you want to assign a preparation period.

5 In the Search Results, in the Name column, click the teacher you want to assign a 
preparation period.

Field Setting

Name Prep Period

Short Name PP

Type Teacher

Scheduling Load 0

Print on Reports Y

NOTE
Reports must be designed to check this flag. By default, reservation labels 
are included on reports.
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6 On the Staff Scheduling Properties page, expand the Course Search panel and search for 
Course Subject Area equals Reservation Labels.

7 In the Search Results, select the preparation period. Click Add. 

8 Click OK.

9 In the list of preferred courses, select Prep Period and set the preference to 1. Click OK.

10 Repeat Steps 4 to 9 for all teachers you want to assign the preparation period.

To create preparation period classes:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 5, click Course Request Tally.

4 On the Course Request Tally page, search for Course Subject Area equals Reservation 
Labels.

The Course Requests column shows the number of teachers who have the reservation 
label as a preference.

5 Select Prep Period. From the Actions menu, click Calculate Classes Needed. 

By default, the scheduler creates one reservation label class for each teacher who has the 
reservation label as a preference.

6 From the Actions menu, click Create Classes. Click Save.

To allocate teachers:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Teacher Allocations.

4 On the Teacher Allocations page, on the By Courses tab, search for Course Subject Area 
equals Reservation Labels. 

The teachers who have the reservation label as a preference are listed under the 
reservation label.

5 Select the teachers you want to allocate classes to and, from the Actions menu, click 
Allocate Teachers. Click Save.

To assign the preparation period:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Master Schedule.

4 On the By Course tab, search for Course Subject Area equals Reservation Labels. 

5 Select the classes you want to schedule. From the Actions menu, click Schedule Classes. 
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Automatically Assigning Students to Early or Late Starting 
Times - Example
This example illustrates a method for reserving the early or late periods for schools that use 
extended day patterns. This method allows the student loader to automatically assign either 
an early start or a late start to students, and prevents the automatic scheduler from 
scheduling classes during the reserved times. 

For this example, assume that the school has an eight-period bell schedule and students are 
required to attend five periods. The school has approximately 1000 students and wants half 
scheduled for early classes and half scheduled for late classes.

To create early start and late start meeting patterns:
You need to create a meeting pattern to reserve the first three periods of each day and 
another meeting pattern to reserve the last three periods of each day.

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 2, click Meeting Patterns.

4 On the Meeting Patterns page, from the Actions menu, click Create Meeting Pattern.

5 On the Add Meeting Pattern page, create two meeting patterns using the following 
settings:

To create reservation labels:
You need to create a student reservation label that will be used to reserve either the first 
three or last three periods of the day for each student.

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Course Setup.

Field Setting 1 Setting 2

Meeting Pattern Name Reserve - am Reserved - pm

Short Name RAM RPM

Periods 1, 2, and 3 for each day in the 
day pattern

6, 7, and 8 for each day in the 
day pattern.
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4 On the Course List page, from the Actions menu, click Create Reservation Label. 

The Add/Edit Reservation Label page opens.

5 On the Add Reservation Label page, enter the following information:

6 Click Save.

7 On the Course List page, expand the Course Search panel and search for Course Subject 
Area equals Reservation Labels.

Field Setting

Name Do Not Schedule

Short Name DNS

Type Student

Scheduling Load 0

Maximum Students 525

Minimum Students 475

Optimal Students 500

Print on Reports N

NOTE
Reports must be designed to check this flag. By default, reservation labels 
are included on reports.
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8 In the Number column, click DNS.

9 In the control bar, click Course Offerings.

10 On the Course Offerings page, select the Scheduling Group and assign the Reserve - am 
and Reserve - pm meeting patterns. Click Save.

To assign the reservation label to students:
Since all students must have either an early or late start, assign the Do Not Schedule 
reservation label to all students and give it a priority of 1.

1 Log on as a school administrator. 

2 Open a Student Search page and select all students.

3 On the Student Search page, from the Actions menu, click Assign > Course Requests.

4 On the Assign Requests page, in the Basic Course Search, search for Course Subject Area 
equals Reservation Labels.

5 In the Course Search Results, select the Do Not Schedule reservation label and click Add 
Request. Click Apply.

To create reservation label classes and assign meeting patterns:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 5, click Course Request Tally.

4 In the Basic Search, search for Course Subject Area equals Reservation Labels.

5 Select the Do Not Schedule reservation label and, in the Classes Required column, 
enter 2.

6 From the Actions menu, click Create Classes. Click Save.

7 In the control bar, under Admin, click Scheduling. 

8 On the Scheduling page, under Step 5, click Master Schedule.

9 On the Master Schedule page, search for Course Subject Area equals Reservation Labels.

10 Select the Do Not Schedule-1 class.

11 Under the Class Schedule panel, in Meeting Pattern, select RAM. Click Save.

12 Select the Do Not Schedule-2 class.

13 Under the Class Schedule panel, in Meeting Pattern, select RPM. Click Save. 
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To load student schedules:
When you load student schedules, students are equally distributed into the two Do Not 
Schedule classes and other classes are not scheduled during the reserved periods. 

NOTE

The Student Loader is unavailable once you enter grades or attendance in the active calendar. In this 
case, you can still assign courses and classes to students from the Student Schedule page. For more 
information, see “Working with Student Schedules” on page 321.

1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 6, click Load Students. 

4 Search for and select students. 

5 From the Actions menu, click Load Students.

Manually Assigning Students to Early or Late Start Times - 
Example
This example illustrates a manual method for reserving the early or late periods for schools 
that use extended day patterns. This method allows you to select the students who are 
assigned the early start or late start schedule. 

For this example, assume that the school has an eight-period bell schedule and students are 
required to attend five periods. The school has approximately 1000 students.

To create early start and late start meeting patterns:
You need to create a meeting pattern to reserve the first three periods of each day and 
another meeting pattern to reserve the last three periods of each day.

1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 2, click Meeting Patterns.

4 On the Meeting Patterns page, from the Actions menu, click Create Meeting Pattern.

5 On the Add Meeting Pattern page, create two meeting patterns using the following 
settings:

To create reservation labels:
For this example, you need to create two student reservation labels that you will assign to 
specific students.

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 1, click Course Setup.

Field Setting 1 Setting 2

Meeting Pattern Name Reserve - am Reserved - pm

Short Name RAM RPM

Periods 1, 2, and 3 for each day in the 
day pattern.

6, 7, and 8 for each day in the 
day pattern.
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4 On the Course List page, from the Actions menu, click Create Reservation Label. 

5 On the Add Reservation Label page, create two reservation labels with the following 
information:

6 On the Course List page, expand the Course Search panel and search for Course Subject 
Area equals Reservation Labels.

7 In the Number column, click ES.

8 In the control bar, click Course Offerings.

9 On the Course Offerings page, select the Scheduling Group and assign the Reserve - pm 
meeting pattern. Click Save.

10 On the Course List page, in the Number column, click LS.

11 In the control bar, click Course Offerings.

12 On the Course Offerings page, select the Scheduling Group and assign the Reserve - am 
meeting pattern. Click Save.

To assign the reservation label to students:
1 Log on as a school administrator. 

2 Open a Student Search page and select the students you want to have an early start 
time.

3 On the Student Search page, from the Actions menu, click Assign > Course Requests.

4 On the Assign Requests page, in the Basic Course Search, search for Course Subject Area 
equals Reservation Labels.

5 In the Course Search Results, select the Early Start reservation label and click Add 
Request. Click Apply.

6 Repeat Steps 2 to 5 for the students you want to have a late start time. 

To create reservation label classes and assign meeting patterns:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 5, click Course Request Tally.

Field Setting 1 Setting 2

Name Early Start Late Start

Short Name ES LS

Type Student Student

Scheduling Load 0 0

Maximum Students 525 525

Minimum Students 475 475

Optimal Students 500 500

Print on Reports
Note
Reports must be designed to 
check this flag. By default, 
reservation labels are included on 
reports.

N N
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4 In the Basic Search, search for Course Subject Area equals Reservation Labels.

5 Select the Early Start and Late Start reservation labels and, from the Actions menu, click 
Calculate Classes Needed.

6 From the Actions menu, click Create Classes. Click Save.

7 In the control bar, under Admin, click Scheduling. 

8 On the Scheduling page, under Step 5, click Master Schedule.

9 On the Master Schedule page, search for Course Subject Area equals Reservation Labels.

10 Select the Early Start-1 class.

11 Under the Class Schedule panel, in Meeting Pattern, select RPM. Click Save.

12 Select the Late Start-1 class.

13 Under the Class Schedule panel, in Meeting Pattern, select RAM. Click Save.

To load student schedules:
When you load student schedules, students are assigned to Early or Late Start times 
according to the reservation label request entered for the student. Other classes are not 
scheduled during the reserved periods. 

1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 6, click Load Students. 

4 Search for and select students. 

5 From the Actions menu, click Load Students.

NOTE

The Student Loader is unavailable once you enter grades or attendance in the active calendar. In this 
case, you can still assign courses and classes to students from the Student Schedule page. For more 
information, see “Working with Student Schedules” on page 321.

Setting Up Reservation Labels for Student/Teacher 
Meetings - Example
This example illustrates a method for reserving time for student-teacher meetings for 
activities such as tutoring or counseling sessions in which attendance and grades are not 
collected. 

NOTE

Resource services can also be used to schedule students for special assistance, either within their 
regular class or pulled out to a different room. For more information about resource services, see 
“Setting Up Resource Services (active calendar only)” on page 313.

For this example, assume that you want to create a Math Assistance session in which a 
teacher provides additional math instruction to a small group of students. The Math 
Assistance session uses the same meeting patterns that have been created for other courses 
and is assigned directly to both teacher and student schedules. 

To create a reservation label:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.
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3 On the Scheduling page, under Step 1, click Course Setup.

4 On the Course List page, from the Actions menu, click Create Reservation Label. 

The Add/Edit Reservation Label page opens.

5 On the Add Reservation Label page, enter the following information:

6 Click Save.

7 On the Course List page, expand the Course Search panel and search for Course Subject 
Area equals Reservation Labels.

Field Setting

Name Math Assistance

Short Name Math Asst.

Type Student

Scheduling Load .5

Maximum Students 5

Minimum Students 1

Optimal Students 3

Print on Reports Y

NOTE
Reports must be designed to check this flag. By default, reservation labels 
are included on reports.
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8 In the Number column, click Math Asst.

9 In the control bar, click Course Offerings.

10 On the Course Offerings page, select the Scheduling Group and assign the meeting 
patterns you want available to the math assistance session. Click Save.

To assign the math assistance session to a teacher and room:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 5, click Master Schedule.

4 On the By Course tab, search for Course Subject Area equals Reservation Labels. 

5 In the Math Assistance heading bar, click Add Class. 

6 Select the class.

7 In the Class Schedule panel, in Meeting Pattern, select the meeting pattern you want to 
assign; in Teacher, select the teacher; and in Room, select the room. Click Save.

To assign the math assistance session to students:
1 Log on as a school administrator. 

2 Open a Student Search page and select the students you want to assign the Math 
Assistance session.

3 On the Student Search page, from the Actions menu, click Assign > Classes.

4 On the Class Search tab, search for Course Subject Area equals Reservation Labels.

5 In the Course Search results, select the Math Assistance class. Click Add Class. 

6 Click Apply.
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Using Planning Schedules
A blank planning schedule is automatically created when you create a planning calendar. You 
can create additional planning schedules to try different scheduling scenarios for the next 
school year. 

NOTE

Although you can have multiple planning schedules, only one planning schedule can be active at one 
time. For more information, see “Copying and Switching Planning Schedules” on page 169.

Aside from changes to rooms and staff, what you do in the planning calendar does not affect 
the school active calendar. Changes to rooms and staff affect the active calendar and all 
planning schedules in the planning calendar. Changes to the course catalog setup lists on the 
Course Catalog Home page (District Setup > Course Catalog) apply to both the active and 
planning calendars, as well as all planning schedules in the planning calendar. Courses are 
assigned and published for schools by the district and must be assigned and published for 
each calendar year. If required courses are not available in the school planning calendar, 
contact your district administrator. 

In the planning calendar, you can create one or more planning schedules, provided you have 
the Change Planning Schedule permission. You can set up a different scheduling scenario in 
each planning schedule with different teachers, rooms, courses, or classes until you are 
satisfied with the schedule for the coming school year.

For more information about the planning calendar, see “Creating a Planning Calendar” in the 
Chancery SMS School Setup Guide. 

Creating Planning Schedules
Planning schedules can only be created in the planning calendar, so you must have set up a 
planning calendar, including the courses for the coming year. 

For information about creating and switching to a planning calendar, see “Switching to the 
School Planning Calendar” on page 9. 

NOTE

Staff, rooms, and courses are not part of the planning schedule. Although you can update staff and 
rooms in the planning calendar, there is only one set of staff and one set of rooms that are used by both 
the active and planning calendars. Therefore, any changes you make to staff or rooms, whether in the 
active calendar or the planning calendar, affect the data in both calendars. Courses in the planning 
calendar do not affect the active calendar. However, the courses you set up in the planning calendar are 
set up for all planning schedules in the planning calendar. For more information about updating staff, 
rooms, and courses, see “Configuring Rooms, Staff, & Courses” on page 131.

You can create as many planning schedules as you need to find the best schedule. Use the 
Planning Schedule dropdown under Step 2 on the Scheduling page to switch planning 
schedules. Switching planning schedules affects student course requests. For more 
information, see “Copying and Switching Planning Schedules” on page 169.

NOTE

To be able to create and switch between planning schedules, the Change Planning Schedule permission 
must be set to “Yes”. By default, this permission is set to “No”. For more information, see “Permission 
to Work with Secondary Scheduling” on page 121.

Because you can have multiple planning schedules, be sure you are working in the correct 
one.
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IMPORTANT NOTE

Although you can have multiple planning schedules, only one planning schedule can be active at one 
time. 

To create or copy a planning schedule:
1 Log on as a school administrator. 

2 If not already using the planning calendar, switch to the planning calendar.

3 In the control bar, under Admin, click Scheduling.

Under Step 2, the Planning Schedule dropdown shows the current planning schedule.

If you have permission, use the planning schedule dropdown to view all planning 
schedules and switch to another planning schedule.

4 To create another planning schedule, click New to the right of the Planning Schedule 
dropdown.

The column to the right of the 
links summarizes what is set up 
for this planning schedule.

Shows the current planning 
schedule. To open a different 
planning schedule select it from 
the dropdown.

To create a new planning 
schedule, click New.
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5 On the New Planning Schedule page, specify which calendar you want to copy from and 
which scheduling elements you want to copy.

NOTE

Teacher preferences are copied automatically when you create a new planning scheduled based on 
the active calendar schedule. Courses are not copied from the school active calendar. They must be 
assigned and published for the school from the district planning calendar. If required courses are not 
available in the school planning calendar, contact your district administrator. 

Field Description

Copy From Schedule Choose the schedule you want to copy. You can copy from one of 
the following schedules into the planning schedule:

• the active schedule you are using in the active calendar

• a planning schedule you have created

• a historical schedule

To create a blank planning schedule, choose None.

Copying planning schedules affects student course requests. For 
more information, see “Copying and Switching Planning 
Schedules” on page 169.

To New Planning Schedule Enter a name for the planning schedule you are creating.

Description Enter a description. (optional)
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6 Click OK.

On the Scheduling page, use the Planning Schedule dropdown to select the planning 
schedule you want to work with. The messages to the right of the links on this page 
summarize what is set up for the selected planning schedule.

After you create a planning schedule, you can define its scheduling structure and schedule 
classes, teachers, and students. Settings in one planning schedule do not affect the settings 
in other planning schedules.

As the next school year approaches, you must select one planning schedule to roll over as 
the new active schedule for the next school year. For more information about selecting a 
planning schedule for the next year, see “Selecting a Planning Schedule (planning calendar 
only)” on page 319.

Editing and Deleting Planning Schedules
You can change the name or description of planning schedules or delete them.

To edit a planning schedule name or description:
1 Log on as a school administrator.

2 If not already using the planning calendar, switch to the planning calendar.

3 In the control bar, under Admin, click Scheduling.

4 In the Planning Schedule dropdown, select the planning schedule you want to edit.

5 From the Actions menu, click Edit Planning Schedule. 

6 Make changes to the name or description. Click OK.

To delete a planning schedule:
1 Log on as a school administrator.

2 If not already using the planning calendar, switch to the planning calendar.

3 In the control bar, under Admin, click Scheduling.

4 In the Planning Schedule dropdown, select the planning schedule you want to delete.

5 From the Actions menu, click Delete Planning Schedule. Click OK. 

The planning schedule and everything that is set up in that planning schedule is deleted.

Elements to Copy Select the scheduling elements you want to copy to the new 
planning schedule.

If you select an element that requires other elements, the 
required elements are automatically selected and dimmed so 
that you cannot deselect them.

For example, if you select Term Sets, Scheduling Groups is 
automatically selected and dimmed because it is required. 
However, if you later deselect Term Sets, Scheduling Groups is 
not dimmed but is still selected.

If you do not select any scheduling elements, a blank planning 
schedule is created.

Field Description
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Copying and Switching Planning Schedules
Because creating and switching planning schedules affects student course requests, the 
Change Planning Schedule permission is set to No by default. Before you allow multiple 
people to create and switch between planning schedules, carefully consider the impact on 
student course requests. In addition, only one planning schedule can be active at one time. 
Assign the permission to change planning schedules to a minimum number of users so you 
can coordinate working in different planning schedules.

The following table describes how actions in the planning calendar affect course requests.

To switch the planning schedule:
1 Log on as a school administrator.

2 If not already using the planning calendar, switch to the planning calendar.

3 In the control bar, under Admin, click Scheduling.

4 From the Planning Schedule dropdown, choose the planning schedule you want to work 
with.

The messages to the right of the links on this page summarize what is set up for the 
selected planning schedule.

Action Effect on Course Requests

Create a planning schedule Course requests are copied to the new planning schedule. 
Depending on which planning schedule is selected when you click 
New, some or all of the course requests in the selected planning 
schedule are copied to the new planning schedule.

Copy from an active schedule or 
historical schedule

Course requests are not copied from these schedules because old 
course requests are not useful in a planning schedule. The course 
requests in the currently-selected planning calendar are copied to 
the new planning schedule.

Copy from another planning 
schedule

All the course requests in the other planning schedule are copied 
to the new planning schedule. Also, any course requests that 
only exist in the currently-selected planning schedule are copied 
to the new planning schedule.

Switch to another planning 
schedule

All the unchanged course requests are copied to the destination 
planning schedule. Changed course requests are not copied. This 
allows you to have different planning schedules with different 
course requests.
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If you copied scheduling elements when you created the planning schedule, you can 
modify the scheduling elements you copied. If you created a blank planning schedule, 
you must set up a new scheduling structure.

Select the planning 
schedule you want to 
work with.
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Setting Up the Scheduling Structure
Before you can schedule classes, teachers, and students, you must set up the basic structure 
of your school schedule, including defining scheduling groups, scheduling term sets and 
scheduling terms, the day pattern, bell schedules, and meeting patterns.

NOTE

The scheduling structure can affect data mapping. For an overview of data mapping constraints, see 
“Switching to the School Planning Calendar” on page 9. In addition, constraints related to specific 
features are mentioned in the procedures for setting up those features. 

You can set up the scheduling structure either in the active calendar or in a planning 
calendar. In the planning calendar, you can set up a separate schedule structure for each 
planning schedule so that you can see which scenario is best for your school.

NOTE

In a planning schedule, the changes you make affect only the planning schedule you’re working in. Your 
changes do not affect the active calendar or any other planning schedules. However, if changes apply to 
both the active schedule and a planning schedule, you must make them in both schedules.

Defining Scheduling Groups
A scheduling group is a group of students who use the same term set, term dates, bell 
schedules, and meeting patterns. You can set up multiple scheduling groups. Each scheduling 
group can have its own term set and term dates, bell schedules, and meeting patterns.

For example, you can set up scheduling groups by grades, such as a Junior group for grades 
9 and 10, and a Senior group for grades 11 and 12. Or you can set up scheduling groups by 
programs, such as an Accelerated group for the Advance Placement and Honors classes, and 
a Regular group for the regular classes. Another example is to set up a separate scheduling 
group with a different bell schedule for double-block classes.

Later, when you set up term sets and term dates, you define the start and end dates of each 
term for each scheduling group.

NOTE

For data mapping, the bell schedule must be the same in all scheduling groups, that is, the period codes 
and period start and end times must be the same. You can create different meeting patterns based on 
the bell schedules to accommodate different class types.

To set up scheduling groups:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

The messages to the right of the links on this page summarize what is set up for this 
planning schedule.
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4 If you are using a planning calendar, on the Scheduling page, under Step 3, click 
Scheduling Groups.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click 
Scheduling Groups.

The Scheduling Groups page opens.

5 On the Scheduling Groups page, do one of the following:

6 On the Edit Group page, enter or edit the following information as needed:

7 Click OK.

To Do this

Add a scheduling group • From the Actions menu, click Add Group.

Edit a scheduling group • Click the name of the scheduling group you want to edit.

OR

Select the scheduling group you want to edit. From the Actions 
menu, click Edit Groups.

Delete a scheduling group Deleting scheduling groups also deletes its bell schedules, 
scheduling periods, and meeting patterns, along with term lunch 
periods. 

In the active calendar, if classes have been created for a 
scheduling group, you cannot delete the scheduling group.

1 Select the scheduling group you want to delete. 

2 From the Actions menu, click Delete Group. 

3 Click OK and skip the remaining steps.

Field Description

Name Enter a unique scheduling group name.

Code Enter a short code of up to two characters. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Description Enter a description of up to 250 characters. (optional)
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Setting Up Scheduling Term Sets
After you define the scheduling groups, you can define term sets.

Term sets allow you to segment the school year. You can create as many term sets as you 
need and give each term set any name. For each term set, create as many terms as are 
needed to divide the school year, and define the start and end dates of each term. Then 
choose which scheduling group uses which term set.

You can put classes into more than one term set; that is, you can have some students 
following one term set, and some following another term set. You can also put a student into 
classes in different term sets; that is, a student can be in some classes in the full-year term 
set and some classes in the semester term set.

For example, you can create a term set with two terms or semesters.

If your school has students following a trimester schedule, you can also create a term set 
with three terms.

NOTE

For data mapping, you can define a maximum of 12 unique term ranges for each school year. If you can 
combine terms to form another term, that term does not count toward the maximum number of allowed 
terms. For example, if you have three term sets (year, quarters, and semesters) then the total number 
of terms is seven (1 + 4 + 2). However, since you can combine the quarters to form both the semesters 
and the year, only the four terms in the quarters are counted toward the maximum number of terms. 
Terms within the same term set cannot overlap.

To set up term sets:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.
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4 If you are using a planning calendar, on the Scheduling page, under Step 3, click 
Scheduling Term Sets.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click 
Scheduling Term Sets.

The Term Sets page displays any term created for the schedule and the number of terms 
in each term set.

5 On the Term Sets page, do one of the following:

6 On the Add Term Set of Edit Term Set page, enter or edit the following information as 
needed:

7 To specify term dates, click Continue.

To Do this

Add a term set • From the Actions menu, click Add Term Set.

Edit a term set • Click the name of the term set you want to modify.

OR

Select the term set. From the Actions menu, click Edit Term 
Set.

Delete a term set Before you can delete term sets in the active calendar, you must 
delete any daily code calculation rules (bell rules).

1 Select a term set. 

2 From the Actions menu, click Delete Term Set. 

3 Click OK and skip the remaining steps.

Field Description

Term Set Name Enter a unique name for the term set.

Term Name and Code Enter the names, up to 25 characters, for each term.

Enter the codes, up to 3 characters, for each term. Use 
meaningful short codes so you know what they mean when 
displayed on other pages.
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8 On the Term Dates page, enter or edit the following information, as needed:

Field Description

Use this Term Set for this 
Scheduling Group

Make sure this option is selected. In a planning schedule, you 
can temporarily deselect this option when you are setting up a 
planning schedule.

You must select this option to enter term dates. If this option is 
not selected, you cannot copy this term set to other groups, and 
all term dates are deleted when you click OK.

Scheduling Group From the Scheduling Group dropdown, select the scheduling 
group you want to work with.

School Year Enter the dates for the school year. 

You cannot use dates that fall outside your school calendar.

Start and End Date Enter the start and end date of each term in this term set.

Dates cannot overlap. For example, if one term ends on May 15, 
the next term cannot start on May 14 or May 15. The earliest 
start date for the next term is May 16.

You can have gaps between terms. For example, one term can 
end on May 15 and the next term can start on May 20.

Edit term set To return to the Edit Term Set page, click the Edit term set link 
beside the Term Set heading.

Copy to other groups If the term dates for this scheduling group can be used in 
another scheduling group, click the “Copy to other groups” link 
beside the Scheduling Group heading.

On the Copy to Groups page, specify the scheduling group to 
copy to.

After you copy term dates to another group, making changes to 
one scheduling group does not affect the other.

To return to the Edit Term 
Set page, click Edit Term 
Set.

To copy these term dates to 
another scheduling group, 
click Copy to another group.
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9 Click OK.

Specifying Day Patterns
A day pattern is the cycle of days that your school operates on. For example, your school can 
use a day-of-the-week pattern using Monday to Friday or you can use a relative-day pattern 
using a set number of days in a cycle, such as day 1 to day 4 in a four-day relative cycle. The 
day pattern is used to define which classes are offered on which days.

NOTE

For Tennessee customers only: To support the Class Section Schedule (031) extract, if your school uses 
semester, trimester, or quarter term sets, the total number of each day of the week in each semester, 
trimester, or quarter must be divisible by the number of days in the relative-day pattern. For example, 
if your school has a semester term set and a two-day relative day pattern (day 1 and day 2), the total 
number of each day of the week in each semester must be divisible by two. If semester 1 had 10 
Mondays and semester 2 had 12 Mondays, extracts would calculate correctly. However, if semester 1 had 
10 Fridays and semester 2 had 11 Fridays, extracts would not calculate correctly.

You can only have one day pattern for the active school year. Each planning calendar can 
have multiple planning schedules with different day patterns so you can determine the best 
scheduling scenario.

You can also set up special days when your school has a different bell schedule, such as days 
when your school has parent-teacher interviews, professional development days, and so on.

Using special days allows you to have a short relative-day cycle, while still accommodating 
special days that have a different schedule. For example, if you use a four-day relative cycle, 
but have a work experience day once a month, you can schedule a special day once a month 
on your calendar, instead of using a 30-day relative cycle with a different schedule every 30th 
day. For more information about setting up special days, see “Setting Up Special Days” on 
page 180.

NOTE

For data mapping, special days are not supported. Use the same day schedule for all days in the day 
pattern. You can create different meeting patterns based on the bell schedule to accommodate 
different class types.

You can apply a relative day pattern to a specific date and have Chancery SMS begin using 
that relative day on that date. For example, if the school was unexpectedly closed due to 
heavy snow on Day 2, you can apply Day 2 to the following day. For more information, see 
“Applying Relative Day Patterns” on page 179.

To set up a regular-day pattern or a special-day pattern:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.
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4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Day 
Pattern.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Day 
Pattern.

The Day Pattern page displays the regular and special days set up for the day pattern.

5 On the Day Pattern page, in the Regular Days section, enter information about your 
school’s regular day pattern. 

Field Description

Days of the Week If your school schedule uses days of the week as its day pattern, 
select Days of the week. Your school schedule would then follow 
a Monday-to-Friday pattern.

If your school schedules classes on Saturdays or Sundays, make 
sure these days are set up as normal school days in the Day 
Types setup list. For more information, see “Setting Up and 
Adding Day Type Codes” in the Chancery SMS School Setup 
Guide. 

To change a Day of the Week 
code, click the code.
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6 On the Day Pattern page, in the Special Days section, specify the pattern for special days. 

NOTE

If your school uses data mapping, do not set up special days. 

To add more than two special days, from the Actions menu, click Add Special Days.

7 Click OK.

To delete days in a relative-day pattern:
You can only delete regular days if you are using a relative-day pattern.

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

Relative Days If your school schedule uses relative days as its day pattern, 
select this option. Your school schedule would then follow a 
relative day pattern, such as Day 1 to Day 4.

You must create the number of relative days and specify their 
day names and short codes. For example, you can set up a 
four-day relative cycle called Day A to Day D, or an eight-day 
cycle called Day 1 to Day 8. 

To add relative days, from the Actions menu, click Add Regular 
Day.

NOTE
For Tennessee customers only: To support the Class Section Schedule (031) 
extract, If your school uses semester, trimester, or quarter term sets, the 
total number of each day of the week in each semester, trimester, or quarter 
must be divisible by the number of days in the relative-day pattern. For 
example, if your school has a semester term set and a two-day relative day 
pattern (day 1 and day 2), the total number of each day of the week in each 
semester must be divisible by two. If semester 1 had 10 Mondays and 
semester 2 had 12 Mondays, extracts would calculate correctly. However, if 
semester 1 had 10 Fridays and semester 2 had 11 Fridays, extracts would not 
calculate correctly. 

Day Name If you are using Relative days, specify a day name for each day. 
To add more than five regular days, from the Actions menu, click 
Add Regular Days.

If you are using Days of the week, you cannot change the name 
of the day. You can change the code names for the days of the 
week.

Code Enter a short code for each day name. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Field Description

Day Name Enter a Day name for each special day, for example, Early Dismis 
or PTI.

Code Enter a short code for each day name. Use meaningful short 
codes so you know what they mean when displayed on other 
pages.

Field Description
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3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Day 
Pattern.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Day 
Pattern.

5 Select a regular day then, from the Actions menu, click Delete Regular Day.

OR

Select a special day then, from the Actions menu, click Delete Special Day.

6 Click OK.

Applying Relative Day Patterns
NOTE

This step must be completed in the active calendar.

If you are using relative day patterns, you must specify the date that the relative day pattern 
cycle begins. Throughout the school year, you can adjust the relative day pattern cycle, as 
required. For example, if the school was unexpectedly closed due to heavy snow on Day 2, 
you can apply Day 2 to the following day and the following days adjust accordingly.

Although you typically set up relative day patterns in a planning calendar when you schedule 
classes, you must apply the relative day pattern to a specific date in the active calendar.

NOTE

You can only apply a relative day pattern if you set up scheduling to use relative day patterns. For more 
information about setting up relative day patterns, see “Specifying Day Patterns” on page 176.

You can apply a relative day pattern at any time. However, you cannot apply a relative day 
pattern to the past (days before today) if attendance has already been taken for those days. 
If you apply a relative day pattern to a future date and attendance has already been taken 
for those future dates, the attendance for those future dates is deleted.

NOTE

If your district uses the Chancery SMS student behavior feature, student behavior actions assigned to 
students might assign attendance codes for those students. When you change relative days, all future 
attendance is deleted, including attendance codes assigned by student behavior actions. However, 
student behavior attendance codes are reassigned on a day-by-day basis when the day is initialized. 

To apply a day pattern:
1 Log on as a school administrator.

2 In the control bar, under Admin, click School Setup > Relative Day Pattern. 

3 In the “Start Pattern Using Day” dropdown, select the relative day that you want to apply 
to the specified date.

4 In the As of Date dropdown, select the date you want the relative day pattern to begin. 
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5 Click Apply Day Pattern.

The Calendar Day List section refreshes to show your changes.

Setting Up Special Days
For days when your school requires a different bell schedule, you can set up special days. For 
example, you can use special days for parent-teacher interview days, professional 
development days, and so on.

If your school uses relative day patterns, using special days allows you to have a short 
relative-day cycle, while still accommodating special days that have a different schedule. For 
example, if you use a four-day relative cycle, but have a work experience day once a month, 
you can schedule a special day once a month on your calendar, instead of using a 30-day 
relative cycle with a different schedule every 30th day. 

NOTE

For data mapping, special days are not supported. Use the same bell schedule for all days. You can 
create different meeting patterns based on the bell schedule to accommodate different class types.

Setting up special days requires the following overall steps:

Step 1: Define a name and code for the special day

Step 2: Define a bell schedule for the special day

Step 3: Assign a day type to the special day

Step 4: Assign the special day to a calendar date

After you apply a new 
day pattern, the Calendar 
Day List refreshes to 
show the changes.
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Step 1: Define a name and code for the special day
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, click Day Pattern.

4 On the Day Pattern page, from the Actions menu, click Add Special Day. 

5 On the Special Days panel, click the new row.

6 In the Day Name column, enter a name for the special day. In the Code column, enter a 
code. Click OK. 

Step 2: Define a bell schedule for the special day
1 On the Scheduling page, click Bell Schedules. 

2 On the Bell Schedules page, from the Day dropdown, select the special day you defined in 
Step 1. 

3 From the Actions menu, click Add Period. 

To enter special day type 
information, click a special 
day type row. 
To add more rows, from the 
Actions menu, click Add 
Special Day.

In the Day dropdown, select 
the special day you defined in 
Step 1.
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4 On the Add Period page, enter information about the period. Click OK.

For more information about adding periods, see “Setting Up Bell Schedule Periods” on 
page 185.

5 Repeat steps 3 and 4 to define all the periods for the special day. 

6 Click OK. 

Step 3: Assign a day type to the special day
1 In the control bar, under Admin, click School Setup.

2 On the School Setup page, under Calendar, click Day Types (Setup List).

3 On the Day Types page, from the Actions menu, click Add Day Type. 

4 On the Add Day Type page, enter information about the day type. In the Instruction Day 
dropdown, select “Yes” and, in the Use For Defaults In the Day Type List Setting 
dropdown, select “No”.

5 Click Continue.

To set the bell schedule for this 
day, set Instructional Day to 
“Yes” and “Use for defaults in 
day type list settings” to “No”.

Continue button is only available 
when Instructional Day is set to 
“Yes” and “Use for defaults in 
day type list settings” is set to 
“No”.
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6 On the Bell Schedules page, in the Bell Schedule Based On Day dropdown, select the 
special day you defined in step 1.

7 Click OK. 

Step 4: Assign the special day to a calendar date
1 In the control bar, under Admin, click School Setup.

2 On the School Setup page, under Calendar, click Calendar Day Exceptions.

3 On the Calendar Day Exceptions page, from the Action menu, click Add Exception Day. 

In the “Bell Schedule based on 
day” dropdown, select the special 
day you defined in step 1.
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4 On the Add Exception Day page, enter information about the exception day. In the Day 
Type dropdown, select the day type you created in step 3.

5 If your school uses relative days, click Continue and select the relative day you want to 
be applied to the day following the special day. 

6 Click Apply Day Pattern.

Setting Up Bell Schedules
Bell schedules specify the start and end times for periods throughout the day. You can define 
a different bell schedule for each scheduling group and for each day in the day pattern. For 
example, you can have one bell schedule for the junior and intermediate scheduling groups, 
and a different bell schedule for the senior scheduling group.

To set up a bell schedule, add periods to the day and define the start and end times for each 
period.

NOTE

To support data mapping, note the following:

• Each day in the day pattern must have the same bell schedule/period structure, including the same 
periods and the same number of instructional minutes in periods with the same code. For example, 
if on Monday, period 1 had 50 instructional minutes, period 1 must have 50 instructional minutes for 
every day in the day pattern. Periods within one day can have different amounts of instructional 
minutes. 

• Each day in the day pattern can have a maximum of 42 periods.

• Periods cannot overlap.

• If more than one scheduling group is defined (e.g., to support exception days), the bell schedule 
must be the same in both scheduling groups, that is, the period codes and period start and end times 
must be the same.

In Day Type, select the 
day type you created in 
Step 3.

If your school uses 
relative days, the OK 
button is replaced with a 
Continue button. Click 
the Continue button to 
apply a relative day to 
the day following this 
special day.
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Setting Up Bell Schedule Periods
You set up a bell schedule by adding periods to each day. You can set up the periods for one 
day and then copy those periods to other days in the bell schedule. To copy the periods from 
one day to other days, see “Copying Periods from One Day to Another Day” on page 187.

After you set up periods for all days for a scheduling group, you can copy the bell schedule 
for all the days to other scheduling groups. To copy the periods for all days in one scheduling 
group to another, see “Copying Periods in All Days to Another Scheduling Group” on 
page 189.

NOTE

If you are making adjustments to an existing scheduling structure, use caution when copying periods or 
bell schedules to other days or scheduling groups. Copying deletes any existing setup in the target day or 
scheduling group, which may affect daily code calculation rules, meeting patterns, or exception day 
types.

To set up periods in a bell schedule:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Bell 
Schedules.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Bell 
Schedules.

5 From the Scheduling Group dropdown, select the scheduling group you want to work 
with.

6 From the Day dropdown, select the regular day or the special day you want to define.

7 Do one of the following:

If you add or edit a period, the Add Period or Edit Period page opens.

To Do this

Add a period • From the Actions menu, click Add Period.

Edit a period • Select a period. From the Actions menu, click Edit Period.

OR

Click the Details icon ( ) for the period you want to edit.

Delete a period 1 Select the period. 

2 From the Actions menu, click Delete Period. 

Skip the remaining steps.
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8 On the Add Period or Edit Period page, specify or edit the following information for the 
period:

NOTE

If your district runs data mapping, the maximum number of periods (number of meeting blocks for 
each day) you can create is 42. Periods cannot overlap and each day in the day pattern must have 
the same bell schedule/period structure, including the same periods and the same number of 
instructional minutes in periods with the same code.

Field Description

Start Time Enter the start time for the period.

The start time can be several minutes after the previous end 
time to allow students to get to their next class.

End Time Enter the end time for the period.

Period Name Enter a name for the period.

Period Label (short code) Enter a short code for the period.

Print on Schedules If checked, this period is displayed on student or teacher 
schedules. If you do not want to display this period, such as for 
before or after school periods, deselect this checkbox.

Use for Classes If checked, this period is available for meeting patterns to 
schedule classes.

Include in daily Attendance 
Code Calculation Rules

If checked, this period is available for use in attendance 
calculation rules.

Include in instructional/ 
attendance minutes 
calculations

Select this option if you want this period included in instructional 
or attendance minutes calculations. For more information about 
instructional minutes calculations, see the Chancery SMS 
Instructional Minutes Calculation Technical Bulletin. 

NOTE
You cannot change this value if the period is part of a meeting pattern and 
attendance has been taken.

This period is part of regular 
school hours

Select this option if you want the period to be included in 
instructional minutes calculations as regular school hours. For 
example, if your school offers academic programs in the 
evenings or on weekends and you want them included when you 
calculate instructional minutes for regular school hours. 

NOTE
If you want a period to be included in regular school hours for some classes, 
but not others, create two scheduling groups. Select “This period is part of 
regular school hours” in one scheduling group and deselect it in the other. 
Then schedule classes using the appropriate scheduling group. 
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9 Click OK. 

Copying Periods from One Day to Another Day
After you set up the periods for one day, you can copy them to other days so that you don’t 
have to set up the same periods for every day in the day pattern. If other days have a similar 
bell schedule, you can copy the periods, and then change the days that are different. 

After you copy periods, making changes to the periods in one day does not affect the periods 
in the other day.

NOTE

When you copy periods to another day, any periods already defined in that day are overwritten. If you 
are making adjustments to an existing day, use caution when copying periods to other days. Changing 
the periods set up for an existing day may affect daily code calculation rules, meeting patterns, or 
exception day types.

For This Period Only Enter the amount of instruction time in the period.

The instruction time is usually the number of minutes between 
the start and end time. For example, if a period starts at 9:00 
and ends at 9:50, the instruction time is usually 50 minutes. If 
you leave this field blank, the result of this calculation is used 
when you click OK.

There may be periods where the instruction time is less than the 
meeting time. For example, if a gym class meets for 65 minutes 
but there is 10 minutes for changing then enter 55 as the 
instruction time.

NOTE
For data mapping, the instructional minutes for periods with the same code 
must be the same for all days in the day pattern and in all scheduling groups. 
For example, if period 1 is assigned 50 instructional minutes on Monday, 
period 1 must have 50 instructional minutes for all the other days of the 
week and in all scheduling groups.

Passing Time Minutes to 
Include for Blocked Classes

Use this when a class spans more than one period and there is 
non-scheduled time between periods, such as time between 
classes for students to get to the next class.

For example, if your schedule has four minutes between classes 
for students to go to the next class, and a chemistry class spans 
two periods, you can specify whether that four minutes is 
instruction time or not.

Using this example, say your two-period Chemistry class totals 
70 minutes and includes one period in the classroom and one 
period in the lab, with students using the 4 minutes between 
periods to go from the classroom to the lab then you would enter 
66 in the “For this period only” field, and 4 in the “Passing time 
minutes to include for blocked classes” field.

However, if the two-period chemistry class is both in the lab then 
the 4 minutes would be considered instruction time and you 
would enter 70 in the “For this period only” field and 0 in the 
“Passing time minutes to include for blocked classes” field.

Field Description
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To copy periods:
1 Log on as a school administrator. 

2 In the control bar, click Scheduling.

3 On the Scheduling page, under Step 2, click Bell Schedules.

4 On the Bell Schedules page, after you define periods for one day, click “Copy to Other 
Days” beside the Day heading. For information about adding periods, see “Setting Up Bell 
Schedule Periods” on page 185.

The Copy to Days page displays the day you are copying from and the days that are 
available to be copied.

To copy a period to another day of 
the week, select the period and 
then click the Copy to Other Days.
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5 In the Available column, select the days you want to copy and move them to the Copy to 
Days column.

6 Click OK. Click OK to confirm.

Copying Periods in All Days to Another Scheduling Group
After you have set up periods for all days for a scheduling group, you can copy the bell 
schedule for all the days to other scheduling groups. This option makes it easy to set up the 
bell schedules for all your scheduling groups.

NOTE

When you copy to another scheduling group, the bell schedule in the receiving scheduling group is 
overwritten. If you are making adjustments to an existing bell schedule, use caution when copying to 
other scheduling groups. Changing the bell schedules set up for an existing day may affect daily code 
calculation rules, meeting patterns, or exception day types.

After you copy periods, making changes to the periods in one day does not affect the periods 
in another day.

To copy periods in all days to another scheduling group:
1 Log on as a school administrator. 

2 In the control bar, click Scheduling.

3 On the Scheduling page, under Step 2, click Bell Schedules.

4 On the Bell Schedules page, after you define periods for all days in a scheduling group, 
click “Copy to Other Groups”. For information about adding periods, see “Setting Up Bell 
Schedule Periods” on page 185.

The Copy to Groups page displays the scheduling group you are copying from and the 
scheduling groups that are available to be copied to.

Use the arrows to move 
selected items between the 
lists.
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5 From the Available column, select the scheduling groups you want to copy and move 
them to the “Copy to Scheduling Groups” column.

6 Click OK. Click OK to confirm.

Setting Up Meeting Patterns
After you set up bell schedules, you can set up the meeting patterns. A meeting pattern is a 
series of periods when a class can meet. You define a meeting pattern, and then specify the 
periods and days it meets. Give meeting patterns descriptive names that indicate when the 
class meets.

Once the required meeting patterns are created for your school, the schedule structure is 
complete. When you set up classes, you can assign meeting patterns as appropriate. For 
more information about setting up classes, see “Defining Class Scheduling Options” on 
page 265.

To set up meeting patterns:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.
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4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Meeting 
Patterns.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Meeting 
Patterns.

The Meeting Patterns page shows the following information:

Field or Section Description

Meeting Patterns for 
Scheduling Group

Select the meeting patterns you want to work with.

Name Specifies the name of the meeting pattern.

Short Name Specifies the short name of the meeting pattern. 

When entering short names, use meaningful names so you know 
what they mean when displayed on other pages.

Description Displays a summary of the days and periods when this meeting 
pattern meets.

View of selected meeting 
patterns

Displays a timetable grid.

You can select one or more meeting patterns then click Update 
View to see how the meeting patterns fit in a timetable grid.

Update View Updates the timetable grid with the selected meeting patterns. 

After you select or deselect meeting patterns, click Update View 
to update the timetable grid.

To see the periods when a 
specific meeting pattern 
meets, select a meeting 
pattern and then click 
Update View.

Meeting patterns for the 
scheduling group.
Setting Up the Scheduling Structure 191
Setting Up Meeting Patterns



Chancery SMS Scheduling Guide
5 On the Meeting Patterns page, in Meeting Patterns for Scheduling Group, select the 
scheduling group you want to work with.

6 Do one of the following:

If you add or edit a meeting pattern, the Add Meeting Pattern or Edit Meeting Pattern 
page opens.

To Do this

Add a meeting pattern • In the Actions menu, click Add Meeting Pattern.

Edit a meeting pattern • Select a meeting pattern. From the Actions menu, click Edit 
Meeting Pattern.

OR

Click the name of the meeting pattern you want to edit.

Delete a meeting pattern 1 Select the meeting pattern.

2 From the Actions menu, click Delete Meeting Pattern. Skip the 
remaining steps.

Shows the periods defined in the 
bell schedule. For more 
information about setting up the 
bell schedule, see “Setting Up Bell 
Schedules” on page 184.
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7 On the Add Meeting Pattern page or Edit Meeting Pattern page, specify or edit the 
following information for the meeting pattern.

8 Click OK.

Setting Up Meeting Patterns for Blocked Periods - Example
If your school wants to offer classes in blocked periods, create meeting patterns that use 
multiple, consecutive periods. 

NOTE

Do not use the Add More Detail link on the Master Schedule page to create double periods by assigning 
multiple meeting patterns to the class. The More Detail option creates multiple rows for the class in the 
database, which can be confusing on other pages, such as the Class Search page.

To create a blocked period meeting pattern:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 3, click Meeting 
Patterns.

OR

If you are using the active calendar, on the Scheduling page, under Step 2, click Meeting 
Patterns.

5 On the Meeting Patterns page, in Meeting Patterns for Scheduling Group, select the 
scheduling group you want to work with.

6 In the Actions menu, click Add Meeting Pattern.

7 On the Add Meeting Pattern page, enter a name and short name for the blocked meeting 
pattern; for example, enter Period 1-2 and P1-2.

Field Description

Meeting Pattern Name Enter a descriptive name for this meeting pattern so that you can 
easily see when this meeting pattern meets.

Short Name Enter a descriptive short name for this meeting pattern. Use 
meaningful short names so you know what they mean when 
displayed on other pages.

Meeting Pattern Select the periods when this meeting pattern meets. For 
example, if this meeting pattern meets in period 1 on Day 2 and 
Day 4, select Day 2, Period 1 and Day 4, Period 1.
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8 On the Meeting Pattern panel, select the periods to include in the blocked meeting 
pattern. 

9 Click OK.

Viewing Meeting Patterns
You can view a visual representation of defined meeting patterns. 

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, click Meeting Patterns. 

Select the periods the blocked 
class meets in; for example, this 
meeting pattern offers classes in 
period 1 and 2 on Mondays, 
Tuesdays, and Fridays.
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4 On the Meeting Patterns page, select the meeting pattern you want to view.

5 Click Update View.

Select the meeting pattern 
you want to view.

Click Update View to see a 
visual representation of the 
meeting pattern.
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Configuring Student Loading Rules
The intent of student loading rules is to set up rules that automated scheduling processes 
use when scheduling specific courses, such as making sure some courses are always 
scheduled in sequence, or to balance the schedule so that electives are not all scheduled 
together.

Chancery SMS uses three types of student loading rules: 

Student loading rules are available in both the active and planning calendars. In the active 
calendar, these rules are under the Step 3 “Configure student loading rules”. In the planning 
calendar, these rules are under Step 4 “Configure student loading rules”.

After you define the scheduling structure using the instructions in “Setting Up the Scheduling 
Structure” on page 171, you can define student loading rules for constraints, classes, and 
teams.

NOTE

Do not create more rules than you need for the following reasons:

• The more rules you have, the harder and longer the Student Loader or Walk-in Scheduler 
has to work to create the student schedule. If there are too many restrictive rules, the 
Student Loader or Walk-in Scheduler might not be able to find a suitable schedule. 

• You might inadvertently create loading rules that conflict with each other, especially when 
there are many rules. If you are unable to build a schedule, check the loading rules to 
make sure they do not conflict.

Setting Up Constraints
You can use constraints to control the distribution of students in classes. Schools that use 
elementary scheduling can assign constraints to classes or homerooms. 

For secondary schools, Chancery SMS supports two types of constraints: Restrictions and 
Capacity Balancing. 

• Restrictions

Restrictions allow you to control the distribution of students in classes according to 
specific criteria. For example, you can ensure that at least 10 percent of the students in a 
class are girls or restrict specific classes to students for whom English is their second 
language.

Student Loading Rule Type Description

Constraints Use these rules to control the distribution of students in classes. 

Class Loading Rules Use these rules to:

• control the sequence of classes on a student’s schedule

• match the attributes of selected classes for a student

• balance the class load between terms on a student’s schedule

Team Loading Rules Use these rules if your school schedules students in teams that 
take the same classes with the same teachers.
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• Capacity Balancing

Capacity Balancing constraints ensure that automated loading processes distribute 
students evenly among available classes based on certain criteria. For example, you may 
want to ensure that students whose ethnicity is “African American” are distributed evenly 
among all available classes rather than all being scheduled to the same class. 

Capacity Balancing constraints apply only to automated scheduling processes.

Constraints can be created at the district or at the school. Constraints created at the district 
are available to all schools in the district. If you modify a district-defined constraint at a 
school, Chancery SMS creates a copy of the constraint at the school level. Schools cannot 
delete district-defined constraints. When you create or edit constraints at the school, you can 
also make the constraint mandatory for specific subjects and/or homerooms.

Once constraints are defined, you apply or remove the constraint for specific classes and/or 
for homerooms. If a constraint is mandatory for a subject or homeroom, you cannot remove 
it from any class for that subject or homeroom. 

NOTE

When creating student schedules, the Student Loader only considers constraints if the Use Capacity 
Balancing Constraints or Use Restriction Constraints option is selected on the Student Loader Options 
page. For more information about Student Loader options, see “Setting Student Loader Options” on 
page 307.

Creating and Editing Restriction Constraints
Restrictions allow you to control the distribution of students in classes according to specific 
criteria. For example, you can ensure that at least 10 percent of the students in a classes are 
girls or restrict specific classes to students for whom English is their second language.

Creating and editing constraints involves setting up three steps:

• Step 1: Define Constraints

• Step 2: Select Student Criteria

• Step 3: Select Courses 

Step 1: Define Constraints
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 If you are in the active calendar, on the Scheduling page, under Step 3, click Constraints.

OR 

If you are using a planning calendar, on the Scheduling page, under Step 4, click 
Constraints.
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4 On the Constraints page, do one of the following:

5 On the Edit Constraints page, expand the Define Constraint panel and enter or edit the 
following information:

To Do this

Add a constraint • From the Actions menu, click Add Constraint.

Modify a constraint • Click the constraint name.

OR

Select the constraint. From the Actions menu, click Edit 
Constraint.

NOTE
If you modify a district-defined constraint, it is saved at the school as a 
school-defined constraint. The district-defined constraint is not changed and 
is still available at the district and at the school.

Delete a constraint 1 Select the constraint. 

2 From the Actions menu, click Delete Constraint. 

Skip the remaining steps.

You cannot delete a district-defined constraint.

Field Description

Name Enter a name for the constraint. The name must be unique 
within the school. 

NOTE
If you modify a district-defined constraint, a school-defined version of the 
constraint is saved for your school. The district-defined version is not 
changed and is still available to apply to classes.

Defined at View-only. Indicates whether the constraint was defined at the 
district or at the school. 

Program Constraint Select this checkbox if the constraint applies to the specialized 
activities or courses outside of regular academic studies available 
through Program Management.

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Track Program Attendance 
for Classes with this 
Constraint

This checkbox is available if the Program Constraint checkbox is 
selected. 

Select this checkbox if you want Program Management to include 
classes that are assigned this restriction in instructional minute 
calculations. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Constraint Type Select the type of constraint.

When editing a constraint, you cannot change the constraint 
type.
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6 Under “Complete the following phrase to define the constraint”, enter the following 
information to construct the constraint statement:

7 Continue with “Step 2: Select Student Criteria” on page 200. 

Step 2: Select Student Criteria
After you define the constraint, you must specify the criteria that students must match to be 
eligible for the classes the constraint is assigned to. 

Restriction Constraints use the Eligibility control to construct eligibility criteria. For more 
information about using the Eligibility control, see “Working with the Eligibility Control” on 
page 205.

Field Description

First dropdown Select the constraint strength, that is, whether the constraint 
must be applied or should be applied. 

If you select “Must contain”, automated scheduling processes will 
not schedule students if the constraint is not satisfied. When 
manually scheduling students that do not meet the criteria, you 
must have the Override Constraints permission set to “Yes” to 
add the student to the class.

If you select “Should contain”, automated scheduling processes 
attempt to meet the specified constraint criteria, but if another 
class is not available, Chancery SMS will schedule students who 
do not match the criteria. When manually scheduling students 
that do not meet the criteria, Chancery SMS displays a warning 
but does not prevent the student from being added to the class.

Second dropdown Select the constraint range from the following options:

• At most - the maximum number of students that can have the 
specified criteria.

• All - all students assigned to this class must have the specified 
criteria. This option is equivalent to “must contain 100%”. 

• No - no students assigned to this class can have the specified 
criteria. This option is equivalent to “must contain 0%”. 

Text box Enter the constraint value, that is, the number or percent of 
students required for the constraint. 

For percent values, enter a number between 0 and 100.

For numeric values, enter a number between 0 and 9999. 

%/# Select whether the Constraint Value is a number or a 
percentage.

Third dropdown Select the constraint matching criteria. Students can either 
match or not match the defined criteria.
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To select student criteria:
1 On the Add Constraint or Edit Constraint page, expand the Select Student Criteria panel.

2 If the Program Constraint check box is not selected under the Define Constraint panel, 
construct criteria statements for the eligibility rule using the eligibility control. For more 
information about using the eligibility control, see “Creating and Editing Capacity 
Balancing Constraints” on page 202.

3 If Program Constraint is selected under the Define Constraint panel, specify the programs 
the constraint applies to by entering the following information:

To Do this

Add a criteria statement to 
the eligibility rule

1 From the Category dropdown, select the type of data to be 
added.

2 Under Search By, from the first dropdown, select the field or 
function.

3 From the second dropdown, select the appropriate operator 
(e.g., equals).

4 In the third field, enter or select the appropriate value.

If you selected a function in Step 2, additional dropdowns are 
available under “Where the following conditions apply”.

5 If available, under “Where the following conditions apply”, 
from the first dropdown, select the condition.

6 If available, from the second dropdown, select the appropriate 
operator (e.g., equals).

7 If available, from the third dropdown, select a value.

8 Click Add Criteria.

Delete a criteria statement 
from the eligibility rule

1 In the Eligibility Criteria list box, click the statement to 
highlight it.

2 Click Remove.

Add a logical operator to 
define the relationships 
between statements

1 Click AND or OR.

2 Add a criteria eligibility statement to the logical operator. 

NOTE
Eligibility rules using multiple criteria must conform to the “Rule of Two”. 
Each operator must have a pair of items nested underneath. Item pairs can 
be either two criteria OR one criteria and an operator (AND/OR).

Move a statement to another 
location in the eligibility rule

• Click and drag the statement to the new location.

Validate the rule • Click Validate.

Field Description

Program Category Select the appropriate program category.

Program Select the program the constraint applies to.
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4 Continue with “Step 3: Select Courses” on page 202. 

Step 3: Select Courses
Once you have defined a constraint (see “Step 1: Define Constraints” on page 198) and 
selected student criteria (see “Step 2: Select Student Criteria” on page 200), you are ready 
to assign the constraint to courses. 

When you assign constraints to a course, you indicate how the constraint applies to classes 
for that course. Constraints may apply by default, be available, or be mandatory for courses.

To assign constraints to courses:
1 On the Add Constraint or Edit Constraint page, expand the Select Courses panel.

2 Search for courses or click Display All Records. 

3 In the list of available courses, select the courses you want to apply the constraint to and 
move them to the Selected Courses list. 

4 From the Constraint Is dropdown, select one of the following options:

5 Click OK.

Creating and Editing Capacity Balancing Constraints
NOTE

Capacity Balancing constraints apply only to automated scheduling processes.

Capacity Balancing constraints ensure that automated loading processes distribute students 
evenly among available classes based on certain criteria. For example, you may want to 
ensure that students whose ethnicity is “African American” are distributed evenly among all 
available classes rather than all being scheduled to the same class. Capacity Balancing 
constraints do not apply when you manually assign students to classes. 

Creating and editing constraints involves three steps:

• Step 1: Define Constraints

• Step 2: Select Student Criteria

• Step 3: Select Courses 

Available sessions/Selected 
sessions

To assign the constraint to a session, select the session from the 
Available Sessions list and move it to the Selected Sessions list. 

To remove the constraint from a session, select the session from 
the Selected Sessions list and move it to the Available Sessions 
list.

Option Description

Available The constraint is available to classes for this course. It is not 
automatically assigned to classes.

Default The constraint is applied by default to newly created classes for 
this course, but can be removed for specific classes.

Mandatory The constraint is required for all classes for this course and 
cannot be turned off for any class.

Field Description
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Step 1: Define Constraints
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 If you are in the active calendar, on the Scheduling page under Step 3, click Constraints.

OR 

If you are using a planning calendar, on the Scheduling page under Step 4, click 
Constraints.

4 On the Constraints page, do one of the following:

If you add or edit a constraint, the Add Constraint or Edit Constraint page opens. 

5 On the Edit Constraints page, expand the Define Constraint panel and enter or edit the 
following information:

To Do this

Add a constraint • From the Actions menu, click Add Constraint.

Edit a constraint • Click the name of the Capacity Balancing constraint.

OR

Select the Capacity Balancing constraint. From the Actions 
menu, click Edit Constraint.

Delete a constraint 1 Select the constraint. 

2 From the Actions menu, click Delete Constraint. 

3 Click OK and skip the remaining steps.

NOTE
You cannot delete a district-defined constraint.

Field Description

Name Enter a name for the constraint. The name must be unique 
within the school. 

NOTE
If you modify a district-defined constraint, a school-defined version of the 
constraint is saved for your school. The district-defined version is not 
changed and is still available to apply to classes.

Defined at View-only. Indicates whether the constraint was defined at the 
district or at the school. 

Program Constraint Select this checkbox if the constraint applies to specialized 
activities or courses outside of regular academic studies available 
through Program Management.

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Track Program Attendance 
for Classes with this 
Constraint

This checkbox is available if the Program Constraint checkbox is 
selected. 

Select this checkbox if you want Program Management to include 
classes that are assigned this restriction in instructional minute 
calculations. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.
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6 Under “Complete the following phrase to define the constraint”, select either “Matching 
the specified criteria” or “Not matching the specified criteria” from the dropdown.

7 Continue with “Step 2: Select Student Criteria” on page 204. 

Step 2: Select Student Criteria
After you define the constraint, you specify the characteristic you want to balance across 
classes. Depending on the category selected, you can balance classes for the following items:

To select student criteria:
1 On the Add Constraint or Edit Constraint page, expand the Select Student Criteria panel 

and do one of the following:

2 Continue with “Step 3: Select Courses” on page 205. 

Constraint Type Select Capacity Balancing.

Constraint Matching Select whether the students must match or not match the 
specified criteria.

Constraint Description Displays a description of the defined constraint. 

This field is updated when the constraint is saved or when you 
click Refresh. 

Category Fields available

Demographics • Age (current)

• Ethnic Category

• Federal ethnicity category

• Gender

• Geocode (active)

• Geocode (planning)

• Grade level (current)

If Do this

The Program Constraint 
checkbox is not selected 
under the Define Constraint 
panel

1 From the Category dropdown, select the type of data to be 
added.

2 From the Balance By dropdown, select the field you want 
classes to be balanced by. For example, to have an equal 
number of boys and girls in classes, select Gender.

The Program Constraint 
checkbox is selected under 
the Define Constraint panel

1 From the Program Category dropdown, select the appropriate 
program category.

2 From the Program dropdown, select the program the 
constraint applies to.

3 In the Available Sessions list, select the program sessions you 
want the constraint to apply to and move the sessions to the 
Selected Sessions list.

Field Description
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Step 3: Select Courses
Once you have defined a constraint (see “Step 1: Define Constraints” on page 203) and 
selected student criteria (see “Step 2: Select Student Criteria” on page 204), you are ready 
to assign the constraint to courses. 

When you assign constraints to a course, you indicate how the constraint applies to classes 
for that course. Constraints may apply by default, be available, or be mandatory for courses.

To assign constraints to courses:
1 On the Add Constraint or Edit Constraint page, expand the Select Courses panel.

2 Search for courses or click Display All Records. 

3 In the list of available courses, select the courses you want to apply the constraint to and 
move them to the Selected Courses list. 

4 From the Constraint Is dropdown, select one of the following options:

5 Click OK.

Working with the Eligibility Control
The Eligibility control allows you to construct eligibility rules. For constraints, the eligibility 
rules are used to determine if students are eligible for classes based on the applied 
constraints. 

The Eligibility control is made up of two sections:

• The statement builder – a collection of fields known as Search By sets that you can use to 
construct the individual criteria statements.

Option Description

Available The constraint is available to classes for this course. It is not 
automatically applied to classes.

Default The constraint is applied by default when classes for this course 
are created, but can be turned off for specific classes.

Mandatory The constraint is required for all classes for this course and 
cannot be turned off for any class.
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• The Eligibility Criteria section – a list box that contains the entire eligibility rule, including 
the logical operators (AND/OR) that connect the statements.

Using the Statement Builder
The statement builder has three sections: a Category selector, a primary Search By 
statement, and, for some statements, an additional set of “where” clauses. To add a 
statement to the eligibility criteria, click Add Criteria. 

Statement Builder

Eligibility Criteria

Left term Operator Right term

Category of student data

Search By statement

Where clause (appears if 
function selected in Search By 
statement)

Click to add the statement to the 
eligibility criteria. 
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To construct a statement, you first select a category of student data. For example, 
Demographics.

In each category, you will find all the existing properties in the database that could be 
relevant to calculating eligibility for that particular category. 

The Search By section is made up of a left term, an operator (e.g., equals, is greater than or 
equal to, contains, etc.), and a right term. Using these components, you construct the main 
search statement to be added to the eligibility control. 

IMPORTANT NOTE

All eligibility rule criteria open text field searches are case sensitive.

Depending on the category you select, from the left term, you can select either a field or a 
function.

The options available for specifying a criteria depends on whether you select a field or a 
function from the from the left term dropdown:

• Field

In it’s simplest form, a field is any single piece of data stored in the database, such as a 
student’s gender. When you select a basic field as the left term, you can specify an 
operator and right term then add the statement to the eligibility rule; no additional 
controls are generated.

Some fields include an additional Search By set below the first, which allows you to 
search for specific information related to the selected field. For example, if you select a 
setup list, such as Ethnicity, an additional dropdown allows you to select another left 
term, such as description or code, and specify an operator and right term; for example, 
“Ethnicity Description equals Asian”. 

functions

fields

Basic fields include only one 
Search By set.

Some field include an additional 
Search By set.
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• Function

A function is a predefined tool used to construct statements about complex data that 
require you to specify limiting or “where” clauses. For example, if you specify that a 
student must have a cumulative GPA of 3.5, the system will look at all cumulative GPA 
definitions. However, if you use a cumulative GPA function, additional Search By sets are 
automatically generated to allow you to select a specific GPA definition. 

When you select a function, a section called “Where the following conditions apply” 
appears below the Search By section. Any limiting terms necessary to extract the 
appropriate data are preset. Once you select the operator and right term for the first 
Search By set and all associated where clauses, you can add the statement to the 
eligibility rule. 

NOTE

For some functions, the options available in the right term dropdown for some parameters depend 
on whether you are defining the rule at the district level or at the school level. If you are defining 
the rule at the district level, you can select from a list of values defined at any school in the district. 
If you are defining the rule at the school level, you only see values defined at that school. If an 
eligibility rule is created at the district using a value that is defined at some but not all schools, and 
then the rule is run at a school that does not have the value defined, no students at the school will 
match the criteria. 

For example, suppose a district has two schools that each create a cumulative GPA definition. School 
A calls the definition “Weighted Cum GPA” and School B calls the definition “Weighted Cumulative 
GPA”. Then, at the district, you create an eligibility rule. When you set the Cumulative GPA 
definition parameter, the list of Cumulative GPA definitions includes both “Weighted Cumulative 
GPA” and “Weighted Cum GPA”. If you create the eligibility rule that specifies the “Weighted Cum 
GPA” definition, when the rule is run at School B, no students match the criteria. 

For a description of the functions available for each category, see the Chancery SMS 
Eligibility Technical Bulletin.

When you select a 
function in the first 
Search By 
dropdown, you can 
specify conditions in 
the “Where the 
following conditions 
apply” section.

For some 
functions, the 
values available 
in this dropdown
depend on 
whether you are 
defining the rule
at the district 
level or at the 
school level.
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Creating Eligibility Rules
The Eligibility Criteria section of the control groups together the individual statements into an 
eligibility rule.

The eligibility rule as a whole is displayed in the list box in the Eligibility Criteria section. This 
list box is organized in a tree structure, similar to the folders on a computer, and the 
branches of this tree are called nodes. When you construct a statement and click Add 
Criteria, the statement is added below the selected node, or to the bottom of the rule if a 
node was not selected.

If you have more than one statement in your rule, you must add logical operators to group 
them meaningfully. For example, if students are required to meet all the criteria in your rule, 
the first node under Criteria should be AND; all the statements would then hang off that 
node. If, on the other hand, students are only required to meet one out of a list of criteria, 
the first node should be OR. Additional nodes can be added to allow a combination of these 
operators.

To add operators, click the node to which you want to add the operator and then click the 
AND or OR button. You can then drag the statements to the appropriate node. You can also 
drag whole nodes to different locations in the list box or remove statements completely.

NOTE

When dragging a statement or operator, make sure the cursor is directly above the node before releasing 
it.

Node

Logical operators

Statement

Completed rule
(displays after the 
rule is saved)

Tree structure
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Eligibility Rules and Null or Empty Values
When the Chancery SMS eligibility control processes eligibility rule criteria that references a 
field that is empty, it evaluates as false unless it uses the “is empty” operator. 

For example, if the student’s Date of Birth field is empty, the following criteria would evaluate 
as true:

age is empty

However, the following criteria would evaluate as false:

age does not equal 12

For best results, before calculating eligibility, make sure student data is complete and 
correct. 

Applying Constraints to Classes
After you set up constraints, you can apply or remove them for specific classes. The 
constraints in the Available Constraints, Selected Constraints, and Mandatory Constraints 
lists depend on how constraints were assigned to courses. (See “Step 3: Select Courses” on 
page 202 or “Step 3: Select Courses” on page 205).

If a constraint is available to a course, it is available to all classes for the selected course, but 
is not applied unless selected for specific classes. If a constraint is set to default for a course, 
it is applied when classes for that course are created. You can manually remove the 
constraint from classes. If the constraint is mandatory for a course, it is automatically applied 
when classes for that course are created and it cannot be removed. 

Chancery SMS provides two methods for applying constraints to specific classes:

• From the Apply Constraints page - shows detailed information about the constraints. For 
more information, see “Applying Constraints Using the Apply Constraints Page” on 
page 210.

• From the Master Schedule page - shows detailed information about classes, but only the 
names of constraints.

NOTE

The Student Loader only considers constraints if the Use Capacity Balancing Constraints or Use 
Restriction Constraints option is selected on the Student Loader Options page. For more information 
about Student Loader options, see “Setting Student Loader Options” on page 307.

Applying Constraints Using the Apply Constraints Page
The Apply Constraints page shows detailed information about the constraints you are 
working with.

To apply constraints to classes:
1 Log on as a school administrator.

2 In the control bar, click Scheduling.

3 On the Scheduling page, click Constraints.

4 In the list of constraints, select the constraint you want to apply to classes. From the 
Actions menu, click Apply Constraint.

OR 

Click the number in the # of Classes column.
210 Configuring Student Loading Rules
Applying Constraints to Classes



Chancery SMS Scheduling Guide
5 On the Apply Constraints page, review the following information about the constraint:

6 Expand the Classes panel or Select Classes panel and search for courses. 

7 If the constraint is mandatory, the Classes field shows a list of classes for the course.

OR 

If the constraint strength is set to default or available, the page includes a list of available 
classes and the classes the constraint has been applied to (Selected Classes).

8 For default or available constraints, to apply the constraint to classes, select classes in 
the Available Classes list and move them to the Selected Classes list. 

OR

To remove the constraint for classes, select the classes in the Selected Classes list and 
move them to the Available Classes list. 

9 Click OK.

Setting Up Class Loading Rules
Class loading rules are used by the Student Loader and the Walk-in Scheduler to control the 
loading of student schedules. The Student Loader uses all class loading rules when it loads 
student schedules. Master Schedule Builder only uses the rules that affect building the 
master schedule, such as attribute rules.

For example, to make sure Chemistry Lab immediately follows Chemistry, you can set up a 
course sequencing rule to “always schedule Chemistry 11 to end in a period immediately 

Field Description

Type Displays the type of constraint: Restriction or Capacity 
Balancing.

Program Const Indicates whether the constraint applies to the specialized 
activities or courses outside of regular academic studies available 
through Program Management. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Track Program Att Indicates whether Program Management includes classes that 
are assigned this restriction in instructional minute calculations. 

For more information about Program Management, see the 
Chancery SMS Program Management Guide.

Strength Indicates how the constraint is applied to courses. 

Available indicates that it is available to all classes for the 
selected course, but is not applied unless selected for specific 
classes.

Default indicates that it is applied when classes for that course 
are created. You can manually remove the constraint from 
classes.

Mandatory indicates that it is automatically applied to all classes 
for that course and it cannot be removed.

Name Shows the name of the constraint.

Description Shows the definition of the constraint. 
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before Chemistry Lab 11 begins”. An identical rule is to “always schedule Chemistry Lab 11 to 
begin in a period immediately after Chemistry 11 ends”.

You can also set up course balancing rules so that academic courses are not all scheduled in 
one semester and electives in the other. By default, based on semester (not full year) 
courses, Student Loader or Walk-in Scheduler tries to schedule an equal number of courses 
in each semester. This schedule is based on all course requests and not within each course.

Rule parameters like Always Schedule and Never Schedule are “hard” rules, while 
parameters like Try to Schedule and Try Not to Schedule are “soft” rules. The Student Loader 
will follow hard rules and not schedule a student unless the hard rules are met. The Student 
Loader will try to follow soft rules, but create a student schedule, even if the soft rules cannot 
be met.

To define class loading rules:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 4, click Class 
Loading Rules.

OR

If you are using the active calendar, on the Scheduling page, under Step 3, click Class 
Loading Rules.

The Class Loading Rules page displays any rules you have created, including the type and 
description of each rule.
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5 To add a scheduling rule, from the Actions menu, click Add Rule.

OR

To edit a scheduling rule, click the rule you want to modify.

6 On the Add or Edit Class Loading Rule page, specify the scheduling rule type and the rule 
parameters.

NOTE

Once you have created a rule, you cannot change the rule type.

Rule Type Description

Course Sequencing Rule Use to schedule class sequences, such as when one class must or 
must not follow another. For more information about setting up 
course sequencing rules, see “Defining Course Sequencing Rules” 
on page 214.

For example, use this type of rule to schedule a science lab right 
after the science class, or to make sure different language 
classes, such as Spanish and French, do not follow each other.

Same/Different Attributes 
Rule

Use to schedule classes with the same or different teachers, 
terms, periods, rooms, class numbers, or meeting patterns 
across terms. For more information about setting up 
same/different attribute rules, see “Defining Same/Different 
Attribute Rules” on page 215.

For example, use this type of rule to schedule several classes 
with the same teacher, or to make sure different classes meet in 
the same room.
Configuring Student Loading Rules 213
Setting Up Class Loading Rules



Chancery SMS Scheduling Guide
Defining Course Sequencing Rules
Use course sequencing rules to tell the Master Schedule Builder how to sequence specific 
courses, such as when you want to ensure that a specific course does or does not follow 
another course. For example, a course sequencing rule might be: “Never schedule Spanish to 
begin in a period immediately after French ends”.

To help you understand the rule as you define it, the description is immediately displayed 
below the rule parameters.

To create a course sequencing rule:
1 Log on as a school administrator.

2 Open the Add Class Loading Rules page. 

For more information about opening the Add Class Loading Rules page, see “Setting Up 
Class Loading Rules” on page 211.

3 For Rule Type, select Course Sequencing Rule.

Course Balancing Rule Use to schedule students so that classes of a particular group are 
spread across terms on their schedules. For more information 
about setting up course balancing rules, see “Defining Course 
Load Balancing Rules” on page 217.

For example, use this type of rule to ensure that students with 
requests from a list of difficult academic courses do not have all 
the difficult courses scheduled in one semester.

Rule Type Description

Rule description

Rule parameters
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4 In the first dropdown, select how the course should be scheduled. The following options 
are available:

• Always schedule

• Never schedule

• Try to schedule

• Try not to schedule

5 Click the first Select Course link. Search for and select the first course you want to 
sequence. Click OK.

6 From the second dropdown, select one of the following options:

• To begin in a term

• To end in a term

• To begin in a period

• To end in a period

7 From the third dropdown, select one of the following options

• Anytime before

• Anytime after

• Immediately before

• Immediately after

8 Click the second Select Course link and search for and select the second course for the 
sequencing rule. Click OK. 

9 From the fourth dropdown, select the relationship to the second course. The following 
options are available:

• Begins

• Ends

10 To save the rule and add another rule, click Save+Add.

OR

To save and exit the page, click OK.

Defining Same/Different Attribute Rules
Use same/different attribute rules to tell the Master Schedule Builder how to schedule 
courses with the same or different teachers, terms, periods, rooms, class numbers, or 
meeting patterns across terms. You might use this rule type to schedule several classes with 
the same teacher or to ensure different classes are scheduled for the same room. For 
example, a same/different attribute rule might be: “Always schedule Government and 
Economics with exactly the same class number”.

To help you understand the rule as you define it, the description is immediately displayed 
below the rule parameters.
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To create a same/different attribute rule:
1 Log on as a school administrator.

2 Open the Add Class Loading Rules page. 

For more information about opening the Add Class Loading Rules page, see “Setting Up 
Class Loading Rules” on page 211.

3 For Rule Type, select Same/Different Attribute Rule.

4 From the first dropdown, select how the courses should be scheduled. The following 
options are available:

• Always schedule

• Never schedule

• Try to schedule

• Try not to schedule

5 Click the Select Courses link. 

6 Search for and select the courses you want to specify the rule for. Click OK.

7 From the second dropdown, select one of the following options:

• With exactly the same

• With some of the same

• With all different

• With some different

Rule description

Rule parameters
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8 From the third dropdown, select the attribute. The following options are available

• Term

• Period

• Teacher

• Class number

• Meeting pattern across terms

9 To save the rule and add another rule, click Save+Add.

OR

To save and exit the page, click OK.

Defining Course Load Balancing Rules
Use course load balancing rules to tell the Master Schedule Builder how to balance scheduling 
loads across terms to prevent students from having all the courses with heavy loads in one 
term. For example, a course load balancing rule might be: “Try to schedule all courses to 
ensure that the difference in scheduling load between terms does not exceed 0.5”.

To help you understand the rule as you define it, the description is immediately displayed 
below the rule parameters.

To create a course balancing rule:
1 Log on as a school administrator.

2 Open the Add Class Loading Rules page. 

For more information about opening the Add Class Loading Rules page, see “Setting Up 
Class Loading Rules” on page 211.

3 For Rule Type, select Course Balancing Rule.

Rule description

Rule parameters
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4 From the dropdown, select how the courses should be scheduled. The following options 
are available:

• Always schedule

• Never schedule

• Try to schedule

• Try not to schedule

5 Click the Select Courses link. 

6 Search for and select the courses you want to specify the rule for. Click OK.

OR

Select All Courses.

7 In the second field, enter the scheduling load.

8 To save the rule and add another rule, click Save+Add.

OR

To save and exit the page, click OK.

Setting Up Team Loading Rules
If your school schedules students in teams that take the same classes with the same 
teachers, you can set up team loading rules so the Student Loader or Walk-in Scheduler 
knows which students to keep together. By specifying which teams can or cannot overlap 
with which other teams, you can control which students take which classes together. When 
you set up team loading rules, use “allow overlap” and “do not allow overlap” to control 
which students take the same classes (overlapping) and which students take separate 
classes (no overlapping). For an example of how overlapping can be used, see “Example of 
Using Overlapping in Scheduling Teams” on page 219.

Setting up class teams involves the following general steps:

1 Define the teams. For more information about defining teams, see “Setting Up Teams” on 
page 220.

2 Assign teams to classes. For more information about assigning teams to classes, see 
“Assigning Teams to Classes” on page 221.

3 Use the Student Loader to load student schedules. For more information about loading 
student schedules, see “Loading Student Schedules” on page 307.

The Student Loader loads student schedules according to the rules defined for the teams. 
For example, if you specify that the Cougars team cannot overlap with the Panthers 
team, a student scheduled into the Cougars’ math class is not also scheduled for the 
Panthers’ English class.

OR

Manually load and lock students into team classes to ensure a student is assigned a 
specific team. For more information about manually loading students into classes, see 
“Manually Adding, Dropping, or Transferring Classes” on page 329 and “Locking Classes 
in Student Schedules” on page 344.
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NOTE

Team loading rules are part of student loading rules. Do not confuse team loading rules with elementary 
school team teaching or assigning more than one teacher to a class. For information about team 
teaching in elementary schools, see “Working with Team Teaching” on page 83.

Example of Using Overlapping in Scheduling Teams
This example illustrates how you might set up team teaching to control how students are 
scheduled into classes. Let’s say you set up the following teams:

Now, let’s say you have the following core and elective classes, each belonging to a team:

When Billy and Susie walk into your school with their course requests for the above courses, 
you can manually schedule Billy into a class in the Cougars team (such as English 9-1) and 
Susie into a class in the Lions team (such as English 9-2.) The Student Loader follows the 
above rules and creates a schedule for Billy and Susie like the following example.

As a result, Billy and Susie take separate classes for English and Math because the Cougars 
team and the Lions team cannot overlap. They would take the same Photography 9-1 and 
Band 9-1 class because these classes can overlap with both the Cougars team and the Lions 
team.

Team name Do not allow overlap with teams Comment

Cougars Lions, Tigers, Panthers

The four basic teams, which do 
not overlap with each other

Lions Cougars, Tigers, Panthers

Tigers Cougars, Lions, Panthers

Panthers Cougars, Lions, Tigers

Yellow Cats Tigers, Panthers
Combined teams

Jungle Cats Cougars, Lions

Class (Team) Class (Team)

English 9-1 (Cougars) Math 9-1 (Cougars)

English 9-2 (Lions) Math 9-2 (Lions)

English 9-3 (Tigers) Math 9-3 (Tigers)

English 9-4 (Panthers) Math 9-4 (Panthers)

Photography 9-1 (Yellow Cats, which can only 
overlap with Cougars and Lions)

Band 9-1 (Yellow Cats, which can only overlap 
with Cougars and Lions)

Photography 9-2 (Jungle Cats, which can only 
overlap with Tigers and Panthers)

Band 9-2 (Jungle Cats, which can only overlap 
with Tigers and Panthers)

Billy in Cougars team Susie in Lions team

English 9-1 (Cougars) English 9-2 (Lions)

Math 9-1 (Cougars) Math 9-2 (Lions)

Photography 9-1 (Yellow Cats) Photography 9-1 (Yellow Cats)

Band 9-1 (Yellow Cats) Band 9-1 (Yellow Cats)
Configuring Student Loading Rules 219
Setting Up Team Loading Rules



Chancery SMS Scheduling Guide
Setting Up Teams

To set up teams:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 4, click Team 
Loading Rules.

OR

If you are using the active calendar, on the Scheduling page, under Step 3, click Team 
Loading Rules.

The Teams page opens.

5 To add a team, from the Actions menu, click Add Team.

OR

To edit a team, select the team you want to modify then, from the Actions menu, click 
Edit Team.

6 On the Add Team or Edit Team page, enter the following information:

Field Description

Team Name Enter a name for the team. 

The team name appears in the Team dropdown in the Master 
Schedule page when a class is selected.

Code Enter a code for this team. Use meaningful short codes so they 
are clear when displayed on other pages.

Allow Overlap With Teams By default, new teams can overlap with existing teams.

For example, if you already have teams named Blue, Red, and 
Green, adding a Yellow team allows classes in the Yellow team to 
overlap with the existing teams, by default.

If you do not want a team to overlap with another, click the team 
name then click  to move it to the “Do not allow overlap with 
teams” list.
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7 Click OK.

To delete a team in team loading rules:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 4, click Team 
Loading Rules.

OR

If you are using the active calendar, on the Scheduling page, under Step 3, click Team 
Loading Rules.

5 Select the team you want to delete. From the Actions menu, click Delete Team.

6 Click OK.

Assigning Teams to Classes
Once you create teams and specify the team loading rules, you can assign the teams to 
classes. When a team is assigned to a class, the Student Loader and Walk-in Scheduler follow 
the team loading rules when they create student schedules. 

To assign classes to teams:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

Do Not Allow Overlap With 
Teams

Classes in the team cannot overlap with classes in these teams.

For example, if you have a Blue team that is not allowed to 
overlap with the Yellow team, when Master Schedule Builder 
creates a schedule, students assigned to a class for the Blue 
team are not also scheduled for classes assigned to the Yellow 
team. 

Team Members Use the Search section to search for staff to add to the team as 
members. Add all staff members who can be assigned to teach 
classes assigned to the team. 

When the Student Loader or Walk-In Scheduler creates a 
student’s schedule, it will attempt to schedule the student into 
classes taught by the team members for the team the student is 
assigned to. For example, if the student is assigned to the Green 
team for Math, the Student Loader will attempt to schedule the 
student into an English class taught by a teacher who is a team 
member of the Green team. 

Field Description
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4 If you are using a planning calendar, on the Scheduling page, under Step 5, click Master 
Schedule.

OR

If you are using the active calendar, on the Scheduling page, under Step 6, click Master 
Schedule.

5 On the Master Schedule page, search for a course or click Display All Records.

6 In the search results, select the class that you want to add to a team. 

Detailed information about the selected class is displayed below the search results panel.

7 In the Class Information panel, from the Team dropdown, select the team you want to 
assign to the class. Click Save. 

Assigning Specific Students to Teams
In general, you can set up team loading rules and allow the Student Loader to allocate 
students to teams automatically. For more information about automatically loading student 
schedules, see “Loading Student Schedules” on page 307. 

However, if you want to ensure that specific students are assigned to certain teams, you can 
manually assign the student to a class for that team and lock the student in that class. Once 
the student has been locked into a class for a specific team, automated processes, such as 
the student loader, will only assign them to classes for that team. For more information about 
manually assigning student to classes, see the following topics:

• “Manually Adding, Dropping, or Transferring Classes” on page 329

• “Assigning Groups of Students to Classes” on page 354

• “Locking Classes in Student Schedules” on page 344

NOTE

When you manually assign students to classes, you can assign them to team classes, regardless of the 
team loading rules that have been set up. 
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for Courses
Use the Course Offerings page to define the terms and meeting patterns for the courses your 
school offers. In the planning calendar, you can have different course offerings for different 
planning schedules. Therefore, be sure you are working in the correct planning schedule 
when you set up course offerings.

NOTE

Only offered courses appear on the Course Request Tally page.

1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

4 If you are using the active calendar, on the Scheduling page, under Step 4, click “Course 
Offerings & Meeting Patterns”.

OR

If you are using a planning calendar, on the Scheduling page, under Step 5, click “Course 
Offerings & Meeting Patterns”.

5 On the Course List page, locate and click the course number you want to work with. In 
the control bar, click Course Offerings.

To see available meeting 
patterns, click in a row. Do not 
click a link

When you click the row for a 
scheduling group, the meeting 
patterns available to that 
scheduling group are shown.
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6 On the Course Offerings page, under Offerings, select the term sets in which the course is 
offered.

The Offerings panel shows the following information:

Field Description

Scheduling Group Shows the scheduling groups defined on the Scheduling Groups 
page for this active or planning schedule. Click a scheduling 
group to go to the Scheduling Groups page.

For more information, see “Defining Scheduling Groups” on 
page 171.

Term Set Shows the scheduling term sets defined on the Term Sets page 
for this active or planning schedule. Click a term set to go to the 
Term Sets page.

For more information, see “Setting Up Scheduling Term Sets” on 
page 173.

Default Offering Shows the default scheduling group and term set to be used by 
the create classes process. All classes that are automatically 
created are assigned to this scheduling group, and distributed 
between the terms of this term set.

Allowed Offering In addition to the default offering, you can specify other terms 
available for students to request. For example, if you want to 
allow students to request one semester of a full year course, you 
can assign the full year term as the default offering and 
semesters as another allowed offering. When you enter student 
course requests, you can specify the full year term for students 
who want to take the full course, or a single semester for 
students you want to take part of the course, for example, if they 
need to switch periods. For more information, see “Allowing Term 
Overrides for Courses” on page 227.

NOTE
Only assign classes to the default offering. Assigning classes to multiple 
offerings may create grading errors. 

When you select a Default Offering, this column is automatically 
selected.

Meeting Patterns Shows the number of meeting patterns selected for this course.

To select meeting patterns for a scheduling group/term set, 
select its row then, in the Meeting Patterns section, select 
meeting patterns in the Available Patterns list and move them to 
the Selected patterns list. Repeat for each scheduling 
group/term set.

The Selected patterns list shows the meeting patterns for the 
highlighted row. The Meeting Patterns column updates when you 
click Save or Reset.
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7 On the Course Offerings page, under Meeting Patterns, select the meeting patterns 
available for the course and move them to the Selected Patterns list. 

8 Click Save.

Copying Course Offerings to Other Courses
When you are setting up courses, you can use the Copy link to copy course information to 
other courses. Then for the other courses, you only need to change the fields that are 
different. 

NOTE

You can only copy courses in the planning calendar.

To copy course offerings to other courses:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 5, click Course Offerings & Meeting Patterns.

4 On the Course List page, click the course number of the course you want to copy course 
offerings from. 

5 On the Course Offerings page, make sure the course offerings and meeting patterns are 
set up correctly. 

The course can only be scheduled 
into meeting patterns that are 
included in the Selected Patterns 
list on this page.
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6 Click Copy.

7 On the Copy page, under Fields to Copy, select Course Offerings and Meeting Patterns. 
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8 Under Courses to Copy, search for the course you want to copy the course offerings and 
meeting pattern to and move them to the Selected Courses List. Click OK. 

Allowing Term Overrides for Courses
If you want to allow students to be scheduled into single semesters of a full year course, you 
can set up the course to allow term overrides by assigning additional course offerings. For 
example, if you want to allow students to request one semester of a full year course, you can 
assign the full year term as the default offering and semesters as another allowed offering. 
When you enter student course requests, you can specify the full year term for students who 
want to take the full course or a single semester for students you want to take part of the 
course; for example, if they need to switch periods. 

For more information about entering course requests, see “Working with Course and 
Alternate Requests” on page 247.

NOTE

Only assign classes to the default offering. Assigning classes to multiple offerings may create grading 
errors. 

To set up a course to allow term overrides:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.
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4 If you are using the active calendar, on the Scheduling page, under Step 4, click “Course 
Offerings & Meeting Patterns”.

OR

If you are using a planning calendar, on the Scheduling page, under Step 5, click “Course 
Offerings & Meeting Patterns”.

5 On the Course List page, locate and click the course number you want to work with. In 
the control bar, click Course Offerings.

6 On the Course Offerings page, under Meeting Patterns, select the meeting patterns 
available for the course and move them to the Selected Patterns list. 

7 On the Course Offerings page, under Offerings, select the default offering for the full year 
term set. Under Meeting Patterns, move the allowed meeting patterns to the Selected 
Meeting Patterns list.

To see available meeting 
patterns, click in a row. Do 
not click a link.

When you click the row for 
a scheduling group, the 
meeting patterns available 
to that scheduling groups 
are shown.
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8 For the Semesters term set, select Allowed Offering. Under Meeting Patterns, move the 
allowed meeting patterns to the Selected Meeting Patterns list.

9 Click Save.
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Working with Student Search Results
The Student Search Results page offers several short cuts when scheduling multiple students 
at once. From a list of students, you can select multiple students and quickly assign a 
homeroom, class, or course requests. You can also quickly open a student’s schedule from 
the Student Search Results page. 

Searching for Student Records
There are several ways to search for students in Chancery SMS:

At the top of the Quick Search page or at the top of any search results page (Quick, Basic, 
Detailed, or Saved List):

Using the List dropdown, you can filter your Quick Search, Basic Search, and Detailed Search 
results to show three types of students:

In addition, you can save your search results to Saved Lists for future use.

To Use this search type

Choose from a Basic or Detail search. Student Search

View a pre-defined group of students, such as all students in a school 
or all students in a grade level. You can also search by name or 
student ID.

Quick Search

Search by additional demographic information, such as Phone, 
Birthdate, Age, and Grade.

Basic Search

Customize your search criteria by using advanced search parameters. Detailed Search

To Do this

Search by a student’s exact 
student number

• Enter the number in the “Last Name or ID” field.

Search for students whose last 
names start with the entered 
value, such as “Smi”

• Enter the fragment in the “Last Name or ID” field.

Search for students whose first 
or preferred names start with the 
entered value, such as “Jen”

• Enter the fragment in the “First or Preferred Name” field.

Student type Definition

Active Students who are currently enrolled in a school. They have an 
entry-type status code at a school, indicating they enrolled either 
in the past or today, and have not since withdrawn.

Incoming Students who have an entry-type or re-entry-type status code in 
the future.

Withdrawn Students who have a withdrawn-type status code at a school in 
the past or today, and have not since re-enrolled.
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Performing a Student Search
The Student Search features a Basic search and a Detail search. Use the Basic search to 
search by common student demographic fields. Use the Detail search to search by fields 
within categories, such as Personal or Enrollment.

NOTE

Any student-related custom data fields added to Chancery SMS are accessible in the Detail search.

To search for students using the Basic search:
1 Log on as a school administrator. 

2 In the control bar, under Student, click Student Search.

3 On the Basic tab, use one of the following search options:

4 Click Search.

Search Option Description

Search by Enter up to three search constraints. Enter a field, an operator, 
and a value. Choose from common student demographics fields, 
such as:

• Age (current)

• Birthdate

• Ethnic Category

• First Name

• First or preferred name

• Last Name

• Gender

• Geocode (Active)

• Geocode (Planning)

• Grade Level (current)

• Home School (current)

• Normal Program

• Phone (numbers only)

• Phone (with formatting)

• Special Program

• Track

• Phone

• SSN or PIN

• Student Number

• Student saved lists

Display all records Rather than search for specific students, you can display all 
students.

NOTE
Chancery SMS can display up to 1000 records. If there are more than 1000 
records in the search results, you will need to narrow your search criteria.

List Choose from previously-used search criteria. For example, if you 
recently searched for students whose first name is Colin, that 
search criteria is saved to this list.
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To search for students using the Detail search:
1 Log on as a school administrator. 

2 In the control bar, under Student, click Student Search.

3 On the Detail tab, from the Category dropdown, select a category such as Enrollment, 
Personal, Scheduling, or Registration.

4 Use one of the following search options:

5 Click Search.

Performing a Quick Search
Under Quick Search, click a link to view all students, students in a specific grade, recently 
enrolled students (within the past 30 days), or students withdrawn this year. In addition, use 
the “Last Name or ID” or the “First or Preferred Name” fields at the top of the Quick Search 
page to search for a specific student.

To find a student using a Quick Search:
1 Log on as a school administrator. 

2 In the control bar, under Student, click Quick.

Search Option Description

Search by 1 Enter your search criteria. Enter a field, an operator, and a 
value. 

2 Click Add Criteria. To narrow the search result, add additional 
criteria.

3 Indicate whether to match all criteria or match any criteria.

Display all records Rather than search for specific students, you can display all 
students.

NOTE
Chancery SMS can display up to 1000 records. If there are more than 1000 
records in the search results, you will need to narrow your search criteria.

List Choose from previously-used search criteria. For example, if you 
recently searched for students whose first name is Colin, that 
search criteria is saved to this list.

ValueField Operator
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3 On the Quick Search page, in the “Last Name or ID” field or the “First or Preferred Name” 
field, enter the student’s ID number, last name, or first name, or partial values of any of 
these.

OR

Do one of the following:

The Search Results page displays a list of possible matches. If there are many students, 
you may need to scroll or click the Prev/Next paging controls to find the student you’re 
looking for.

4 To open a student record, click the student’s name.

Performing a Basic Search
A basic search is a precise way of finding students. For example, if you enter a student’s 
name and phone number, you’ll narrow your search results.

You don’t have to use all the search fields. Records are found that meet all the criteria you 
enter while fields you leave blank are ignored. For example, if you enter a last name and a 
phone number, the results include only students who have both the last name and the phone 
number you specified.

If you’re not sure of the correct spelling of a student name, enter the first few letters. The 
results include names beginning with those letters. Use either upper or lower case letters. 
For example, searching for “lancaster” finds “Lancaster”. Enter spaces exactly. For example, 
searching for “delos santos” does not find “de los santos”.

To Do this

View all students in your 
school (depending on your 
access level – office staff 
typically are set up to access 
all students)

• Click All Students.

View students assigned to 
your classes (depending on 
your access level – teachers 
typically are set up to only 
access students assigned to 
classes they teach)

• Click My Students.

View all students in a 
selected grade

• Click a grade level.

View one of the following 
pre-defined searches:

• Recently Enrolled Students

• Withdrawn Students This 
Year

• In the Pre-Defined Searches panel, click a pre-defined search.

View a user-defined list of 
students

• In the Saved List panel, click a saved list.

View only active students • From the Edit menu, click Hide Incoming Students and Hide 
Withdrawn Students.
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To find a student using a Basic Search:
1 Log on as a school administrator. 

2 In the control bar, under Student, click Basic.

3 On the Basic Search page, enter your search criteria:

NOTE

Depending on your access privileges, some options might not be available.

4 Click Search to display your search results.

The Search Results page displays a list of possible matches. If there are many students, 
you can scroll or click the Prev/Next paging controls to find the student you’re looking for.

If you’re not satisfied with your search results, click  to open the Search Criteria panel, 
modify your search criteria then click Search.

5 To view only active students, from the Edit menu, select Hide Incoming Students and 
Hide Withdrawn Students.

6 To open a student record, click the student’s name.

Performing a Detailed Search
A detailed search is a good way to find a range of students who match a variety of criteria 
that you set.

In a detailed search, each of the criteria has three parts:

• a field name

• an operator

• a value

The following criteria finds students whose last name begins with “Sm” and would find Smith, 
Smythe, Small, and so on:

Field Description

Student Name Search for all students with the same Last Name or all students 
with the same First or Preferred Name. If you’re unsure of the 
spelling, enter the first two or three letters.

Student ID Enter a complete Student ID.

Alternate Student # Enter an alternate number derived from a numbering system 
that might be set up at your district.

SSN/SIN Enter the student’s Social Security Number or Social Insurance 
Number.

Phone Enter the student’s home phone number.

Current grade Select a specific grade level.

Geocode (Active) Enter the student’s geographical region code for the current year.

Geocode (Planning) Enter the student’s geographical region code for the coming year.

Birthdate Enter a birthdate in mm/dd/yyyy format.

Age/as of Enter a specific age and the date at which the age was 
calculated.
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• Field Name = Last Name

• Operator = Starts with

• Value = Sm

Add the following criteria to find Grade 5 students AND whose last name begins with Sm:

• Field Name = Grade Level (current)

• Operator = Is

• Value = 5

To reduce the number of students who match, add a criteria and select “All criteria”.

The following criteria finds all the students who are in Grade 5 OR Grade 6:

• Field Name = Grade Level (current)

• Operator = Is

• Value = 5; repeat for Value = 6

Field name Operator Value

To narrow the list of students, select “All Criteria”.
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By searching for any criteria, you increase the number of students who match the criteria.

To perform a Detailed Search:
1 Log on as a school administrator. 

2 In the control bar, under Student, click Detailed.

3 From the Category dropdown, select the type of data you want to search for. Choose 
from:

• Most Frequent

• Personal

• Tennessee (only Tennessee customers see this option)

• Student Contacts

• Registration

• Enrollment

• Scheduling

NOTE

If custom pages have been added to Chancery SMS using cTools (previously known as Custom Data 
Management [Student Pages]), you can also select the names of the basic tables, multi-select lists, 
chronological groups, and repeating groups.

4 From the left dropdown, select a field name.

5 From the middle dropdown, select an operator:

To find records where the field Use this operator

Includes the value anywhere in the field Contains

Ends with the value Ends with

Exactly matches the value Is

Is anything but the value Is not

Starts with the value Starts with

Is greater than the value Greater than

Is less than the value Less than

Is greater than or equal to the value > or =

To expand the list of students, select 
“Any Criteria”.
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6 In the right field, enter or select a value from the dropdown.

Enter either upper or lowercase letters. For example, searching for “lancaster” finds 
“Lancaster”. Enter spaces exactly. For example, “delos santos” does not find “de los 
santos”.

NOTE

To include all students in your search results, select the “Last Name” or “First or Preferred Name” 
fields from the left dropdown, select Starts With from the middle dropdown then enter “%” as the 
value in the right dropdown.

7 Click Add Criteria.

8 To add more criteria to your search, repeat steps 4 through 7.

9 Select whether you want your search to match All Criteria or Any Criteria.

NOTE

If you select All Criteria, only records that match every criteria you have added appear. If you select 
Any Criteria, records that match any of the criteria you have added appear.

To remove criteria from the search, highlight the statement and click Remove.

10 Click Search.

The Search Results page displays a list of possible matches. If there are many students, 
you can scroll or click the Prev/Next paging controls to find the student you’re looking for.

If you’re not satisfied with your search results, click  to open the Search Criteria panel, 
modify your search criteria then click Search.

11 To view only active students, from the Edit menu, select Hide Incoming Students and 
Hide Withdrawn Students.

12 To open a student record, click the student’s name.

Is less than or equal to the value < or =

To find records where the field Use this operator
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Customizing How Student Search Results Display
You can customize the columns that display on the Student Search Results page to suit your 
needs.

1 On any Student Search Results page, from the Edit menu, click Choose Columns.

2 On the Choose Columns page, select the columns that best help you with your current 
task.

For example, if you are compiling a list of students whose parents need to be contacted, 
you might select the following columns:

• Name

• Grade

• Homeroom

• Gender

• Student phone number

To set the column display order, select an item then click the up or down arrow.

3 To return to the Student Search Results page, click OK.

4 On the Student Search Results page, from the Edit menu, click Sort.

To display a column, click an item in the 
Available Columns list then click ->.
To remove a column, click the item in 
the Selected Columns list, hen click <-.

To set the column display order, select 
an item then click the up or down 
arrow.
Working with Student Search Results 239
Searching for Student Records



Chancery SMS Scheduling Guide
5 On the Sort page, indicate the sort order. For example, you might want to sort the list of 
students in ascending order by Grade then by Homeroom.

NOTE

You can sort data by columns that are not visible on the screen. For example, you might not want to 
see the Gender column, but you can still sort by that column.

6 Click OK.

Saving Your Search Results
In addition to the pre-defined searches available in Chancery SMS, you can also save your 
custom search results to a saved list for future use. For example, save a list of students who 
require a specific resource service.

A saved list is a static list of students that you update as needed. For example, when more 
students require the resource service, the additional students are not included in the saved 
list until you manually update the saved list to include those students. However, any changes 
you make to a student’s demographic data are updated to the saved list, in real time. For 
example, when you update a student’s grade level, all saved lists that contain that student 
are updated accordingly. 

To save your search results to a list:
1 On any Student Search Results page, select the students you want to save to a list.

2 From the Actions menu, click Save to List.

3 On the Save to List page, select Create New List, and enter an appropriate list name and 
description.

OR

If you want to replace the names in an existing saved list, select Add to Existing List, and 
then select a list from the List Name dropdown.
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NOTE

To append students to an existing saved list, edit the saved list. 

4 Click OK.

To create or edit a Saved List:
1 On the Quick Search page, in the Saved Lists area, click Edit.

2 To create a new saved list, from the Actions menu, click Add Saved List.

OR

To edit an existing saved list, on the Saved List page, click the list name you want to edit.

3 Enter or change the List Name and Description.

4 Enter your search criteria in the Last Name and First Name fields and click Search.

To add the students to a new saved 
list, select Create New List. 

To replace an existing list with the 
selected students, select Add to 
Existing List. 

To edit an existing saved list, on 
the Quick Search page, click Edit.
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5 Identify the list members. Select a student from the Search Results list and click Add.

OR

Select a student from the List Members list and click Remove.

6 Click OK.

To delete a Saved List:
1 On the Quick Search page, under Saved Lists, click Edit.

2 On the Saved List page, select the saved list you want to delete. From the Actions menu, 
click Delete Saved List.

3 Click OK.

Changing Class Assignments for Multiple Students
From a Student Search Results page, you can quickly add or drop classes for multiple 
students. 

NOTE

If the class assignment changes result in any class exceeding their defined capacity, you must have the 
Classes - Exceed Capacity permission set to “Yes” to make the changes. 

To change class assignments for multiple students:
1 Log on as a school administrator. 

2 Perform a basic, quick, or detailed search.

For information about searching for student records, see “Searching for Student Records” 
on page 231.

3 On the Student Search Results page, select the students you want to assign or drop 
classes for.

4 From the Actions menu, click Assign > Classes.

5 If you are working in the active calendar, in Effective Date, select the date you want the 
change to take effect.
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6 If you are working in the active calendar and Change Reasons are set up by your district, 
from the Change Reason dropdown, select the reason the student’s schedule is being 
changed. 

The selected Change Reason applies to all adds, drops, or transfers in the Classes to 
Add/Drop panel when you click Apply.

7 On the Assign Classes page, search for the classes you want to change.

8 In the class search results, select classes and do one of the following:

When you add or remove classes, the selected classes are added to the Add Classes or 
Drop Classes lists. 

9 Click Apply.

To Do this

Add a class to the students’ 
schedules

• Click Add Class.

Remove a class from the 
students’ schedules

• Click Remove Class.

Transfer from one class into 
a different class

1 Select a class to add. Click Add Class. 

2 Select a class to drop. Click Drop Class.

3 Select Transfer.

Change reason and effective date 
applies to all changes made when 
you click Apply.

To remove a class from the Add 
Classes or Drop Classes list, 
select it and click Remove From 
List.

To transfer classes, select the 
class you want to add and the 
class you want to drop then select 
Transfer.
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Assigning Homerooms to Multiple Students
From a Student Search Results page, you can quickly assign or change the homeroom for 
multiple students. You can assign homerooms by assigning a homeroom value, or you can 
transfer students from one homeroom to another. 

To assign a homeroom:
1 Log on as a school administrator. 

2 Perform a basic, quick, or detailed search.

For information about searching for student records, see “Searching for Student Records” 
on page 231.

3 On the Student Search Results page, select the students you want to assign a homeroom.

4 From the Action menu, click Assign Values.

5 On the Assign Values page, from the Assign Field dropdown, select “Homeroom”. From 
the New Value dropdown, select the homeroom you want to assign to the selected 
students. Click Add to List. Click OK.

6 Click OK.

7 If you are working in the active calendar, in the Change Options dialog, specify when you 
want this change to take effect and, if required, select the reason the students’ 
homeroom is being changed. Click OK.

To transfer student homerooms:
1 Log on as a school administrator. 

2 Perform a basic, quick, or detailed search.

For more information, see “Searching for Student Records” on page 231.

3 On the Student Search Results page, select the students you want to transfer to a 
different homeroom.
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4 From the Actions menu, click Transfer Homerooms.

5 On the Transfer Homeroom page, select the homeroom you want to assign to the selected 
students.

6 If you are working in the active calendar, in the Change Options dialog, specify when you 
want this change to take effect and, if required, select the reason the students’ 
homeroom is being changed. Click OK
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Working with Course and Alternate 
Requests
Course requests indicate which courses students would like to take. Automatic scheduling 
processes, such as the Student Loader and the Walk-in Scheduler, attempt to schedule 
students into classes based on their course requests and the system-wide student loader 
options. If the scheduler cannot find a suitable class for the student, it will not schedule the 
student into the requested course. 

When you assign course requests, you can specify the priority for each request to ensure that 
a lower priority course is not scheduled before a higher-priority course. You can also enter 
alternate requests. If the scheduler is not able to schedule the student into all of their 
requested courses, it will attempt to schedule them into alternates.

Entering alternate requests for requested courses allows automatic scheduling processes 
more flexibility for generating student schedules and increases the likelihood that the 
scheduler can create a full schedule for students. If you want to make early runs of the 
Student Loader without using alternates, you can still enter alternates for students and then 
set the Student Loader user Alternates option to “No”. To get more flexibility to schedule the 
more difficult-to-schedule students in later runs, change this option to “Yes”. For more 
information about setting Student Loader options, see “Setting Student Loader Options” on 
page 307.

You can assign course and alternate requests to individual students or to multiple students at 
one time. If you want to assign the same course requests already assigned to another 
student, you can copy the course requests from one student to another. You can also create 
saved lists of students and courses to help you quickly assign course requests.

NOTE

Copying course requests from one student to another also copies the course request settings for priority, 
term, and required/elective status. If a new student requires the same courses with the same settings, 
you can save time re-entering the course request settings by copying course requests. 

Entering Course and Alternate Requests for Individual 
Students
For each student, you can enter courses the student would like to take. When schedules are 
created using the Walk-in Scheduler, Chancery SMS attempts to assign a class for all course 
requests entered for the student. If it is unable to schedule a class for a course, 
Chancery SMS could assign an alternate class if an alternate request is entered for the 
student. 

Assigning Course Requests
1 Log on as a school administrator.

2 Open the student’s schedule. 

For more information, see “Opening Student Schedules” on page 321.
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3 On the Student Schedule page, click the Course Request tab.

4 Do one of the following:

To Do this

Add course requests by 
searching for courses

1 Expand the Course Search Panel.

2 Search for and select the requested course for the student.

3 Click Add Request.

NOTE
You can create a saved list of courses and then search for the saved list. For 
more information, see “Using Saved Lists to Assign Course Requests” on 
page 259.

Add course requests by 
number

1 In Course #, enter the course number for the requested 
course. You can enter multiple course numbers separated by 
commas.

2 Beside Course #, click Add.

NOTE
You can use Notepad to save a list of frequently requested course numbers 
and then copy and paste them into this field. For more information, see 
“Using Notepad to Enter Student Course Requests” on page 251.
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5 In the Requests list, select the course request and enter the following information, as 
required. 

6 Click Save.

Field Description

Term Select the term this course can be used. 

The options include terms specified as offerings for this course. 
For more information about setting course offerings, see 
“Configuring Terms and Meeting Patterns for Courses” on 
page 223.

None indicates the course can be scheduled in any available 
term.

[P] indicates the term is preferred but another term is 
acceptable.

[O] indicates the course can be scheduled in the selected term 
only. 

NOTE
To allow students to request one semester of a full year course, you must set 
up the course to allow term overrides. For more information, see “Allowing 
Term Overrides for Courses” on page 227.

Priority The priority determines which alternate course the Student 
Loader tries to schedule first when a request cannot be 
scheduled.

Enter a priority from 1 (highest) to 9999 (lowest). The default 
priority is 10 so you can give some courses a higher priority 
without having to change all the others. A blank priority is the 
same as 9999.

Courses with the same priority are selected randomly.

Required Specify whether the course is required or an elective.

The default value is set at the district. You can override the 
default for different students.

Required courses have higher priority than electives and are 
scheduled first.

The priority is applied to required courses and electives 
separately.
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Assigning Alternate Requests
If you do not want automated scheduling processes to use alternate requests when initially 
scheduling students, you can assign the alternates and set the student loader options to not 
use alternates. Then when you are ready to schedule student alternate courses, you can set 
the options to use alternates. For more information, see “Setting Student Loader Options” on 
page 307.

To assign alternate requests to students:
1 Log on as a school administrator. 

2 Open the student’s schedule. 

3 On the Student Schedule page, click the Course Request tab.

4 Do one of the following:

To Do this

Add alternate course 
requests by searching for 
courses

1 Expand the Course Search Panel.

2 Search for and select the requested alternate courses for the 
student.

3 Click Add Alternate.

NOTE
You can create a saved list of courses and then search for the saved list. For 
more information, see “Using Saved Lists to Assign Course Requests” on 
page 259.

Add an alternate course 
request by number

1 In Alternate Course #, enter the course number for the 
alternate request. You can enter multiple course numbers 
separated by commas.

2 Beside Alternate Course #, click Add.

NOTE
You can use Notepad to save a list of frequently requested alternate course 
numbers and then copy and paste them into this field. For more information, 
see “Using Notepad to Enter Student Course Requests” on page 251.
250 Working with Course and Alternate Requests
Entering Course and Alternate Requests for Individual Students



Chancery SMS Scheduling Guide
5 In the Alternates list, select the alternate and enter the following information, as 
required. 

6 Click Save.

Using Notepad to Enter Student Course Requests
If specific groups of students generally request the same courses, you can use Microsoft 
Notepad to more efficiently enter student course requests. To do this, create a Notepad file 
and enter comma-delimited lists of the course numbers frequently requested by specific 
groups of students; for example, you might create a list of courses for students in the Grade 
8 standard stream and another list for Grade 8 students in the advanced stream, and so on. 

Field Description

Term Select the term this alternate can be used. 

The options include terms specified as offerings for this course. 
For more information about setting course offerings, see 
“Configuring Terms and Meeting Patterns for Courses” on 
page 223.

None indicates the alternate could be used in any available term.

[P] indicates the term is preferred but another term is 
acceptable.

[O] indicates the alternate can be scheduled in the selected term 
only. 

Priority The priority also determines which alternate course the Student 
Loader tries to schedule first when a request cannot be 
scheduled.

Enter a priority from 1 (highest) to 9999 (lowest). The default 
priority is 10 so you can give some courses a higher priority 
without having to change all the others. A blank priority is the 
same as 9999.

Courses with the same priority are selected randomly.

Alternate For Specify which requested courses this course can be used as an 
alternate. 

You can select Any Required or Any Elective or specify a specific 
course that is included in the student’s course requests. 
Generally, it is better to assign alternates as replacements for 
specific requests. If a specific course is selected, this alternate is 
only used if that course cannot be scheduled.
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To use a Notepad file to enter student course requests:
1 Open a Microsoft Notepad file.

2 In Notepad, enter a comma-delimited list of courses for each group of students that have 
similar requests. Click File > Save and save the file to your desktop or other easy-to-find 
location.

3 With the Notepad file open on your desktop, open Chancery SMS.

4 Log on as a school administrator. 

5 Open a student schedule. 

6 On the Student Schedule page, click the Course Request tab.

7 Press Alt+Tab to switch to the Notepad program. 

8 Select the course list applicable to the student. Press Ctl-C to copy the course list. 

9 Press Alt+Tab to switch to Chancery SMS.

Select the courses you want to 
assign and press Ctrl-c to copy 
the list.
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10 Click the Course # field. Press Ctrl-V to paste the course list into the field. 

11 Click Add.

12 Click Save.

Deleting Course and Alternate Requests for Individual 
Students
1 Log on as a school administrator. 

2 Open the student’s schedule. 

3 In the Course Requests panel, select the course requests or alternate requests you want 
to remove.

4 From the Actions menu, click Delete Course Request or Delete Alternate Request.

Entering Course and Alternate Requests for Multiple 
Students
If you need to assign the same course and alternate requests to multiple students, you can 
assign course requests from any Student Search Results page. 

To change course requests for multiple students:
1 Log on as a school administrator. 

2 Search for a student.

3 On the Student Search Results page, select the students you want to assign the course 
requests.

Press Ctrl-v to 
paste the copied 
course list into the 
Course # field.
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4 From the Actions menu, click Assign > Course Requests. 

5 On the Assign Requests page, search for the courses you want to assign as requests to 
the selected students.

If you created a saved list of courses, you can open the saved list by selecting Course 
Saved Lists in the first dropdown and the name of the saved list in the third dropdown. 
For more information, see “Using Saved Lists to Assign Course Requests” on page 259.

Shows the number of 
students selected.
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6 From the course search results, select courses and do one of the following:

Added or removed courses are shown in the Add Requests, Remove Requests, Add 
Alternates, and Remove Alternates lists.

To Do this

Add a course request to the 
students’ schedules

• Click Add Request.

Remove a course request 
from the students’ schedules

• Click Remove Request.

Add an alternate request to 
the students’ schedules

• Click Add Alternate.

Remove an alternate request 
from the students’ schedules

• Click Remove Alternate.

To remove a course 
from the selected list, 
select the course in 
the list and click 
Remove from List.

Shows courses that 
have been added as 
requests. Scroll down 
to see courses 
removed as requests, 
or added or removed 
as alternates.
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7 In the Priority field, specify the level of importance that the course be scheduled for the 
students. If you are adding more than one request or alternate, the selected priority 
applies to all the courses in the lists.

Enter a priority from 1 (highest) to 999 (lowest). When scheduling students, automated 
processes select courses with the same priority randomly. The priority is applied to 
required courses and electives separately, that is, you can have one set of priorities for 
required courses and another set for electives. The priority also determines which 
alternate course the Student Loader tries to load first.

8 From the Course Is dropdown, select whether the course is required or an elective. If you 
are adding more than one request or alternate, this value applies to all the courses in the 
lists.

“Req/Elec - From Course” indicates that the value specified for the course in the course 
catalog should be used. 

9 To assign other course requests and alternates, repeat steps 4 to 8.

10 Click Apply. 

The selected course requests and alternates are applied to all the selected students. 

Copying Course Requests from One Student to Another
If a student is already assigned the course requests you want to assign to a new student, you 
can copy the course requests from the existing student’s Student Schedule page. When you 
copy course requests from one student to another, the following course request settings are 
also copied:

• required/elective status

• priority

• term and whether the requested term is a preference or required 

NOTE

You cannot copy alternate requests. 

To copy course requests from one student to another:
1 Log on as a school administrator. 

2 Open the student schedule for the existing student. 
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3 Click the Course Requests tab.

4 On the Course Requests panel, select the course requests you want to copy to the new 
student. 

5 From the Edit menu, click Copy Fields > Course Requests.
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6 On the Copy Student Course Requests page, under Fields to Copy, select “Course, 
Required/elective, Priority, Term, Preference/override, Scheduling config”.

7 Under “School Students to Copy To”, search for and select the students you want to copy 
the course requests to and move them to the Selected School Students list. 

8 Click OK.

Enter search criteria to 
search for students.

Use this option to open a 
student saved list.

The search results appear 
in the Available School 
Students list. Select the 
students you want to copy 
the course requests to and 
move them to the Selected 
School Students list. 
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Using Saved Lists to Assign Course Requests
If you want to assign the same course requests to multiple students, you can also create 
saved lists of courses and then assign course requests for those courses to selected students. 
You can even assign the course requests to a saved list of students. 

Creating a Saved List of Courses
1 Log on as a school administrator.

2 In the control bar, click Scheduling. On the Scheduling page, under Step 1, click Course 
Setup. 

OR

In the control bar, click School Setup. On the School Setup page, under School, click 
Courses.

3 On the Course List page, search for and select the courses you want to add to the saved 
lists. 

4 From the Actions menu, click Save to List.

5 To save the courses to a new list, select Create New List and enter a name and 
description for the list.

OR

To add the courses to an existing list, select Add to Existing List and select the list name.

6 Click OK. 
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Creating a Saved List of Students
1 Search for students. 

2 From the Student Search Results, select the students you want to add to the saved list. 

3 From the Actions menu, click Save to List. 

4 To add the students to a new list, select Create New List and enter a name and 
description for the list.

OR

To add the students to an existing list, select Add to Existing List. 

5 Click OK. 

Assigning Course Requests for a Saved List of Courses
Once you create a saved list of courses, you can retrieve the course saved list from any 
Course Search page and then assign those courses as you would any course. When you 
retrieve a course saved list, you can work with the individual courses in the list; for example, 
you do not need to assign all the courses in the list as requests for one student. 

The following procedure illustrates how you might use a course saved list along with a 
student saved list to assign course requests to specific students. 
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To assign courses from a saved list as requests to students in a saved list:
1 Log on as a school administrator. 

2 Search for the students you want to assign the course requests to.

To open a student saved list, in the control bar, click Student Search. In the first Search 
By dropdown, select School Student Saved List, and, in the third Search By dropdown, 
select the name of the saved list. Click Search.

3 From the Student Search Results, select the students you want to assign the course 
requests to.
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4 From the Actions menu, click Assign>Course Requests.

5 On the Assign Requests page, from the first Search By field, select Course Saved List. In 
the third Search By field, select the name of the course saved list. Click Search.
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6 From the course search results, select courses and do one of the following:

Added or removed courses are shown in the Add Requests, Remove Requests, Add 
Alternates, and Remove Alternates lists.

7 In the Priority field, specify the level of importance that the course be scheduled for the 
students. If you are adding more than one request or alternate, the selected priority 
applies to all the courses in the lists.

Enter a priority from 1 (highest) to 999 (lowest). When scheduling students, automated 
processes select courses with the same priority randomly. The priority is applied to 
required courses and electives separately, that is, you can have one set of priorities for 
required courses and another set for electives. The priority also determines which 
alternate course the Student Loader tries to load first.

8 From the Course Is dropdown, specify whether the course is required or an elective. If 
you are adding more than one request or alternate, this value applies to all the courses in 
the lists.

“Req/Elec - From Course” indicates that the value specified for the course in the course 
catalog should be used. 

9 To assign other course requests and alternates, repeat Steps 4 to 8.

10 Click Apply. 

The selected course requests and alternates are applied to all the selected students. 

To Do this

Add a course request to the 
students’ schedules

• Click Add Request.

Remove a course request 
from the students’ schedules

• Click Remove Request.

Add an alternate request to 
the students’ schedules

• Click Add Alternate.

Remove an alternate request 
from the students’ schedules

• Click Remove Alternate.
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Creating the School Master Schedule
After you set up a planning schedule with a scheduling structure and course offerings, you 
can start to build a master schedule. Each planning schedule has its own master schedule so 
you can see which scheduling scenario is best for your school. For more information about 
setting up a planning schedule, see “Using Planning Schedules” on page 165. 

In the process of building a master schedule, you may go through a few iterations to analyze 
and adjust student requests, class scheduling parameters, and teacher allocations. When you 
are satisfied with student requests, class schedules, and teacher allocations, you can load 
students into your school master schedule.

Defining Class Scheduling Options
Class scheduling options determine how Master Schedule Builder creates and schedules 
classes and how it loads teachers into schedules.

During the teacher allocation process, Master Schedule Builder takes into account teacher 
course preferences and other constraints. For teachers who have equal preferences, Master 
Schedule Builder allocates teachers in a “card-dealing” method, starting with the teacher 
with the fewest classes. If teachers have the same number of classes, teachers are allocated 
randomly and not alphabetically.

To define class scheduling options in a planning schedule:
1 Log on as a school administrator. 

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling. 

4 On the Scheduling page, from the Planning Schedule dropdown, choose the planning 
schedule you want to work with.

The column to the right of the links summarizes what is set up for this planning schedule.

If you copied scheduling elements when you created the planning schedule, you can 
modify the scheduling elements you copied.
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5 On the Scheduling page, under Step 6, click Class Scheduling Options.

The Class Scheduling Options page opens.

6 On the Class Scheduling Options page, enter the following information:

Field Description

Name Based On Select whether the class name is based on the Course Name, 
Short Name, Alternate Name, or Course Number.

Number Increment Enter the number to be incremented for each new class that is 
created, from 1 to 100.

Style Choose the format used to display class names:

• name-number (using dash)

• name(number) (using parentheses)

• name[number] (using brackets)

• name{number} (using braces)
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7 Click OK.

Analyzing Student Course Requests 
Before you can analyze course requests, you must enter course requests for students. For 
more information about entering student course requests, see “Working with Course and 
Alternate Requests” on page 247.

Teacher Over-Allocation 
Percentage

Specify a percentage from 0 to 100. The default is 0%, which 
means that Master Schedule Builder never over allocates 
teachers.

This percentage gives the scheduling algorithm the flexibility to 
shift the load beyond the teacher allocation by this percentage. A 
teacher’s individual teaching load will never exceed its 
maximum.

Depending on how high this percentage is set, a teacher might 
get more classes in one course and fewer classes in another 
course. For example, at 20%, a teacher with five classes might 
get one additional class (20% x 5 = 1). At 10%, a teacher with 
ten classes might get another class. At 34%, a teacher with six 
classes might get two additional classes.

For information about setting the base teacher allocations, see 
“Scheduling Teachers” on page 276.

Weighted Options for the 
Schedule Classes process

Use weighted options to set which factor has priority when 
building schedules.

Move weighted options so they are in order of priority. Master 
Schedule Builder schedules according to the order of the 
weighted options.

By default, the Master Schedule Builder uses the following order 
of priority:

• Minimize potential student conflicts

• Use teacher course allocations

• Use course room preferences

• Use teacher room preferences

Minimize potential student 
conflicts

Classes are scheduled according to the conflict matrix to avoid 
schedule conflicts. 

If this option is moved to a higher priority than other options, 
student schedules have fewer conflicts, at the expense of teacher 
and room allocations.

Use teacher course 
allocations

Teachers are scheduled according to the settings in the Teacher 
Allocations page. 

If this option is not selected then teachers are allocated based 
only on their course preferences.

Use course room preferences Classes are scheduled according to the room preferences set for 
courses. 

Use teacher room 
preferences

Classes are scheduled according to the room preferences set for 
teachers. 

Field Description
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After you set up a scheduling structure for your planning schedule, specify which courses are 
offered, and enter student requests for the coming year, you can analyze course requests to 
locate potential scheduling conflicts and fine tune the classes you need.

The Course Request Tally is a powerful tool to analyze and adjust student course requests. 
Use this page to:

• Work with specific courses or work with all courses. You can only work with offered 
courses. For information about offering courses, see “Configuring Terms and Meeting 
Patterns for Courses” on page 223.

• View and adjust the list of students with primary and alternate requests for courses.

• View and adjust the optimal, minimum, and maximum class size for each course.

• Search for courses with a user-defined number of potential conflicts.

• Generate a conflict matrix for selected courses or for all courses.

• Determine the number of classes you need for each course, with the option to override 
the calculated value.

• Create the classes needed for each course.

Using the Course Request Tally
Use the Course Request Tally to analyze primary and alternate course requests, adjust class 
sizes, search for courses with potential conflicts, and generate the conflict matrix.

The following illustration provides an example of the number of primary and alternate course 
requests that can and cannot be scheduled, and shows which numbers Chancery SMS 
displays on the Course Request Tally. These numbers are filled in progressively as you do 
your scheduling. For more information about scheduling students, see “Loading Student 
Schedules” on page 307.

If there is a total of 100 requests for a course, where 80 are primary requests and 20 are 
alternate requests, the Course Request Tally page displays the number of primary and 
alternate requests. If the Student Loader can schedule 60 of the 80 primary requests, the 
course request tally shows the 20 primary requests that cannot be scheduled in the 
Unscheduled Primary column. If the Student Loader can schedule 10 of the 20 alternate 
requests, this page shows the 10 alternate requests that can be scheduled in the Alts Used 
column.

The circled numbers are displayed on the Course Requests Tally page.
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When working with the Course Request Tally, the numbers in the Unscheduled Primary 
column are the problems you need to resolve. 

The numbers in the Alts Used column are also of interest. Click the number to see the list of 
students whose primary request was not scheduled where an alternate request had to be 
used.

To analyze course requests and adjust class size:
1 Log on as a school administrator. 

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling. 

4 On the Scheduling page, from the Planning Schedule dropdown, choose the planning 
schedule you want to work with, and then, under Step 6, click Course Request Tally.

Click the number in the 
Unscheduled Primary 
column to see which 
students have a 
primary request for 
that course that is not 
scheduled. Then, try to 
give these students the 
course they requested.
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5 On the Course Request Tally page, search for the courses you want to work with. 

The Course Request Tally page includes all offered courses. For information about 
courses, see “Setting Up Courses” on page 140.

6 Review the number of primary and alternate requests for courses, and adjust the class 
size for each course, if necessary.

Field Description

Course Name and Course # To view the Course Detail page in the course catalog, click the 
Course Name. From the Course Detail page, you can also view 
the Course Scheduling and Course Offerings pages.

Prim Reqs The number of times this course appears as a primary request 
for a student.

To see the students with primary requests for this course, click 
the number in the Prim Reqs column. To view a student’s 
schedule, click the student name.

Alt Reqs The number of times this course appears as an alternate request 
for a student.

To see the students with alternate requests for this course, click 
the number in the Alt Reqs column. To view a student’s schedule, 
click the student name.

Unsched Primary The number of times the Student Loader could not schedule a 
primary request for this course.

To see the students with primary requests for this course that are 
not scheduled, click the number in the Unsched Primary column. 
To view a student’s schedule, click the student name.

The goal is to reduce the numbers in this column, which indicates 
that all students’ primary requests are scheduled.
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Alts Used The number of times the Student Loader scheduled this course 
as an alternate for another course. That is, another course was 
not able to meet the scheduling request and this course was 
used to meet the request.

To see the students that have an alternate used for this course, 
click the number in the Alts Used column. To view a student’s 
schedule, click the student name.

The goal is to reduce the numbers in this column, which indicates 
that students have their primary requests rather than alternate 
requests.

% Prim Reqs Sched The percentage of primary requests scheduled out of the total 
number of primary requests.

This column is not displayed by default. To display this column, 
from the Edit menu, click Choose columns.
Note
This value is blank until after student schedules are loaded. For more 
information about loading student schedules, see “Loading Student 
Schedules” on page 307.

% Alt Reqs Sched The percentage of alternate requests scheduled out of the total 
number of alternate requests.

This column is not displayed by default. To display this column, 
from the Edit menu, click Choose columns.
Note
This value is blank until after student schedules are loaded. For more 
information about loading student schedules, see “Loading Student 
Schedules” on page 307.

Min Size

Max Size

Opt Size

The Minimum and Maximum class size columns are not displayed 
by default. To display these columns, from the Edit menu, click 
Choose columns and select these fields.

If you copied the Course scheduling information from another 
planning schedule, these fields are the same as in the copied 
planning schedule. Otherwise, these fields are copied from the 
school course catalog.

You can change the class size numbers on this page by entering 
a different number. Changes to these fields only affect this 
planning schedule. These fields are not changed in other 
planning schedules or in the school course catalog.

Avg Size Average Class Size = primary requests / actual number of 
classes created.

If the average class size is below the minimum size for this 
course, this number is displayed in bold black with an alert icon. 
If the average class size is over the maximum, this number is in 
bold red with an alert icon.

Field Description
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7 Use Edit menu commands to help you work on the Course Tally page.

8 To save your changes, click Save.

Using the Conflict Matrix
At this stage in the scheduling process, the conflict matrix shows potential conflicts based 
on student requests and not on actual classes. Potential conflicts may not turn into real 
conflicts. You can always manually schedule students to avoid conflicts. The conflict matrix 
also shows if a student has requested the same course more than once, which your school 
might not allow. Either way, you can use the conflict matrix to analyze these requests.

You can create a conflict matrix for selected courses so you are not working with all the 
courses at once.

Classes Needed Classes Needed = primary requests / optimal class size (rounded 
up to a whole number).

For example, if you have 55 primary requests and the optimal 
class size is 20, Chancery SMS calculates the classes needed to 
be 3. If you have 65 primary requests, the classes needed would 
be 4. If you override the optimal class size to 22, the number of 
classes needed changes to 3.

If you want to change the number of classes needed, enter a 
different number in this column. Changes to this column affect 
this planning schedule only.

A “~” beside the number indicates that the calculated number 
has been overridden. If this line is not locked, the next time you 
run Calculate Classes Needed, Master Schedule Builder replaces 
this number with the calculated value.

Classes Created The number of classes that have actually been created in the 
master schedule.

Lock Locks the line to prevent any automatic process from changing 
the line. You can manually change locked items.

To Do this

Choose which columns to 
display

1 From the Edit menu, click Choose Columns. 

2 Move the column titles to the Selected Columns list, and click 
OK.

Sort the search results • From the Edit menu, click Sort, specify the sort criteria, and 
click OK.

Copy the minimum, 
maximum, and optimal class 
size, or the number of 
classes needed

• From the Edit menu, click Copy.

Field Description
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To use the conflict matrix:
1 Log on as a school administrator. 

2 Make sure you are using the planning calendar. 

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling.

4 On the Scheduling page, from the Planning Schedule dropdown, select the planning 
schedule you want to work with.

5 Under Step 6, click Course Request Tally.

OR

Under Step 6, click Master Schedule.

6 Search for the course you want to work with. 

For example, to search for all courses that have only one class (singleton courses) and 
courses that have two classes (doubleton courses):

• In the Course Search panel, select the Detail tab.

• From the Category dropdown, select Courses and Classes.

• Search for courses where the # of classes created for a course < 3.

The Search Result panel displays a list of all singleton and doubleton courses. These 
courses are difficult to schedule and are usually done first.

For more information about searching for courses, see “Searching for Courses” on 
page 140.

7 In the Search Results section, select the courses you want to work with.

For example, within the list of singleton and doubleton courses, select those for a specific 
course or teacher.

8 From the Actions menu, click Conflict Matrix.

Use the conflict matrix to check the number of students taking the selected courses. For 
example, if you selected singleton courses, make sure these courses do not meet at the 
same time, otherwise students cannot take more than one of them.

NOTE

The Master Schedule Builder automatically optimizes schedules to avoid conflicts. You can use the 
conflict matrix to pay special attention to these courses in the scheduling results. You might also 
want to manually schedule some of these students.

Field Description

Course Name The names of the courses you selected.

To view the Course Detail page in the course catalog, click the 
Course Name.

Numbered row and column 
headings

The numbered row and column headings correspond to the 
Course Name. For example, row 4 is Band II and corresponds to 
column 4.
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The Conflict Matrix page shows the number of students requesting each of the selected 
courses.

9 To see a list of students requesting both courses, click the link intersecting the two 
courses. For example, click the number on the Art I row under the Band I column to see 
the students requesting both Art I and Band I.

The Student List page shows each student’s request information, including term 
preference and overrides, priority, and whether the course is required or an elective. To 
see a student’s schedule, click the student’s name.

Creating Classes for the Coming School Year
After you have used the Course Request Tally and Conflict Matrix to fine-tune your planning 
schedule, and you are satisfied with student course requests and the number of classes you 
need, you can create classes for the coming school year.

To determine the number of classes needed:
1 Log on as a school administrator.

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling.

4 On the Scheduling page, from the Planning Schedule dropdown, select the planning 
schedule you want to work with, and then, under Step 6, click Course Request Tally.

5 Search for the courses you want to work with. For more information about searching for 
courses, see “Searching for Courses” on page 140.

6 On the Course Request Tally page, check that you are ready to create classes – that is, 
the number of primary and alternate requests, and class sizes for courses are correct – 
and, after running the Student Loader, the number of unscheduled primary requests and 
alternates used is as low as possible. 

Course 
numbers

Numbers that appear in the diagonal 
indicate the number of students who 
requested the same course more than 
once.

Click the number to view the students’ 
names.

The numbers in the grid indicate the 
number of students that requested both 
courses. For example, this 90 indicates 
that ninety students have requested both 
CRD_Chemistry and CRD_Mathematics.
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7 Select the courses then, from the Actions menu, click Calculate Classes Needed.

Classes needed = primary requests / optimal class size.

Selected courses that are not locked are calculated and displayed in the Classes Needed 
column.

To override the number of classes needed, enter a different number. If you override the 
calculated value, click Lock so automated processes do not change it.

For more information about the number of courses needed option, see “Classes Needed” 
in the table on page 272.

8 To save your changes, click Save.

To create classes for courses:
1 Log on as a school administrator.

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling.

4 On the Scheduling page, from the Planning Schedule dropdown, select the planning 
schedule you want to work with, and then, under Step 6, click Course Request Tally.

5 Search for the courses you want to work with. For more information about searching for 
courses, see “Searching for Courses” on page 140.

6 On the Course Request Tally page, check that you are ready to create classes – that is, 
the number of primary and alternate requests, and class sizes and number of classes for 
courses are correct – and the number of unscheduled primary requests and alternates 
used is as low as possible.

7 Select the courses for which you want to create classes then, from the Actions menu, 
click Create Classes.

If classes have already been created for courses that are not locked, this command 
deletes and re-creates their teacher loads and class schedule information. The result is 
displayed in the Classes Created column. Locked courses are not processed.

8 When you are satisfied with the number of classes for a course, click Lock so automated 
processes do not change them.

9 To save your changes, click Save.

Continue to analyze and adjust scheduling results using the course request tally and the 
conflict matrix. Try to minimize unscheduled primary requests and the number of 
alternates. Also, check that class sizes and the number of classes needed are acceptable. 

For more information about using these tools, see “Using the Course Request Tally” on 
page 268 and “Using the Conflict Matrix” on page 272. 

To delete classes for courses:
1 Log on as a school administrator.

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling.
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4 On the Scheduling page, from the Planning Schedule dropdown, select the planning 
schedule you want to work with, and then, under Step 6, click Course Request Tally.

5 Search for the courses you want to work with. For more information about searching for 
courses, see “Searching for Courses” on page 140.

6 Select the course for which you want to delete classes then, from the Actions menu, click 
Remove Classes.

Remove Classes is a manual command, so classes are removed whether the course is 
locked or not.

7 To save your changes, click Save.

Continue to analyze and adjust scheduling results. See “Using the Course Request Tally” 
on page 268 and “Using the Conflict Matrix” on page 272. Try to minimize unscheduled 
primary requests and the number of alternates. Also check that class sizes and the 
number of classes needed are acceptable.

Scheduling Teachers
After you create classes, you can allocate teachers to those classes. You can view allocations 
either by course or by teacher. After you allocate teachers, you can adjust teacher course 
preferences, as well as teacher loads.

You can also create “placeholder” teachers for teachers you expect to start in the next school 
year but who are not yet part of the school staff. Placeholder teachers allow you schedule 
students based on the number of teachers you expect to have available. 

To create placeholder teachers:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are working in the planning calendar, on the scheduling page, from the Planning 
Schedule dropdown, select the planning schedule you want to use.

4 If you are working in the planning calendar, on the Scheduling page, under Step 6, click 
Teacher Allocations. 

OR 

If you are working in the active calendar, on the Scheduling page, under Step 5, click 
Teacher Allocations.

5 On the Teacher Allocations page, from the Actions menu, click Create Placeholder 
teachers. 

6 On the Staff Scheduling Properties page, enter the information required for the 
placeholder teacher. 

For more information about creating placeholder teachers and for descriptions of the 
available fields, see “Creating Placeholders for Scheduling” on page 136.
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Allocating Teachers to Classes 
Use the Teacher Allocations page to allocate and schedule teachers for classes. You can 
allocate teachers “by course” or “by teacher”.

Allocating teachers by course gives you the option of viewing only the courses you’re working 
on. For example, you might want to work on the allocations for your English courses all at 
once without having to look at all the other courses offered at the school. 

Allocating teachers by teacher gives you the option of viewing only the teachers you’re 
working with. For example, you might want to work on allocating teachers in your Math 
department for all of their courses regardless of the departments those courses are from. 

On the Teacher Allocations page, you can search for the course or teacher you want to 
allocate or select Display All Records. The search results are grouped by course name on the 
By Courses tab and by teacher name on the By Teacher tab. 

To allocate teachers to classes:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are working in the planning calendar, on the scheduling page, from the Planning 
Schedule dropdown, select the planning schedule you want to use.

4 If you are working in the planning calendar, on the Scheduling page, under Step 6, click 
Teacher Allocations. 

OR 

If you are working in the active calendar, on the Scheduling page, under Step 5, click 
Teacher Allocations.
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5 On the Teacher Allocations page, click the By Course tab and search for the courses you 
want to allocate or click Display All Records. For more information about searching for 
courses, see “Searching for Courses” on page 140.

OR

On the Teacher Allocations page, click the By Teacher tab and search for the teachers you 
want to allocate courses to or click Display all records.

Summary row 
grouped by course 
name

Teachers eligible to 
teach the course.

Summary row 
grouped by teacher 
name

Courses the teacher 
is eligible to teach.
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The following table describes the fields and headings on the Teacher Allocations page:

Field Description

Total FTE (alloc./sched.) for 
search results

The total FTE value of all teachers or courses in the search 
results. This value includes both allocated and scheduled FTE.

Course name/teacher 
headings

On the By Course tab, search results are grouped by course 
name and number. The course name headings are summary 
rows showing subtotals for scheduling load, classes created, and 
FTE by course. To open the Course Offerings page, click the 
course name.

OR

On the By Teacher tab, search results are grouped by teacher. 
The teacher headings are summary rows showing subtotals for 
scheduling load, classes created, and FTE by course. To open the 
Course Offerings page, click the course name.

Course/Teacher On the By Course tab, lists the teachers eligible to teach the 
courses.

OR

On the By Teacher tab, lists the courses the teacher is eligible to 
teach. 

A teacher is eligible to teach a course when that course is 
specified as a preferred course in the teacher’s scheduling 
preferences. You can change the teacher’s scheduling 
preferences on the Staff Scheduling Properties page. To open the 
Staff Scheduling Properties page, click the teacher name. For 
more information, see “Setting Staff Scheduling Properties” on 
page 132.

Pref. The teacher’s preference for teaching this course, where 1 is the 
highest and 9 is the lowest. Master Schedule Builder does not 
schedule teachers with a preference of 9. Use preference 9 to 
designate teachers as spares that you can manually schedule 
later.

You can change the teacher preference on this page. Changing 
the teacher preference here changes it in the staff record and 
affects all planning schedules.

Sched. Load Factor Displays the scheduling load factor that is assigned at the 
district. For more information about assigning scheduling load 
factors, see “Setting Up Staff for Scheduling” on page 132.
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FTE Alloc (Crs/All) Shows the FTE allocation of each teacher for each course. This 
column has three numbers: one beside each course name and 
two beside each teacher name.

The number beside the course name is the total number of FTEs 
allocated to this course.

The two numbers beside each teacher name apply only to that 
teacher for that course. The number on the left is the FTE 
allocated to that teacher. The number on the right is the sum of 
the FTE for all the courses allocated to that teacher.

FTE allocated = (sum of classes allocated for all terms * course 
scheduling load) / full-time teacher load where:

• the “sum of classes allocated for all terms” is the sum of all 
the #Cls columns. 

• The “course scheduling load” is in the Sched Load Factor 
column. 

• The “full-time teacher load” is the Maximum Scheduling Load 
defined in “Setting Staff Scheduling Properties” on page 132.

The sum of the FTE for all courses is the same whenever this 
teacher’s name appears.

When you change the numbers in the #Cls columns, the 
calculated values in this column change accordingly.

FTE Sched (Crs/All) This column shows the FTE value of all the classes for each 
course that each teacher is scheduled to teach. This column has 
three numbers: one beside each course name and two beside 
each teacher name.

The number beside the course name is the total number of FTEs 
scheduled for that course. 

The two numbers beside each teacher name apply only to that 
teacher for that course. The number on the left is the FTE 
scheduled for that teacher. The number on the right is the sum of 
the FTE for all the courses scheduled for that teacher.

FTE scheduled = (sum of classes scheduled for all terms * course 
scheduling load) / full-time teacher load where:

• the “sum of classes scheduled for all terms” is the sum of all 
the #Cls columns. 

• The “course scheduling load” is in the Sched Load Factor 
column. 

• The “full-time teacher load” is the Maximum Scheduling Load 
defined in “Setting Staff Scheduling Properties” on page 132.

The sum of the FTE for all courses is the same whenever this 
teacher’s name appears.

Field Description
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6 To allocate teachers, from the Actions menu, click Allocate Teachers.

You can also manually allocate teachers to classes by selecting the teacher or course and 
then entering the number of classes in the # Cls columns. 

To use a mixture of automatic and manual teacher allocations, manually enter the 
allocations for some teachers or courses, and then click Lock for those teachers or 
courses. From the Actions menu, click Allocate Teachers to automatically allocate 
teachers for courses that are not locked. 

When you are satisfied with a teacher’s or course’s allocation, click Lock so that Master 
Schedule Builder does not change it.

7 Click Save.

To clear teacher loads:
1 On the Teacher Allocations page, select the By Courses or By Teachers tab. 

2 On the By Courses tab, select the courses you want to remove from teacher loads. 

OR

On the By Teachers tab, select the teachers whose loads you want to clear. 

3 From the Actions menu, click “Clear loads for selected teachers”.

“Clear loads for selected teacher” is a manual command so teacher loads are cleared 
regardless of lock status.

4 Click Save.

# Cls

(one column for each term 
and one for the year)

Shows the number of classes required and allocated for each 
course. The number of columns depend on how many terms you 
defined.

On the By Course tab, the numbers beside each course name 
heading indicate the number of classes allocated/the number of 
classes required. The number beside each teacher name 
indicates the number of classes allocated to that teacher. 

OR

On the By Teacher tab, the number beside each teacher name 
heading indicates the total number of classes allocated to that 
teacher. The number beside each course name indicates the 
number of classes for that course that are allocated to that 
teacher.

You can manually change the number of classes allocated to 
each teacher, or select the course or teacher and select Action > 
Allocate Teachers. When you change the numbers in these 
columns, the numbers in the FTE alloc column change 
accordingly.

Lock Locks the line to prevent any automatic processes from changing 
the line. You can manually change locked items.

Field Description
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Understanding the Master Schedule Page
You can use the Master Schedule page to schedule courses, teachers, or rooms either 
manually or automatically. 

To open the Master Schedule page:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, from the Planning Schedule dropdown, select the 
planning schedule.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

4 If you are using the active calendar, on the Scheduling page, under Step 5, click Master 
Schedule.

OR

If you are using a planning calendar, on the Scheduling page, under Step 6, click Master 
Schedule.

The Master Schedule page opens.
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The following table describes the fields and menu commands on the Master Schedule 
page. Some options are only available in one tab.

Field Description

Heading bar On each tab, classes are sorted based on the selected tab. 

On the By Course tab, the heading bar shows the course name 
and course number. To open the Course Scheduling page, click 
the course name. 

On the By Teachers tab, the summary heading row shows the 
teacher name and their FTEs. The first number in the FTE is the 
sum of the teacher’s scheduled classes divided by the district full-
time teaching load. If the teacher’s teaching load is the same as 
the district default, the second number in the FTE is 1.0. If the 
teacher’s default has been overridden, the second number is the 
overridden teaching load divided by the district full-time teaching 
load. To open the teacher scheduling page, click the teacher 
name.

On the By Room tab, the heading bar shows the room name and 
building name. To view or edit room information, click the room 
name.

Add Class (on By Course tab) Adds a class to the course beside the button. The new class row 
is automatically highlighted so you can use the Class Information 
section to enter the details and schedule of the new class.

Add (on By Teacher tab) Adds selected classes to the teacher beside the button. Clicking 
this button is the same as clicking the teacher name in a class 
schedule on the By Course tab.

Add (on By Room tab) Adds selected classes to the room beside this button. Clicking 
this button is the same as clicking the room number in a class 
schedule on the By Course tab.

Status Indicates whether the class has any conflicts.

This column is blank until you run Master Schedule Builder or 
until you click Save after making manual changes. It is also blank 
if the class has no conflicts.

The class is full – that is, it has reached its capacity. If you 
use overfill then this is capacity + overfill percentage.

The class is overfull – that is, it has exceeded its capacity. If 
you use overfill then this is capacity + overfill percentage.

A teacher conflict for this class – that is, this class is 
scheduled but the teacher is scheduled for another class in 
the same period.

A room conflict for this class – that is, this class is 
scheduled but the room is assigned to another class at the 
same time.

This class is part of a combined set of classes.

Class Name The class and section name of the class. 

To view or edit class information, click the class name. 

Term The term the class is offered. The list of terms displayed for a 
class is controlled by the Course Offerings & Meeting Patterns 
settings for the course.
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Mtg Pat The meeting pattern for the class. The list of meeting patterns 
displayed for a class is controlled by the Course Offerings & 
Meeting Patterns settings for the course. Part of this definition 
includes different meeting patterns for different scheduling 
groups, so if you change the scheduling group for the class, the 
list of meeting patterns changes as well.

Teacher (on By Course and 
By Room tabs)

The teacher scheduled for the class.

Room (on By Course and By 
Teacher tabs)

The room scheduled for the class.

# Students The number of students assigned to the class in the following 
format: <current #> (<high water #>)/<class capacity>

where:

<current #> is the number of students in the class as of the 
current date or the date set in the Changes Effective field (active 
calendar) or the number of students on the first day of classes 
(planning calendar).

<high water #> is the highest number of students that the class 
has from this point in the school year forward.

<class capacity> is the capacity of the class from the class 
schedule data.

For example: 27 (31)/30 indicates that there are currently (or on 
the effective date) 27 students in the class and at one time 
during the year (after the effective date), the class will be (or 
was) at 31 students.

To open the Class Roster page, click the link.

For more information about class rosters, see “Working with 
Homeroom and Class Rosters” on page 349.

Lock Locks the line to prevent any automatic process from changing 
the line. You can manually change locked items.

Class Information section 
(on By Course tab)

This section shows the highlighted class’s name, number, 
capacity, class code, scheduling group, and team.

You can change class information in this section.

Class Constraints section (on 
By Course tab)

This section shows the constraints that are available and applied 
to the class. 

Constraints available, but not applied, to the class are listed in 
the Available Constraints list. Constraints applied to the class are 
shown in the Selected Constraints list. Constraints that are 
mandatory for the class are shown in the Mandatory Constraints 
list. 

You can move constraints between the Available Constraints and 
the Selected Constraints lists. You cannot removed mandatory 
constraints. 

For more information about constraints, see “Setting Up 
Constraints” on page 197.

Field Description
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Creating School Master Schedules
In the active calender, you can use the Master Schedule page to modify class schedules as 
needed throughout the school year.

In the planning calendar, you can create any number of planning schedules. In each planning 
schedule, after you have created classes and allocated teachers to them, you can create the 
master schedule for your school for the coming school year.

You can use the Master Schedule Builder to automatically schedule by course, teacher, or 
room to build a master schedule for your school. You can also build part or all of the schedule 
manually.

NOTE

The checkbox in the Lock column indicates that the automated processes, such as Master Schedule 
Builder or Student Loader, will not change that item. You can make changes manually regardless of the 
lock status.

Automatically Scheduling Classes
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand a Search panel and search for courses, teachers, or rooms. 

5 Select the classes you want to schedule and, from the Actions menu, click Schedule 
Classes. Click OK. 

Master Schedule Builder assigns a meeting pattern, teacher, and room to the selected 
classes based on class scheduling options. For more information about class scheduling 
options, see “Defining Class Scheduling Options” on page 265.

Manually Adding Classes to Courses
You can add classes to courses and assign class information and scheduling settings. If you 
change class scheduling details in a planning calendar after students have been scheduled, 
Chancery SMS displays a warning message that the changes may create scheduling conflicts. 

To manually add classes to courses:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

Class Schedule section (on 
By Course tab)

This section shows the highlighted class’s terms, meeting 
pattern, teachers, and room.

You can change class schedule details in this section. If your 
changes create conflicts, an appropriate message is displayed.

Field Description
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3 On the Master Schedule page, click the By Course tab. 

4 Expand the Course Search panel and search for courses. 

The search results are grouped by course name and number. 

5 In the heading row for a course, click Add Class.

6 Once the class is added for the course, you can select it and edit the class details. 

For more information, see “Editing Class Details” on page 286.

Editing Class Details 
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course tab. 

4 Expand the Course Search panel and search for courses. 

The search results are grouped by course name and number. 
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5 In the Course Search Results, click the row of the class you want to edit, being careful not 
to click a link. When you click in the row for a class, the focus moves to that class. 

The Class Information, Class Constraints, and Class Schedule sections open at the bottom 
of the page. 

To focus on a class and 
display class details, click 
the class row without 
clicking any links.
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6 In the Class Information section, enter the following information, as required:

7 Scroll down to the Class Constraints section and review the constraints for the class. 

Constraints available, but not applied, to the class are listed in the Available Constraints 
list. Constraints applied to the class are shown in the Selected Constraints list. 
Constraints that are mandatory for the class are shown in the Mandatory Constraints list. 

For more information about constraints, see “Setting Up Constraints” on page 197.

8 To change the constraints applied to this class, select the constraint in the Available 
Constraint or Selected Constraints list and move it to the appropriate list. 

Field Description

Name Specify the class name. 

By default, Chancery SMS creates a class name using the course 
name and adding a sequential number for each added class.

Number Specify the class number.

By default, Chancery SMS assigns a sequential number to all 
classes for a course. 

Capacity Enter the maximum number of students that can be assigned to 
this class. 

If class capacity exceeds either the course maximum or the room 
capacity, Chancery SMS displays a warning message. You can 
override the class capacity.

Code Enter a code for the class (optional).

Scheduling Group Select the scheduling group this class is assigned to.

The specified scheduling group determines which meeting 
patterns are available to this class.

Class Comment Enter a comment for the class.

Team Select the team you want to assign this class to. 

For more information about teams, see “Setting Up Team 
Loading Rules” on page 218.

Custom Click this link to see custom fields added to the page. 
288 Creating the School Master Schedule
Creating School Master Schedules



Chancery SMS Scheduling Guide
NOTE

Mandatory constraints cannot be removed from the class.

9 Scroll down to the Class Scheduling section and enter the following information, as 
required:

10 To add another schedule for this class, click Add More Detail. 

NOTE

Tennessee customers only: EIS reporting does not support additional class information entered 
using the Add More Detail option. 

11 Click Save.

Manually Assigning and Removing Classes for Teachers

To assign classes to teachers:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

Field Description

Term Specify the term this class is offered. 

Meeting Pattern Specify a meeting pattern for this class.

The meeting patterns available depend on the scheduling group 
selected in the Class Information section.

Teacher Select the primary teacher assigned to this class.

Other Teacher Select another teacher to assign to this class (optional).

Other Teacher Select another teacher to assign to this class (optional).

Room Select a room where this class is taught. 

Constraints available 
to this course, but 
not applied to this 
class.

Constraints applied to this class.

Select constraints in the Available 
Constraints list or Selected Constraints 
list and click the arrows to move them 
between the lists.

These constraints 
cannot be removed 
from this class.
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3 On the Master Schedule page, click the By Teacher tab. 

4 Expand the Teacher Search panel and search for teachers. 

The search results are grouped by teacher name. 

5 Expand the Class Search tab and search for classes.

6 In the class search results, select the class you want to add to a teacher’s schedule.

7 In the heading row for the teacher you want to add the course to, click Add.

To remove a class from a teacher’s schedule:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Teacher tab. 

4 Expand the Teacher Search panel and search for teachers. 

The search results are grouped by teacher name. 

5 Select the class you want to remove from a teacher’s schedule. From the Actions menu, 
click Remove From Schedule.

Manually Assigning and Removing Classes for Rooms

To assign classes to rooms:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Room tab. 

4 Expand the Room Search panel and search for rooms. 

The search results are grouped by room name. 

5 Expand the Class Search tab and search for classes.

6 In the class search results, select the class you want to assign to a room.

7 In the heading row for the room you want to add the class to, click Add.

To remove a class from a room’s schedule:
1 Log on as a school administrator.

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Room tab. 

4 Expand the Room Search panel and search for rooms. 

The search results are grouped by room name. 
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5 Select the class you want to remove from a room’s schedule. From the Actions menu, 
click Remove From Schedule.

Locking Classes in the Master Schedule
If you want to prevent Master Schedule Builder from changing scheduled classes, you can 
lock the classes. 

To lock a single class:
1 Log on as a school administrator.

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand a search panel and search for courses, teachers, or rooms. 

5 In the search results, in the Lock column, select the checkbox for any classes you want to 
lock. 

To lock all classes:
1 Log on as a school administrator.

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand a search panel and search for courses, teachers, or rooms that have classes you 
want to lock. 

5 From the Actions menu, click Lock All Classes. 

All scheduled classes that were in the search results are locked. 

To unlock all classes:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand a search panel and search for courses, teachers, or rooms that have classes you 
want to lock. 

5 From the Actions menu, click Unlock All Classes. 

All scheduled classes that were in the search results are unlocked. 
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Working With Class Combining 
You can specify that two classes are combined. In a future release, combined classes will 
have a joint roster and attendance page. To combine classes, both classes must have the 
same schedule, that is, they must meet in the same room, be assigned the same teacher, 
and have the same meeting pattern. 

NOTE

Even when classes are combined, the conflict icon still indicates a teacher and room conflict for the 
combined classes. 

To combine classes:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand the Course Search panel and search for courses. 

The search results are grouped by course name and number. 

5 Select two or more classes that have the same class schedules, that is, they are assigned 
the same teacher, room, and meeting pattern.

6 From the Edit menu, click Combine Classes.

7 In the Combine Classes dialog, enter a name for the combined class. 

8 Click OK.

The Combined Class icon ( ) displays in the status column for the combined classes. 
Pause the cursor over this icon to see the name of the combined class.

To change the name of a combined class:
1 Log on as a school administrator.

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand the Course Search panel and search for the course. 

5 In the search results, select a combined course. From the Edit menu, click Edit Class 
Combination.

6 In the Edit Class Combination dialog, enter a new name for the class combination. Click 
OK. 

To uncombine classes:
1 Log on as a school administrator. 

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 
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4 Expand the Course Search panel and search for the course. 

5 In the search results, select a combined course. From the Edit menu, click Uncombine 
Class. Click OK.

The Combined Class icon ( ) is removed from the status column for all classes in the 
combination. 

Copying Class Settings
1 Log on as a school administrator.

2 Open the Master Schedule page.

For more information about opening the Master Schedule page, see “Understanding the 
Master Schedule Page” on page 282.

3 On the Master Schedule page, click the By Course, By Teacher, or By Room tab. 

4 Expand the Course Search panel and search for courses. 

The search results are grouped by course name and number. 

5 In the search results, select the class whose settings you want to copy to other courses. 
From the Edit menu, click Copy Fields. 

• On the Copy To page, under Fields to Copy, select the settings you want to copy to 
other courses. 

Class fields available to be 
copied to other classes.
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6 Under Class to Copy To, search for classes. In the Available Classes list, select the classes 
you want to copy the settings to and use the arrows to move the classes to the Selected 
Classes list. 

7 Click OK.

Creating Lunch Periods
In Chancery SMS, lunch periods are treated as any other class. If your school requires a 
specific arrangement for lunch periods, such as split lunches, you can customize the 
Chancery SMS configuration. The following examples illustrate how you could create lunches 
for the following scenarios:

• “Full Period Lunches - Example” on page 294

• “Four Lunch - Split Period with Length Difference - Example” on page 298

NOTE

These examples are intended to provide ideas of how you might configure lunches for your school. They 
do not encompass all possibilities or methods for creating lunches with Chancery SMS.

Full Period Lunches - Example
The easiest method of assigning lunches is to treat it as a regular full period class. For this 
example, assume that the school lunch period fits within a regular class period. The school 
also contains more students than can be accommodated in the cafeteria at one time, so 
lunch is offered in two periods. 

For this example, assume the school is using the following bell schedule:

To accommodate this bell schedule, create a lunch course and assign it to a meeting pattern 
that meets every day in period 3 or every day in period 4. When you assign the lunch course 
request to all students in the school and generate student schedules, each student is 
assigned a lunch period for either period 3 or period 4.

NOTE

For Tennessee customers only: Make sure lunch minutes are deducted from the student standard day. 
You cannot count lunch as part of the standard day. 

To create a lunch course:
1 Log on as a school administrator.

2 The district administrator must create a lunch course with the following settings and 
assign it to your school:

• Collect attendance = disabled (on Course Detail page)

Period 1 8:30 - 9:25

Period 2 9:30 - 10:25

Period 3/Lunch 10:30 - 11:25

Period 4/Lunch 11:30 - 12:25

Period 5 12:30 - 1:25

Period 6 1:30 - 2:25
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• Course is = required (on Course Detail page)

• Collect grades for this course = disabled (on Course Grading page)

For assistance, contact your district administrator. 

3 At the school, assign a room to the lunch course.

Make sure you assign a room that is large enough to accommodate all the students.

For more information about assigning rooms, see “Assigning Rooms to Courses” on 
page 148.

To set up the lunch meeting patterns:
1 On the Scheduling page, click Meeting Patterns.

2 From the Meeting Patterns for Scheduling Group dropdown, select the scheduling group. 

3 From the Actions menu, click Add Meeting Pattern and add the meeting patterns required 
for classes and lunches as shown in the following table: 

The following figure shows the meeting patterns when the bell schedule includes a 
regular day for each day of the week. 

4 On the Scheduling page, click Course Offerings and Meeting Patterns. 

5 Select the lunch course and, from the Actions menu, select Edit Course Offerings.

6 In the Scheduling Group section, click on the row containing the scheduling group you 
want to work with. The available meeting patterns are listed in the Meeting Patterns 
section. 

Name Short Name
Periods
(for each regular day)

Period 1 1 1

Period 2 2 2

Period 3/Lunch 3L 3

Period 4/Lunch 4L 4

Period 5 5 5

Period 6 6 6
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7 Select the following meeting patterns and move them to Selected Patterns.

• Period 3/Lunch

• Period 4/Lunch

8 Click Save. 

To assign lunch course request to students and create lunch classes:
1 Log on as a school administrator.

2 Search for students and, from the search results, select all students who require lunch.

3 From the Actions menu, select Open Student > Schedule.

4 On the Student Schedule page, click the Course Request tab.

5 In the Course # field, enter the course number for the lunch course and click Add. 

6 In the Course Request list, select the lunch course and, from the Actions menu, click 
Copy Fields > Course Requests.

7 In the Fields to Copy section, select Student Course Requests and, in the School Students 
to Copy to section, select all the students who require lunch and move them to the 
Selected School Students list. Click OK.

To see the available meeting 
patterns, click in a scheduling 
group row without clicking on 
a link. 
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NOTE

When you select the students to copy the course requests to, make sure you do not select the 
student you are copying course requests from, or that student will have duplicate course requests.

8 Click Home. 

9 In the control bar, click Scheduling and then click Course Request Tally. 

10 Locate and select the lunch course.

11 From the Actions menu, click Calculate Classes Needed.

OR

In the Classes Needed field, enter the number of lunch classes required to accommodate 
all the students in the school. Since the school cannot accommodate all the students in 
the cafeteria at one time, specify two lunch classes. 

12 Use the student loader to generate student schedules. 

Each student is assigned a lunch period in either period 3 or period 4.
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Four Lunch - Split Period with Length Difference - Example
This example illustrates a method for configuring split lunches when the lunch period is 30 
minutes and classes are 40 minutes. A lunch course is created and assigned to a meeting 
pattern. Since lunch is a separate course, it has its own roster.

For this example, assume that the school is using the following regular day schedule:

Students can have any one of the following three options for period 5:

To accommodate this schedule in Chancery SMS, you can create a bell schedule that includes 
small blocks of time that can be combined in meeting patterns and assigned to courses to 
allow period 5 to include two 40 minute classes and a 30 minute lunch. 

Before you begin:

• The district administrator must create a lunch course and assign it to your school. The 
lunch course should not collect grades or attendance, and it should be required. 

For assistance, contact your district administrator.

• At the school, assign the cafeteria as the required room for the lunch course. 

For more information about assigning rooms see “Assigning Rooms to Courses” on 
page 148.

To create the bell schedule:
1 Log on as a school administrator. 

2 In the control panel, click Scheduling.

3 On the Scheduling page, click Bell Schedule.

4 From the Scheduling Group dropdown, select the scheduling group. 

Period 1 7:49 - 8:29

Period 2 8:32 - 9:13

Period 3 9:17 - 9:57

Period 4 10:01 - 10:41

Period 5 10:45 - 12:43 (includes two 40 minute classes and one 30 minute 
lunch, which can occur in any order)

Period 6 12:47 - 1:27

Period 7 1:31 - 2:11

Period 8 2:15 - 2:55

Option 1 Option 2 Option 3

Lunch (10-45 - 11:15) Class (10:45 - 11:25) Class (10:45 - 11:25)

Class (11:19 - 11:59) Class (11:29 - 12:09) Lunch (11:29 - 11:59)

Class (12:03 - 12:43) Lunch (12:13 - 12:43) Class (12:03 - 12:43)
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5 From the Actions menu, click Add Period and enter information about the period. Repeat 
this step to create all the periods listed in the following table:

6 Click Copy To Other Days and copy the bell schedule to all the regular days in the 
schedule. Click OK.

7 On the Bell Schedule page, click OK.

To create the meeting patterns:
1 On the Scheduling page, click Meeting Patterns.

2 In the Meeting Patterns for Scheduling Group dropdown, select the scheduling group. 

3 From the Actions menu, click Add Meeting Pattern and enter the meeting patterns 
required for classes in periods 1 to 4 and 6 to 9 then enter the following meeting patterns 
for period 5:

NOTE

When entering meeting pattern information, short periods may not be visible on the meeting 
pattern matrix. To show all periods, from the Actions menu, click Zoom to Maximum.

Start time End Time Period Name Label

7:49 8:29 Period 1 P1

8:32 9:13 Period 2 P2

9:17 9:57 Period 3 P3

10:01 10:41 Period 4 P4

10:45 11:15 Period 5 - Module 1 M1

11:15 11:19 Period 5 - Module 2 M2

11:19 11:25 Period 5 - Module 3 M3

11:25 11:29 Period 5 - Module 4 M4

11:29 11:59 Period 5 - Module 5 M5

11:59 12:03 Period 5 - Module 6 M6

12:03 12:09 Period 5 - Module 7 M7

12:09 12:13 Period 5 - Module 8 M8

12:13 12:43 Period 5 - Module 9 M9

12:47 1:27 Period 6 P6

1:31 2:11 Period 7 P7

2:15 2:55 Period 8 P8

Name Short Name
Periods
(for each regular day)

Period 5a Class 5aC M1, M2, M3

Period 5a Lunch 5aL M1

Period 5b Class (following 5aC) 5bC1 M5, M6, M7

Period 5b Class (following 5aL) 5bC2 M3, M4, M5

Period 5b Lunch 5bL M5

Period 5c Class 5cC M7, M8, M9
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The following figure shows the meeting patterns when the bell schedule includes a 
regular day for each day of the week. 

4 On the Scheduling page, click Course Offerings and Meeting Patterns. 

5 Select the lunch class and, from the Actions menu, select Edit Course Offerings.

6 In the Scheduling Group section, click on the row containing the scheduling group you 
want to work with. The available meeting patterns are listed in the Meeting Patterns 
section. 

7 Select the following meeting patterns and move them to Selected Patterns:

• Period 5a Lunch

• Period 5b Lunch

Period 5c Lunch 5cL M9

Name Short Name
Periods
(for each regular day)
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• Period 5c Lunch

8 Click Save. 

To add lunch to student schedules:
1 Log on as a school administrator.

2 Search for students who require lunch and, from the search results, select all students 
you want to assign a lunch.

3 From the Actions menu, select Open Student > Schedule.

4 On the Student Schedule page, click the Course Request tab.

5 In the Course # field, enter the course number for the lunch course and click Add. 

6 In the Course Request list, select the lunch course, and then from the Actions menu, click 
Copy Fields > Course Requests.

7 In the Fields to Copy section, select Student Course Requests and, in the School Students 
to Copy to section, select all the students who require lunch and move them to the 
Selected School Students list. Click OK.

To see the available 
meeting patterns, 
click in a scheduling 
group row without 
clicking on a link. 
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NOTE

When you select the students to copy the course requests to, make sure you do not select the 
student you are copying course requests from, or that student will have duplicate course requests.

8 Click Home. 

9 In the Control bar, click Scheduling.

10 On the Scheduling page, click Load Students.

11 On the Load Students page, search for and select the students whose schedules you want 
to load, and then from the Actions menu, click Load Students.

12 Click OK.

Creating and Scheduling Study Hall Periods
You can assign study halls by creating a study hall course and assigning as many study hall 
requests as are required to fill the students’ schedules. You can also create multiple study 
hall courses; for example, you can create separate study hall classes for grade 9, grade 10, 
and grade 11 students. 

If meeting patterns don’t overlap and empty periods always coincide with a class schedule, 
you can assign existing class meeting patterns to study halls. However, if class meeting 
patterns overlap, students could have an empty period anywhere in their schedule. In that 
case, you need to create separate meeting patterns for study halls to accommodate all 
possible empty periods. When you plan your study hall meeting patterns, consider all the 
possibilities for an empty period to occur in student schedules and create a meeting pattern 
for every possibility.
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Tips:

• To ensure that a study hall is not scheduled in place of required courses, either set the 
study hall as “elective” and the required courses as “required” or set the priority for study 
hall classes to be less than the priority for required classes. 

• If you are scheduling study halls using the Walk-in Scheduler or Student Loader, you can 
lock classes already scheduled to prevent the Student Loader from changing the classes 
that are already set. You can only lock classes for individual students. 

Setting Up Study Halls to Replace Empty Periods - Example
Filling a student’s empty periods with study halls involves three overall steps:

• Create a study hall class. For more information, see “Step 1: Create a Study Hall Class” 
on page 303.

• Create and assign meeting patterns to study halls. For more information, see “Step 2: 
Create and Assign Study Hall Meeting Patterns” on page 304.

• Assign the study hall to students. For more information, see “Step 3: Assign Study Hall 
Classes To Students” on page 304.

Step 1: Create a Study Hall Class
1 The district administrator must create a study hall course with the following settings and 

assign it to your school:

Course Detail page:

• Course number = any suitable course number, e.g., 2000

• Course name = any suitable name, e.g., Study Hall

• Course short name = any suitable short name, e.g., SH

• Course subject area = any subject area, e.g., NA

• Course type = any suitable course type, e.g., Non-academic

• Course is = study hall

Course Scheduling page:

• Scheduling load = suitable load, e.g., 0.5 for a single semester course or 1.0 for a full 
year course.

• Maximum students = if creating a free-form study hall, allow a large group. The 
maximum number allowed is 999.

• Minimum students = enter a low number to allow any number of students to be 
assigned the study hall, e.g., 1.

• Optimal students = 20

Course Grading page:

• Grading does not apply to study hall courses.

2 At the school, if you are using Master Schedule Builder to assign rooms to classes, set up 
study hall rooms.

3 Create meeting patterns for every study hall meeting arrangement. You need a meeting 
pattern for every possible study hall scenario
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Step 2: Create and Assign Study Hall Meeting Patterns
You need to assign a meeting pattern for each time slot in which the study hall is offered. If 
empty periods always coincide with class meeting patterns, you can assign the same meeting 
pattern to study halls as other classes. If an empty period could occur anywhere in a 
student’s schedule and does not always match class meeting patterns, you can create 
meeting patterns specifically for study halls. 

To assign class meeting patterns to study halls:
1 Log on as a school administrator.

2 On the Scheduling page, click Course Offerings and Meeting Patterns. 

3 Select the study hall class and, from the Actions menu, select Edit Course Offerings.

4 In the Scheduling Group section, click on the row containing the scheduling group you 
want to work with. The available meeting patterns are listed in the Meeting Patterns 
section. 

5 Select all the study hall meeting patterns and move them to Select Patterns. Click OK. 

To create study hall meeting patterns and assign them to study halls:
1 Log on as a school administrator.

2 On the Scheduling page, click Meeting Patterns.

3 From the Meeting Patterns for Scheduling Group dropdown, select the scheduling group. 

4 From the Actions menu, click Add Meeting Pattern and enter the required meeting 
patterns. For example, create a meeting pattern for every period in every day. 

5 On the Scheduling page, click Course Offerings and Meeting Patterns. 

6 Select the study hall class and, from the Actions menu, select Edit Course Offerings.

7 In the Scheduling Group section, click on the row containing the scheduling group you 
want to work with. The available meeting patterns are listed in the Meeting Patterns 
section. 

8 Select all the study hall meeting patterns and move them to Select Patterns. Click OK. 

Step 3: Assign Study Hall Classes To Students
If you want to fill the empty periods of a student’s schedule with study halls, load the 
student’s required and elective course requests first. When you are happy with the student’s 
schedule, add enough course requests to fill in their schedule, and load students again. For 
information about determining the number of study hall classes required to fill a student’s 
schedule, see “Determining the Number of Study Hall Classes Required” on page 305.

To assign study hall classes to students:
1 Log on as a school administrator.

2 Open a student record.

3 In the control bar, click Schedule.

4 Enter course # for as many study hall courses as required to fill the student’s schedule. 

5 If you are working in the active calendar, set the date you want the changes to take 
effect.

6 Click New Schedule.

The student’s schedule is generated and empty periods are filled with study halls.
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Determining the Number of Study Hall Classes Required
You can use the Scheduled Load or Filled Scheduling Load fields to determine the number of 
study halls required to fill a student’s schedule. 

The Scheduled Load and Filled Scheduling Load fields show the sum of the scheduling load 
values for all the courses in the student’s current schedule. If the value is less than a full 
load, you can add study halls to fill the student’s schedule. For example, if a full course load 
is “8” and the study hall is assigned a scheduling load of “1” then any students who have a 
filled scheduling load of “7” require one study hall to fill their schedule. 

You can check the Filled Scheduling Load value for individual students on the Student 
Scheduling page or you can sort students by Scheduled Load on the Student Loader page. 
From the Student Loader page, you can also save a list of students that require the same 
number of study halls to fill their schedules and then assign the study hall requests to all the 
students in the saved list at one time. 

To display the filled scheduling load for individual students:
1 Log on as a school administrator.

2 Open a student record.

3 In the control bar, click Schedule.

The student’s schedule shows the student’s filled scheduling load.

To sort students by scheduled load:
1 Log on as a school administrator. 

2 In the control bar, click Scheduling. 

3 On the Scheduling page, click Load Students.

4 Search for student records.

OR

Click Display All Records.

Shows the student’s 
filled scheduling load.
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5 Click Scheduled Load to sort students by their filled scheduling load. 

Click the 
heading 
to sort 
the 
column 
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Loading Student Schedules
After you have scheduled courses, teachers, and rooms into the master schedule for your 
school, you can define Student Loader options and use the Student Loader to automatically 
load student schedules.

If constraints are applied to a class, the constraints are taken into consideration when 
students are scheduled using automated schedule processes such as the Student Loader. If 
you manually assign students to classes and the student does not fit the criteria, 
Chancery SMS displays an error message. If you have permission to override constraints, 
you can assign students to classes even if they do not fit the constraint criteria. For more 
information about constraints, see “Setting Up Constraints” on page 197.

Before you can use the Student Loader to create student schedules, make sure all student 
course requests are entered. For more information about entering student course requests, 
see “Working with Course and Alternate Requests” on page 247.

NOTE

In the active calendar, you cannot use the Student Loader to generate student schedules if grades or 
attendance have already been collected, or if a future-dated transfer has been entered for any student 
in any class. If the Student Loader is unavailable for creating student schedules, you can still create 
student schedules on the Student Schedule page. For more information about using the Student 
Schedule page, see “Working with Student Schedules” on page 321.

Setting Student Loader Options
Student loader options are used by both the Student Loader and the Walk-in Scheduler. You 
can set the Student Loader options in either the planning or active calendar. However, once 
you enter student grades or attendance, you cannot run the Student Loader. You can 
continue to use the Walk-in Scheduler. 

To set Student Loader options:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 If you are using the planning calendar, on the Scheduling page, from the Planning 
Schedule dropdown, choose the planning schedule you want to work with.

The messages to the right of the links summarize what is set up for this planning 
schedule.

4 If you are using a planning calendar, on the Scheduling page, under Step 7, click Student 
Loader Options.

OR

If you are using an active calendar, on the Scheduling page, under Step 8, click Student 
Loader Options.
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The Student Loader Options page opens.

5 On the Student Loader Options page, enter the following information:

Field Description

Class Overfill % Specify a percentage between 0 and 100.

Allows the class capacity to be exceeded by this percentage.

You can use this option temporarily in a test run of the Student 
Loader to see where the “spikes” are, which shows you which 
courses need extra classes.

You can also use this setting to allow extra room in classes.

If a Student Has More Than 
n Unscheduled Requests, Do 
Not Schedule At All

Specify a number between 1 and 99.

If the Student Loader is unable to find a schedule for a student 
that falls within this limit, it leaves the student completely 
unscheduled.

Adjusting this number allows you to minimize the number of 
students left with partial schedules after a run of the Student 
Loader.

Attempt to Re-schedule 
Students to Avoid Conflicts 
Caused by Full Classes

This option tries to make room in full classes by shuffling 
students.

The Student Loader tries to re-schedule students with a lower 
scheduling difficulty in order to schedule students who are more 
difficult to schedule.

For an example of using this option, see “Example: Attempting to 
Re-Schedule Students to Avoid Conflicts From Full Classes” on 
page 310.
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Attempt to Schedule an 
Equal Number of Students to 
Each Class Choice for Each 
Course

When classes reach 50% of their average class size, the Student 
Loader progressively opens the unused 50% to keep classes as 
level as possible.

NOTE
Selecting this option does not guarantee that each class will have an equal 
number of students. The numbers of students assigned to each class is also 
affected by class capacities. In addition, conflicts in the Master Schedule 
could prevent an equal distribution of students across the specified classes. 
For additional information about balancing class sizes, see the Chancery SMS 
Master Scheduling Best Practices Guide. 

Use Alternates Schedules a student’s alternate course requests to find a 
schedule.

You might want to make early runs of the Student Loader 
without using alternates. Then turn this option on in later runs to 
get more flexibility to schedule students who are more difficult.

Weighted Options Use weighted options to specify which factor has priority when 
loading students.

Move weighted options so they are in order of priority. The 
Student Loader schedules according to the order of the selected 
weighted options.

By default, the following weighted options are selected in the 
following order: 

1 Load balancing rules

2 Class sequencing rules

3 Class attribute rules

4 Term preferences

Use capacity balancing constraints and use restriction constraints 
are not selected by default. 

Use capacity balancing 
constraints

This option instructs the Student Loader to consider the capacity 
balancing constraints that have been assigned to classes when 
creating student schedules. 

For more information about capacity balancing constraints, see 
“Creating and Editing Capacity Balancing Constraints” on 
page 202.

Use class load balancing 
rules

This option instructs the Student Loader to try to find a schedule 
that balances the student’s classes covered by class load 
balancing rules between terms.

For more information about class load balancing rules, see 
“Defining Course Load Balancing Rules” on page 217.

Use class sequencing rules This option instructs the Student Loader to try to find a schedule 
that sequences classes between terms or periods for the 
student’s classes covered by class sequencing rules.

For more information about class sequencing rules, see “Defining 
Course Sequencing Rules” on page 214.

Field Description
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6 Click OK.

Example: Attempting to Re-Schedule Students to Avoid Conflicts 
From Full Classes 
The Algebra class in period 1 is full, while the Algebra class in period 2 is not full. English AP 
is a singleton course that meets only in period 2. Joe is requesting both Algebra and English 
AP, but he cannot get both courses because the only Algebra class that has room is also in 
period 2.

If you selected the “Attempt to re-schedule students to avoid conflicts caused by full classes” 
option, the Student Loader unschedules one of the students – let’s say Adam – in the period 
1 Algebra class who is easier to schedule, and schedules Joe into the period 1 Algebra class 
and the period 2 English AP class.

The Student Loader then rebuilds Adam’s schedule, unscheduling and re-scheduling his 
classes until Adam gets all his course requests.

Using this option results in more students getting all their course requests. If you do not use 
this option, Joe would not be able to take both Algebra and English AP.

When you load students, because you are only loading the students you select, this option 
only affects selected students. As always, the Student Loader does not change locked 
students.

Using the Student Loader to Create Student Schedules
The Student Loader automatically generates student schedules based on student course 
requests, student loader options, and applied class constraints. For more information about 
entering course requests, see “Working with Course and Alternate Requests” on page 247. If 
you want to manually assign classes to students, you can assign classes to individual 
students from the Student Schedule page or you can assign classes to multiple students from 
the Class Roster page or Student Search page. 

• For information about assigning classes from student schedules, see “Manually Adding, 
Dropping, or Transferring Classes” on page 329. 

Use class attribute rules This option instructs the Student Loader to try to find a schedule 
that has classes with the same or different attributes in any of 
the student’s classes covered by class attribute rules.

For more information about class attribute rules, see “Defining 
Same/Different Attribute Rules” on page 215.

Use restriction constraints This option instructs the Student Loader to consider the 
restriction constraints that have been assigned to classes when 
creating student schedules. 

For more information about restriction constraints, see “Creating 
and Editing Restriction Constraints” on page 198.

Use term preferences This option instructs the Student Loader to consider the term 
preferences that might have been entered for a student’s course 
requests when finding a schedule for a student.

Field Description
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• For information about assigning classes from a class roster, see “Adding Groups of 
Students to Other Classes” on page 353 and “Assigning Groups of Students to Classes” 
on page 354. 

• For information about assigning classes from student search results, see “Changing Class 
Assignments for Multiple Students” on page 242.

NOTE

In the active calendar, you cannot use the Student Loader to generate student schedules if grades or 
attendance have already been collected, or if a future-dated transfer has been entered for any student 
in any class. If the Student Loader is unavailable for creating student schedules, you can still create 
student schedules on the Student Schedule page. For more information about using the Student 
Schedule page, see “Working with Student Schedules” on page 321.

To use Student Loader to generate student schedules:
1 Log on as a school administrator.

2 Make sure you are using the planning calendar.

For information about switching to a planning calendar, see “Switching to the School 
Planning Calendar” on page 9.

3 In the control bar, under Admin, click Scheduling.

4 On the Scheduling page, from the Planning Schedule dropdown, select the planning 
schedule you want to work with.

5 On the Scheduling page, under Step 7, click Load Students.

The Load Students page opens.
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6 On the Load Students page, search for the students you want to work with. For more 
information about searching for students, see “Working With Student Records” on 
page 10.

You can use the Student Search section on this page to search for:

• students with requests but no schedules (e.g., new students)

• students whose requests or schedules have been changed

• students that have been affected by master schedule changes (e.g., if a class was 
moved)

• students by Seat Count value

7 Select the students you want to load then, from the Actions menu, click Load Students.

8 If necessary, adjust Student Loader options, and load students again.

9 Repeat Steps 6 to 8 to continue loading students. When you’re done, click OK.

Field Description

List The working lists of your recent searches.

Name, Grade, Homeroom, 
and Age

Basic student information. Use Edit > Choose Columns to select 
the fields you want to view.

Requested Load The sum of the scheduling load of all the student’s primary 
course requests.

Scheduled Load The sum of the scheduling load of classes on the student’s 
schedule.

Student Seat Count A weighting number for students who are counted as having a 
value greater than 1 in the class. For example, special needs 
students who require more of the teacher’s time might have a 
seat count value of 1.5 or 2. 
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Setting Up Resource Services (active 
calendar only)
NOTE

This step is only available in the active calendar.

In addition to regular courses, you can set up resource services. For example, you can set up 
resource services for Remedial Reading and Math, Speech Therapy, Gifted and Talented 
Enrichment, and so on.

Resource services are typically taught by a resource teacher (who often moves between 
several schools). The resource service is usually taught in a small group or on an individual 
basis, either in a “pull-out” format where students are moved to another room for the class, 
or in an “inclusion” format where students are taught the resource service in the regular 
classroom.

You do not have to create classes for resource services. You can specify when each student 
receives a service, and whether it is given in an inclusion or in a pull-out format.

NOTE

For Tennessee customers only: Resource services are not displayed on the District Setup > Schools > 
Classes page. As a result, resource services are not reported to EIS. To include special education classes 
in EIS reports, do not set up special education classes as resource services. Create a subject and 
schedule a class, as you would with regular classes.

Creating Resource Services
You can set up resource services only in the active calendar.

To create a resource service:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling.

3 On the Scheduling page, under Step 7, click Resource Services.

4 On the Resource Services page, do one of the following:

To Do this

Add a resource service • From the Actions menu, click Add Resource Service.

Edit a resource service • Click the name of the resource service you want to change.

OR

To change multiple resource services, select the resource 
services you want to change. From the Actions menu, click Edit 
Selected Resource Services.

Delete a resource service You cannot delete a resource service if it has been assigned to a 
student, even if the resource assignment has ended. Before 
deleting a resource service, you must delete all record of 
assignments of that resource service. 

1 Select the resource service you want to delete. 

2 From the Actions menu, click Delete Resource Service. 

3 To confirm, click OK. 
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If you add or edit a resource service, the Add Resource Service or Edit Resource Service 
page opens.

5 On the Add Resource Service page, enter the necessary information.

6 Click OK.

Assigning Resource Services to Students
You can only assign resource services in the active calendar.

After resource services are set up, you can schedule students to receive the resource service. 
For more information about setting up resource services, see “Creating Resource Services” 
on page 313.

You can also schedule resource services for individual students from the Student Schedule 
page. For more information, see “Adding and Deleting Resource Assignments” on page 345.

To schedule resource assignments:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 7, click Resource Roster.

Field Description

Resource Service Name Enter a resource service name, such as Reading Recovery.

Short Name Enter a short name.

Service Number Enter the resource service number.

Related Subject Select a subject or subject element.

Default Teacher If necessary, select the default teacher for this resource service.
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4 On the Resource Roster page, from the View dropdown, select one of the following 
options:

• a specific resource service

• a specific resource assignment

• all resource assignments

To display students who have received resource services in the past or are scheduled to 
receive resource services in the future, but who are not currently receiving resource 
services, from the Edit menu, click Show Incoming Students or Show Past Students.

5 Do one of the following:

When you add or edit a resource assignment, the Add Resource Assignment or Edit 
Resource Assignment page opens.

To Do this

Add a resource assignment • From the Actions menu, click Add Resource Assignment.

Edit a resource assignment • Click the name of the resource assignment you want to edit.

OR

Select the resource assignment you want to edit. From the 
Actions menu, click Edit Resources Assignment.

Delete a resource 
assignment

1 Select the resource assignment you want to delete. 

2 From the Actions menu, click Delete Resource Assignment. 

3 Click OK and skip the remaining steps.
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6 On the Add Resource Assignment or Edit Resource Assignment page, enter or edit the 
necessary information.

7 Click OK.

To keep track of resource assignment changes, or to copy the same resource information 
to multiple students, see “Tracking Resource Assignment Changes” on page 316.

Tracking Resource Assignment Changes
The schedule of a student’s resource assignments might change during the school year. For 
example, the amount of time they receive the resource service might increase from  
120 minutes to 180 minutes each week beginning on November 1. You might need to track 
both the old and new schedules. You can change the student’s resource assignment end date 
to October 31, duplicate the resource assignment, and change its start date to November 1 
and its minutes per week to 180.

When several students take the same resource service together, duplicate the resource 
assignment and change the student information.

To duplicate a resource assignment:
1 Log on as a school administrator.

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 6, click Resource Roster.

Field Description

Student Name Click Select Student to search for and select a student.

Resource Service Select a resource service. After you save this record, this field 
becomes view-only.

Related Subject Shows any related subjects defined for the resource service.

Comment Enter a comment of up to 500 characters, such as the reason the 
student is in this resource service.

Start and End date Enter the dates that the resource assignment will start and end.

If a student’s resource schedule changes during the year, you can 
duplicate the student’s resource assignment and change the 
scheduling information. 

Instructional Model Select whether this resource service is taught in the regular 
classroom, or if it is taught in another room. If it is taught in a 
different room, specify the room.

Teacher Select up to three teachers for the resource assignment.

Minutes Per Week Enter the number of minutes this student receives this resource 
service each week.

Meeting Times Enter the time that the student and teacher will meet for the 
resource assignment.
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4 On the Resource Roster page, select the student whose resource assignment you want to 
duplicate. 

If necessary, from the View dropdown, select an option to narrow the list of students.

5 From the Actions menu, click Copy Resource Assignment.

6 To assign the resource service to another student, on the Add Resource Assignment page, 
click Select Student beside the student name. In the Select Student dialog, choose 
another student and click OK.

OR

To change resource information for the same student, change the roster information such 
as the resource service, start and end dates, minutes per week, or the meeting time.

7 Click OK.

Select an option to 
narrow the student 
search.

To copy this resource 
assignment to a 
different student, click 
Select Student.

To create another 
resource assignment 
for the same student, 
change the resource 
information and click 
OK. 
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Selecting a Planning Schedule (planning 
calendar only)
When you have finished scheduling in the planning calendar and are ready for Year-End 
Processing (YEP), you must select the planning schedule you want to roll over to the active 
calendar when YEP is run. 

To select a planning schedule for the active calendar:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click Scheduling. 

3 On the Scheduling page, under Step 2, select the planning schedule you want to become 
active when YEP is run. 

4 On the Scheduling page, under Step 8, click Select Current.
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Working with Student Schedules
The Student Schedule page allows you to view and adjust individual student schedules. From 
this page, you can also assign student course requests, manually assign classes, or 
automatically generate a new schedule for individual students. 

Opening Student Schedules
You can use the Student Schedule page to view and adjust individual student schedules. 
From this page, you can also assign student course requests, manually assign classes, or use 
the Walk-in Scheduler to automatically generate a new schedule for individual students after 
school has started. 

You can open student schedules for individual students from the Student Demographics 
page, or you can go directly to the student schedule for one or more students from any 
student search results page. 
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NOTE

The Open Student>Schedules option on the Student Search Results page offers a quick way to open 
student schedules and allows you to open multiple student schedules at one time. 

Understanding the Student Schedule Page
This section provides an overview of the Student Schedule page. For detailed procedures on 
using the Student Schedule page, see “Entering Course and Alternate Requests for Individual 
Students” on page 247 and “Manually Adding, Dropping, or Transferring Classes” on 
page 329.

When you are familiar with scheduling students, you can use the brief procedures as a quick 
reference when you schedule walk-in students or change a student’s schedule. 

Task Procedure

Opening Student Schedules 
From Student Search Results

1 Log on as a school administrator.

2 Search for a student.

3 From the Student Search Results, select the students whose 
schedules you want to view. 

4 From the Actions menu, click Open Student>Schedule. 

5 If you selected more than one student, on the Student Schedule 
page, click Prev and Next to page through the open student 
schedules.
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For information about working with student records, see “Working With Student Records” on 
page 10. 

The student’s schedule shows the following information:

Field Description

View Select the term whose schedule you want to view.

When you select All Terms, this page displays all the student’s 
classes for the entire school year. You can select individual terms 
to view the student’s classes for that term only.

For full details about changes made to the student’s schedule, 
from the Actions menu, click View Change History.

Filled Scheduling Load The total scheduling load in the student’s current schedule.

Current student 
schedule, which is 
initially blank.

Click the Course Request tab 
to work with student course 
requests or click the Class 
Search tab to work with 
classes.

Show the student’s 
current scheduling 
load.

Click  to view the student’s 

schedule and click  to print 
the student’s schedule.

In the active calendar, 
click the Changes 
Effective date to 
specify when you 
want the changes to 
the student’s 
schedule to take 
effect.
If available, from the 
Change Reason 
dropdown, select the 
reason the student’s 
schedule is being 
changed.
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Show Reservation Labels By default, the student’s schedule includes any reserved periods 
assigned to the student. If you don’t want to see reservation 
labels in the list of classes, clear this checkbox. 

For more information about reservation labels, see “Reserving 
Periods in Student, Teacher, or Room Schedules” on page 149.

Term The term that the course is scheduled.

Meeting Pattern The meeting pattern defined for the class.

Class Name The class in the student’s schedule.

Click the class name to open the Class Roster page. For more 
information about class rosters, see “Working with Homeroom 
and Class Rosters” on page 349.

Teacher The teacher scheduled to teach the class.

Room The room scheduled for the class.

Details Click the icon to view details about the class (the course name 
and number and the class name and code).

Lock Lock the line to prevent any automatic process from changing it, 
such as clicking New Schedule. You can manually change locked 
items.

Changes Effective This field is only displayed in the active calendar.

Specify the effective date for the schedule changes. Default is 
today. Click the link to change the date.

For more information, see “Specifying Effective Dates for 
Schedule Changes” on page 328.

Change Reason Applies to active calendar only.

If you are working in the active calendar, the Change Reason 
dropdown appears if the district set up change reason codes. 
Change reasons may be required or optional. 

Select the reason the student’s schedule is being changed. 

If entered, the change reason is displayed on the Change History 
page for all manual changes to student schedules.

Course Request tab

New Schedule Create a new schedule for the student based on the course 
requests entered for the student and the scheduling rules and 
options defined in for the student loader. 

Each time you click New Schedule, the Student Loader creates a 
new version of the student’s schedule. 

For more information, see “Scheduling Walk-In Students” on 
page 328.

Bookmark Available after you click the New Schedule button.

Saves the current version of the student’s schedule and allows 
you to create other schedules. 

You can only bookmark one schedule. The next time you 
bookmark a schedule, any existing schedules are overwritten. 

Return to Bookmark Available after a schedule is bookmarked.

Retrieve the last bookmarked schedule.

Field Description
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Course # Course Request section.

Enter one or more course numbers that you want to add to the 
student’s course requests. 

To add one course, enter the course number and press Enter or 
click Add. 

To add multiple courses, enter all the course numbers separated 
by commas then press Enter or click Add.

Status Course Request section.

Indicates the current status of the course request in the 
student’s schedule.

This column is blank until you run Master Schedule Builder or 
until you click Save after making manual changes.

This request is scheduled, that is, there is a corresponding 
entry in the student schedule.

This request is not scheduled because all classes for this 
course are full.

This request is not scheduled because the only available 
classes for this course conflict with other courses on the 
student schedule.

This request is not scheduled because there are no classes 
created for this course.

An alternate for this request is scheduled. There is an entry 
in the student schedule for the alternate.

Course Name Course Request section.

The name of the course as defined at the district. Click the 
course name to open the Course Detail page.

Course # (in table) Course Request section.

The number of the course as defined at the district. Click the 
course name to open the Course Detail page.

Term Course Request section.

Indicates the term the student prefers for this course. The 
default is blank for no term preference.

For each term of the allowed term sets for the course, the 
options are:

• [O] – Term override. For example, if the request is for the 
second semester of a full year course.

• [P] – Term preference. For example, if the preference is to 
take a one semester course in the first semester.

Field Description
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Priority Course Request section.

Specifies the order of importance for the course to be scheduled 
for the student.

Enter a priority from 1 (highest) to 9999 (lowest). The default 
priority is 10 so you can give some courses a higher priority 
without having to change all the others. A blank priority is the 
same as 9999.

Courses with the same priority are selected randomly.

The priority is applied to required courses and electives 
separately, that is, you can have one set of priorities for required 
courses and another set for electives.

The priority also determines which alternate course the Student 
Loader tries to schedule first.

Required Course Request section.

Specifies whether the course is required or an elective.

The default value is set at the district. You can override the 
default for different students.

Required courses have higher priority than electives and are 
scheduled first.

The priority is applied to required courses and electives 
separately.

Load Factor Course Request section.

The scheduling load as defined at the district.

The total load factor for the classes in the student’s schedule is 
shown above the schedule grid.

Requested Scheduling Load Course Request section.

The total load factor for all requested required and elective 
courses.

Alternate Course # Course Request section.

Use this field to quickly enter one or more course numbers you 
want to add to the student’s alternate course requests. 

To add one course, enter the course number and press Enter or 
click Add.

To add multiple courses, enter all the course numbers separated 
by commas then press Enter or click Add.

Alternate For Course Request section.

Use this field to quickly enter one or more course numbers you 
want to add to the student’s alternate course requests. 

To add one course, enter the course number and press Enter or 
click Add. 

To add multiple courses, enter all the course numbers separated 
by commas then press Enter or click Add. 

Field Description
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Class Search tab

Add Class To add the class to the student’s schedule, select a class from the 
class search results and click this button.

From more information, see “Manually Adding, Dropping, or 
Transferring Classes” on page 329.

Drop Class To remove a class from the student’s schedule, select a class in 
the student’s schedule and click this button. 

From more information, see “Manually Adding, Dropping, or 
Transferring Classes” on page 329.

Transfer Class To transfer the student to a different class, in the student’s 
schedule, select the class you want to drop. From the class 
search results, select the class you want to add. Then click this 
button. 

From more information, see “Manually Adding, Dropping, or 
Transferring Classes” on page 329.

Status Class section.

Indicates whether the class is scheduled successfully.

This column is blank until you run Master Schedule Builder or you 
click Save after making manual changes. It is also blank when 
the class is successfully scheduled.

This class is full, that is, it has reached its capacity. If you 
use overfill then this is capacity + overfill percentage.

This class conflicts with another class on the student 
schedule.

Term Class section.

The default is blank for no term preference.

For each term of the allowed term sets for the course, the 
options are:

• [O] – Term override. For example, if the request is for the 
second semester of a full year course.

• [P] – Term preference. For example, if the preference is to 
take a one semester course in the first semester.

Meeting Pattern Class section.

The meeting pattern of the class.

Class Name Class section.

The name of the class.

Room Class section.

The room scheduled for that class.

Field Description
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Specifying Effective Dates for Schedule Changes
After school starts, if you want to change student schedules or create a new schedule for 
students who do not have a schedule, you must specify the date you want the changes to 
take effect. The date you should select depends on whether the student is new to the school 
or is an existing student and on the task you are performing. The following table indicates 
the Changes Effective date you should select for various situations:

NOTE

If you want to transfer classes when one class is in the current semester and one is in a future semester, 
you cannot use the transfer option. Use Add/Drop class instead. 

Scheduling Walk-In Students
Typically, student schedules are created in the planning calendar or early in the school year 
before grades and attendance are entered. Once grades and attendance are entered, you can 
no longer use the Student Loader to automatically create student schedules. If a student 
enrolls at your school partway into the school year, use the Walk-in Scheduler to 
automatically create a schedule based on student course requests. 

Before you use the Walk-in Scheduler to create student schedules, enter course requests for 
the student. For more information about entering course requests, see “Working with Course 
and Alternate Requests” on page 247.

To schedule walk-in students:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 Click New Schedule.

Student Type Task Changes Effective Setting

New Generate a New Schedule “First Day in School”

Add/Drop/Transfer Class “First Day in School”

Existing Generate a New Schedule “Today”, “Tomorrow”, or specify the 
date the change will take effect.

Add/Drop classes in the current 
semester

“Today”, “Tomorrow”, or specify the 
date the change will take effect.

Add/Drop classes for future semesters “First Day in School”

Transfer classes when both classes are 
in the current semester

“Today”, “Tomorrow”, or specify the 
date the change will take effect.

Transfer classes when both classes are 
in a future semester

“First Day in School”
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4 Do one of the following:

Manually Adding, Dropping, or Transferring Classes
On the Student Schedule page, you can adjust the student’s schedule by manually adding, 
dropping, or transferring classes. If you adjust the student’s schedule in the active calendar, 
you need to enter the date the change will take effect and you may be required to enter a 
reason for the change. For more information about setting the effective date, see “Specifying 
Effective Dates for Schedule Changes” on page 328.

NOTE

If the class assignment changes result in any class exceeding their defined capacity, you must have the 
Classes - Exceed Capacity permission set to “Yes” to make the changes. 

After transferring classes, you can transfer grades and reassign attendance to remove all 
record of the student ever being in the dropped class. For more information about 
transferring grades and attendance, see “Transferring Grades and Reassigning Attendance” 
on page 335.

NOTE

You cannot drop or transfer from a class if attendance has been entered after the drop or transfer 
effective date. 

To adjust student schedules:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

To Do this

Accept the generated 
schedule

• Click Save.

Attempt to generate a 
different schedule

• Click New Schedule again.

Store the generated 
schedule and attempt to 
generate a different schedule

• Click Bookmark and then click New Schedule again.

You can only bookmark one schedule. Each time you click 
Bookmark, the current schedule overwrites the stored 
schedule.

Return to a bookmarked 
schedule

• Click Return to Bookmark.

Save some classes in the 
generated schedule and 
attempt to reschedule other 
classes

1 For each class you want to save, in the Lock column, select the 
check box. 

2 When you have locked all the classes you want to save, click 
New Schedule again.
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3 On the Student Schedule page, do one of the following:

For a description of the Student Schedule page, see “Understanding the Student Schedule 
Page” on page 322.

Searching for Classes for Multiple Courses
When you are manually scheduling students into classes to fill in an incomplete schedule, you 
can use the Detail tab to search for classes for multiple courses. In this way, the search 
results show the classes available for all selected courses on one page, so you can select the 
most appropriate classes for each course.

To search for classes for multiple courses:
1 Log on as a school administrator. 

2 Open the student’s schedule.

To Do this

Add a class to the student’s 
schedule

1 If required, click the Changes Effective date to specify the date 
you want the changes to take effect.

2 If available, from the Change Reason dropdown, select the 
reason the student’s schedule is being changed.

3 Click the Classes tab.

4 Search for and select the class you want to add.

5 Click Add Class. 

Remove a class from the 
student’s schedule

1 If required, click the Changes Effective date to specify the date 
you want the changes to take effect.

2 If available, from the Change Reason dropdown, select the 
reason the student’s schedule is being changed.

3 From the student’s schedule, select the class you want to 
remove. 

4 Click Drop Class.

Transfer the student from a 
class into a different class

1 If required, click the Changes Effective date to specify the date 
you want the changes to take effect.

2 If available, from the Change Reason dropdown, select the 
reason the student’s schedule is being changed.

3 Click the Classes tab. 

4 Search for and select the class you want to add.

5 In the student’s schedule, click the class you want to remove 
from the student’s schedule. 

6 Click Transfer Class.
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3 Click the Class Search tab. 

4 Under Class Search, click the Detail tab. 
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5 On the Detail tab, enter the following information:

The following figure shows the search options available on the Detail tab:

6 Click Add Criteria.

7 Repeat Steps 5 and 6 to add as many courses as you want to include in the search 
results. 

Field Description

Category Select the category of the properties you want to search by; for 
example, to search by course number, select “Course”.

First dropdown Select the property you want to search for; for example, to 
search for course numbers, select “Course Number”.

Middle dropdown Select the operator; for example, to search for part of a course 
number, select “Contains”. To search for an exact course number, 
select “Equals”.

Third dropdown Enter the value you want to search for; for example, the course 
number.

To search for classes by 
course number, select 
“Course”.

To search for classes by 
course number, select 
“Course number” and 
specify the course number 
you want to find.

Click Add Criteria to add the 
criteria to the list of search 
criteria.
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8 Under Search Criteria, click Any Criteria. 

When you select Any Criteria, the search results include records that contain any of the 
criteria, that is, it creates an OR statement. If you select All Criteria, the search results 
include records that match all the listed criteria, that is, it creates an AND statement. 

9 When you have entered all the course numbers you want to search for, click Search. 

10 The search results include classes for all the entered courses. 

To search for records that 
match any of the entered 
criteria, click Any 
Criteria.

Shows the courses included in the 
search results.

Use the scroll bar to see more 
classes in the list.

Lists the possible classes for the 
entered courses.

Shows the student’s current 
schedule.
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Overview of Transferring Grades and Reassigning 
Attendance
If a student drops or transfers classes, you can transfer grades and reassign attendance to 
remove all record of the student ever being in the dropped class. After you transfer grades 
and reassign attendance, the dropped class is no longer included on the student’s report 
cards or transcripts. 

For example, a student finds their Algebra class too difficult and transfers to General Math. 
Algebra was offered in period 1 and General Math is in period 2, so they also transferred from 
their period 2 English class to a period 1 English class. You can use the transfer grades 
feature to remove all record of the Algebra and period 2 English classes from the student’s 
schedule. You have several options for handling grades. In this example, you choose to 
transfer the grades from Algebra to General Math and from period 2 English to period 1 
English. 

If your school takes class attendance, you also need to specify how you want to handle the 
attendance for the changed classes. Again, you have several options. In this example, you 
choose to reassign attendance to the new classes according to the periods they are in, so 
attendance entered for the period 1 Algebra class is reassigned to period 1 English and the 
period 2 English attendance is reassigned to period 2 General Math. 

You can only transfer grades and reassign attendance if the following requirements are met:

• The classes were added or dropped with the same effective date.

NOTE

If you use the Transfer button rather than the Add and Drop buttons, the added and dropped classes 
always have the same effective date.

• The dropped class has the same scheduling and grading structure as the added class. For 
example, you cannot transfer grades and reassign attendance from a full year class to a 
semester class. 

• If both grades and attendance were entered for the dropped class, the attendance is 
reassigned or cleared at the same time the grades are transferred.

• To reassign attendance, the student’s new schedule has a class scheduled in the same 
period as the dropped class. For example, if the student drops a period 1 Math class and 
his new schedule does not have a period 1 class, you cannot reassign the attendance 
entered for the period 1 Math class. You can clear attendance for this class and manually 
enter attendance. 

Transferring grades and attendance is a two-part process:

1 Add and drop or transfer classes on the student’s schedule. For more information, see 
“Manually Adding, Dropping, or Transferring Classes” on page 329.

2 Open the Transfer Grades page and specify how you want to handle grades and 
attendance for the dropped classes. For more information, see “Transferring Grades and 
Reassigning Attendance” on page 335.
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For more information about how you can transfer grades in specific scenarios, see 
“Transferring Grades and Attendance - Examples” on page 338.

NOTE

After transferring grades and attendance, make sure you recalculate grades, credits, and GPAs for the 
student. 

Transferring Grades and Reassigning Attendance
After adding and dropping classes or transferring classes, you can open the Transfer Grades 
page and specify how you want to handle the grades and attendance for dropped classes.

You have the following options for handling the grades entered for the dropped class:

Attendance is associated with the period the class is scheduled in, not with the class. When 
you reassign attendance, it is reassigned to the class that is offered in that period in the new 
schedule. For example, suppose a student transfers from Math in Period 1 to Math in Period 2 
and English in Period 2 to English in Period 1. Prior to the transfer, the student was absent for 
three Math classes and two English classes. If you reassign attendance, the student’s records 
would show three absences for English and two absences for Math. If you want to keep 

Option Description

Do nothing Leaves the grades with the dropped class. 

If grades have been entered, the student’s record continues to 
include the dropped class, and the class is printed on their report 
cards and transcripts. 

Use this option if grades have not been entered for the dropped class 
or if it is part of a multi-period class and you have transferred the 
grades from another period of the class. For more information, see 
“Transferring Grades and Attendance - Examples” on page 338.

Move The grades are transferred from the dropped class to the added 
class. 

If attendance has not been entered for the dropped class or the 
attendance is reassigned, the dropped class is no longer included in 
the student’s records and does not print on their report cards or 
transcripts. 

Use this option if classes are similar and the grades are relevant to 
the added class. For example, when transferring from Honors English 
to Regular English.

Clear The grades entered for the dropped class are deleted. 

If attendance has not been entered for the dropped class or the 
attendance is reassigned, the dropped class is no longer included in 
the student’s records and does not print on their report cards or 
transcripts. 

Use this option if the classes are not similar, the grades would not 
make sense for the added classes and you want to manually enter 
grades. For example, when transferring from Art Exploration to 
Biology. You also use this option when transferring between two 
single-period classes and a multi-period class. For more information, 
see “Transferring Grades and Attendance - Examples” on page 338.
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attendance values with the class rather than reassigning them to the period, you can clear 
the attendance values for the dropped class and manually enter the attendance for the added 
classes. 

You have the following options for handling the attendance entered for the dropped class:

To specify how grades are handled for the dropped class:
1 Open a student schedule.

2 On the student schedule page, from the Actions menu, click View Change History.

Option Description

Do nothing Use this option if the class is not attendance bearing or if attendance 
has not been entered.

If attendance has been entered, when you transfer grades, you must 
either clear or reassign the attendance.

Reassign Reassigns the attendance entered for the dropped class to the class 
scheduled in that period in the new schedule. 

If grades have not been entered or are transferred or cleared, the 
dropped class is no longer included in the student’s records and does 
not print on their report cards or transcripts. 

Use this option if you want to keep the attendance with the period 
for which it was entered. 

Clear Deletes the attendance entered for the dropped class. 

If grades have not been entered or are transferred or cleared, the 
dropped class is no longer included in the student’s records and does 
not print on their report cards or transcripts. 

Use this option if you want to manually enter attendance for the 
added class. 
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3 On the Schedule Change History page, from the Actions menu, click Transfer Grades.

The Transfer Grades page displays a list of dropped and added classes. Click a row to 
change settings for a dropped class.

4 On the Transfer Grades page, for dropped classes, in the Transfer To column, select the 
added class you want to transfer grades to.

NOTE

If the class was transferred or if only one class was added on the same effective date as the dropped 
class, you do not need to specify a class to transfer the grades to. 

5 In the Grades column, select one of the following options:

To Select

Take no action with grades, e.g., use this option if the class is not graded 
or if the grades have not been entered. 

Do Nothing

Transfer the grades from the dropped class to the selected class that was 
added on the same effective date.

Move

Delete the grades entered for the dropped class without transferring these 
grades to another class. 

Clear

The Transfer To column includes courses added with 
the same effective dates as the dropped course. By 
default, the field shows the first added class in 
alphabetical order. Click the row to select a class.

If classes were 
rescheduled using 
the Transfer button
the Transfer To 
column 
automatically 
selects the class 
added during the 
transfer. You canno
change the 
selection.
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6 In the Attendance column, select one of the following options:

7 Click Transfer.

When the transfer is complete, the selected classes are removed from the list of added 
and dropped classes and all record of the dropped class is removed from the student’s 
change history. 

Transferring Grades and Attendance - Examples
The following table illustrates how you might handle grades and attendance when adding and 
dropping different types of classes: 

To Select

Take no action with attendance, e.g., use this option if the class is not 
attendance-bearing or if attendance has not been taken. 

Do Nothing

Reassign the attendance from the dropped class to the class now being 
offered in that period. For example, if the student transfers from a period 2 
Math class and now has a period 2 English class, attendance is reassigned 
from Math to English and kept with the same period. 

Reassign

Delete the attendance entered for the dropped class without transferring 
the attendance to another class. 

Clear

Transfer From Transfer To Description

Single-period 
class, e.g., 
Algebra

Single-period class, 
e.g., General Math

When a student transfers to a different class, the change 
often affects other classes in the student’s schedule. For 
example, the student finds Algebra too difficult so they 
transfer to General Math, but General Math is offered in a 
different period (P3) so they must change other classes in 
their schedule, such as transferring from Period 3 Art to 
Period 4 Art. You can transfer grades and reassign 
attendance for these classes, as shown below: 
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Multi-period 
class, e.g., Team 
Sports-1

2 single-period 
classes, e.g., PE-1 
and Art-4

When you transfer from a class offered in multiple periods, 
the class appears on multiple rows on the Transfer Grades 
page (one row for each period in which the class is 
offered). The multi-period class must be selected as the 
Transfer From class for two Transfer To classes. For 
example, a student is on the football team and takes Team 
Sports-1 (a multi-period class). They are cut from the 
football team and have to transfer to a regular PE class (a 
single-period class) and another elective (Art-4). 

The grades for the multi-period class can only be 
transferred to one of the added classes. For example, you 
could transfer the grades from Team Sports-1 to PE-1. The 
Grades column for the Art-4 class must be set to “Do 
Nothing”. If you clear or reassign attendance for a 
multi-period class, all the periods for the class must have 
the same attendance option, i.e., all set to reassign or all 
set to clear. 

2 single-period 
classes, e.g., PE-
1 and Art-4

Multi-period class, 
e.g., Team Sports-1

If a student transfers into a multi-period class from two 
single-period classes, the multi-period class must be 
selected as the Transfer To class for both Transfer From 
classes. You can transfer grades from one of the single-
period classes to the multi-period class. The Grades 
column for the other single-period class must be set to 
Clear. If you clear or reassign attendance for a multi-period 
class, all the periods for the class must have the same 
attendance option, i.e., all set to reassign or all set to clear. 

Transfer From Transfer To Description
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Viewing an Audit Trail of Changes to Grades and 
Attendance
You can use audit trails to query grade transfers and attendance reassignments, along with 
other changes to student information. Audit trails are time-stamped records of user activity 
in Chancery SMS.

When you transfer grades or reassign attendance for class changes, Chancery SMS records 
the grade and attendance changes in the Audit Log. The Audit Log also keeps a record of the 
affected grades and any non-default attendance. For example, if you clear the grades for a 
dropped course, the Audit Log indicates that the grades were cleared and shows the grades 
that were entered for the dropped course. If you reassign attendance, the Audit Log indicates 
that attendance was reassigned and shows the non-default attendance values associated 
with the period. 

For more information, see “Using Audit Reports” in the Chancery SMS District Administration 
Guide.

To view audit trail records for grade transfers:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click School Setup.

3 On the School Setup page, under Audit, click Audit Log.

4 On the Audit Log page, from the Type dropdown, click Transfer Grades.

5 To select the date range in which to search, click the appropriate calendar icon.

If needed, enter the name of a staff member, a district’s student ID number, or the social 
security number of a student to narrow your search.

Class scheduled 
with a full-year 
term set

Class scheduled 
with a semester 
term set

Not supported.

At this point, you cannot transfer grades and attendance 
between courses with different scheduling structures. 

Class using a 
letter grade 
grading table

Class using a 
numeric grade 
grading table

Not supported. 

You can only transfer grades and attendance between 
classes that use the same grading structure, i.e., they use 
the same grading table and grading period set.

Transfer From Transfer To Description
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6 Click Search. 

The search results display the Audit Log records for the search criteria.

Grades cleared

Grades transferred

Shows the grades entered 
for the dropped class.
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7 To preview the Audit Log, from the Actions menu, click Print.

The PDF Viewer opens in a new window.

8 Close the PDF Viewer.

To view audit trail records for grade transfers:
1 Log on as a school administrator. 

2 In the control bar, under Admin, click School Setup.

3 On the School Setup page, under Audit, click Audit Log.

4 On the Audit Log page, from the Type dropdown, click Transfer Grades.

5 To select the date range in which to search, click the appropriate calendar icon.

If you need to narrow your search, enter the name of a staff member, a district’s student 
ID number, or the social security number of a student.
342 Working with Student Schedules
Overview of Transferring Grades and Reassigning Attendance



Chancery SMS Scheduling Guide
6 Click Search. 

The search results display the Audit Log records for the search criteria.

7 To preview, print, or save the Audit Log, from the Actions menu, click Print.

The PDF Viewer opens in a new window.

Attendance cleared

Shows the dates that 
non-default attendance 
was entered and the 
values entered.

Attendance reassigned 
to new period
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8 If desired, click Save or Print.

9 Close the PDF Viewer.

Locking Classes in Student Schedules
After a student is assigned to a class, you can lock that class on their schedule. If a class is 
locked, automatic scheduling processes, such as the Student Loader and Walk-in Scheduler, 
will not remove that class from the student’s schedule. 

NOTE

If you are using automatic scheduling processes, such as the Walk-in Scheduler, do not lock classes unless 
you are certain the student must be in the specified class. Locking classes prevents the scheduler from 
changing the class assignment and limits its ability to generate a full schedule for students. 

For a description of the Student Schedule page, see “Understanding the Student Schedule 
Page” on page 322.

To lock a class in a student’s schedule:
1 Log on as a school administrator. 

2 Open the student’s schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 In the student’s schedule, select the checkbox in the Lock column for the class you want 
to lock. 

4 Click Save.

To lock all classes in the student’s schedule:
1 Log on as a school administrator. 

2 Open the student’s schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 From the Actions menu, click Lock All Classes. 

All scheduled classes in the student’s schedule are locked. 

To unlock all classes in the student’s schedule:
1 Log on as a school administrator. 

2 Open the student’s schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 From the Actions menu, click Unlock All Classes. 

All scheduled classes in the student’s schedule are unlocked. 
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Adding and Deleting Resource Assignments
From the Student Schedule page, you can add or delete resource assignments for individual 
students. Assign resource services to students who require extra attention because they may 
be struggling or advanced. For example, resource services include Remedial Reading and 
Math, Speech Therapy, Gifted and Talented Enrichment, and so on.

Before you add a resource assignment to a student schedule, you must set up resource 
services. For more information about setting up resource services, see “Setting Up Resource 
Services (active calendar only)” on page 313.

If you want to assign the same resource service to multiple students, use the Resource 
Roster. For more information about assigning resource services to multiple students, see 
“Assigning Resource Services to Students” on page 314.

To add a resource assignment to a student’s schedule:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 From the Actions menu, click Add Resource Assignment.

4 On the Add Resource Assignment page, enter the required resource service information. 

5 Click OK.

The Student Schedule page displays the student’s revised schedule. The Resource 

Assignment icon ( ) indicates resource assignments.

To delete a resource assignment from a student’s schedule:
NOTE

When you delete a resource assignment, you delete all record of the assignment. If you want to end a 
resource assignment without deleting the entire record, adjust the End Date for the resource 
assignment.

1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 Select a Resource Assignment.

4 From the Actions menu, click Delete Resource Assignment.

5 Click OK.

The Student Schedule page displays the student’s revised schedule. 

Viewing Change History
You can view a history of changes for each class a student has enrolled in. For example, you 
can view when a student has transferred from one class to another or when they changed 
homerooms. For each change, you can specify the effective date, select a change reason, 
and include a comment.
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The schedule change history is only available in the active calendar and only shows changes 
over time. For example, if a class is added and dropped as of the same day, the change is not 
recorded in the change history. You can undo some schedule changes. For more information 
about undoing schedule changes, see “Reversing Student Schedule Changes” on page 347.

The change history does not include changes made by automatic scheduling processes such 
as the Student Loader or Walk-in Scheduler.

To view a student’s change history:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 On the Student Schedule page, from the Actions menu, click View Change History.

The Schedule Change History page displays a list of the changes made to the student’s 
schedule.

4 To change the effective date, change reason, or comment for a specific schedule change, 
click the link in the Start column or select the line and click Edit.

To see the change 
reason description, 
pause the pointer 
over the change 
reason code.
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5 On the Edit Change page, make the necessary changes and click OK.

Reversing Student Schedule Changes
From the Change History page, you can reverse a change made to the student’s schedule. 
You can only undo the last change within each set of changes. If a change can be undone, a 
“Y” appears in the Can Undo column. 

To undo a change to the students schedule:
1 Log on as a school administrator. 

2 Open a student schedule. 

For more information about opening student schedules, see “Opening Student Schedules” 
on page 321.

3 On the Student Schedule page, from the Actions menu, click View Change History.

4 Select the change you want to reverse. 

There must be a “Y” in the Can Undo column.

5 Click Undo Last or Undo Selection. Click OK.
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Working with Homeroom and Class 
Rosters
Rosters provide a list of students assigned to a homeroom or class. You can display the roster 
and make adjustments, if necessary, from the roster page. 

Viewing Class Rosters
1 Log on as a school administrator. 

2 In the control bar, under Class, click Classes.

To view the class roster, click 
the class name or click the 
roster icon.
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3 On the Classes page, click the class you want to view.

OR

On the Classes page, click the Roster icon ( ) for the class you want to view.

4 On the Class Roster page, you can change the information displayed on the screen. For 
more information about changing the roster display, see “Changing the Information 
Displayed on Roster Pages” on page 351.

Viewing Homeroom Rosters
1 Log on as a school administrator. 

2 In the control bar, under Class, click Homerooms.

To open a student record, click the 
student name.

To view the homeroom roster, 
click the homeroom name or 
click the roster icon.
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3 On the Homerooms page, click the homeroom you want to view.

OR

On the Homerooms page, click the Roster icon ( ) for the homeroom you want to view.

The Roster page opens.

4 On the Homeroom Roster page, you can change the information displayed on the screen. 
For more information about changing the roster display, see “Changing the Information 
Displayed on Roster Pages” on page 351.

Changing the Information Displayed on Roster Pages
To assist you in adjusting homeroom and class rosters, you can change the student 
information displayed on class and homeroom roster pages. You can display incoming or 
withdrawn students and you can change the columns included on the page. 

To change the information displayed on the screen:
1 Log on as a school administrator. 

2 Open a class or homeroom roster.

For information about opening a class roster, see “Viewing Class Rosters” on page 349. 
For information about opening homeroom rosters, see “Viewing Homeroom Rosters” on 
page 350.

3 From the Edit menu, click Choose Columns > Class Search Results.

4 In the Available Columns list, select the columns you want to display, and then click  
to move them to the Selected Columns list.
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5 Use the  and  buttons to set the display order.

6 Click OK.

To include withdrawn or incoming students:
1 Log on as a school administrator.

2 Open a class or homeroom roster. 

For information about opening class rosters, see “Viewing Class Rosters” on page 349. 
For information about opening homeroom rosters, see “Viewing Homeroom Rosters” on 
page 350.

3 From the Edit menu, click Show Incoming Students.

OR

From the Edit menu, click Show Withdrawn Students.

Modifying Homeroom and Class Rosters
At the beginning of the school year, finish your schedule by transferring students to correct 
homeroom, class, and subject assignments. You can adjust the rosters for all classes and 
subjects to incorporate team teaching or group students by ability. For more information 
about adjusting a roster at the beginning of the school year, see “Transferring Homerooms” 
on page 355.

During the school year, transfer students to assign them to a new class or subject, as 
required. For example, a group of students might take Music for the first half of the year and 
Art for the second half of the year. For more information about transferring students during 
the school year, see “Changing Class Rosters” on page 352.

Changing Class Rosters
After school starts, you may need to adjust class rosters from time to time. For example, you 
may need to adjust a class roster to complete the following tasks:

• Assign walk-in students to a class.

• Find the best homeroom for a student and manually adjust a student’s schedule.

• Schedule a student to receive or stop receiving resource services partway into the school 
year.

• Adjust a student’s schedule based on individual student needs, such as moving a student 
to a faster or slower paced Math class. This change can be made at the start of the school 
year or partway through the school year.

NOTE

If the class assignment changes result in any class exceeding their defined capacity, you must have the 
Classes - Exceed Capacity permission set to “Yes” to make the changes. 

To add, drop, or transfer students:
1 Log on as a school administrator. 

2 Open a class roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 349.
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3 On the Class Roster page, do one of the following:

4 If you are working in the active calendar, in the Class Change Options dialog, specify the 
date you want these students to be added, enter a comment, and, if available, select a 
change reason. Click OK.

5 Click Save.

Adding Groups of Students to Other Classes
You can select a group of students and add them to several classes, one after another. For 
example, after you add students to the first term Music class, you can add the entire group of 
students to the second term Art class.

NOTE

If the class assignment changes result in any class exceeding their defined capacity, you must have the 
Classes - Exceed Capacity permission set to “Yes” to make the changes. 

1 Log on as a school administrator. 

2 Open a class roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 349.

3 On the Class Roster page, select the students you want to add to another class.

To Do this

Add a student to the class 1 From the Actions menu, click Add Student. 

2 In the Select Student dialog, select the students you want to 
add. 

3 Click OK.

Drop a student from the 
class

1 Select the students you want to drop. 

2 From the Actions menu, click Drop Students.

Transfer students to a 
different class

1 Select the students you want to transfer. 

2 From the Actions menu, click Transfer Students. 

3 On the Transfer to Class page, select the class you want to 
transfer them into. Click OK.

If you are working in the active calendar, the 
Change Reason dropdown appears if change 
reasons are set up at the district. Change 
reasons may be required or optional. 
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4 From the Actions menu, click Add Another Class.

5 From the Class dropdown, select the class for these students. Click OK.

6 If you are working in the active calendar, in the Class Change Options dialog, specify the 
date you want these students to be added, enter a comment, and, if available, select a 
change reason. Click OK.

Assigning Groups of Students to Classes
From a class or homeroom roster, you can select a group of students and assign them to 
specific classes. 

NOTE

If the class assignment changes result in any class exceeding their defined capacity, you must have the 
Classes - Exceed Capacity permission set to “Yes” to make the changes. 

Shows the number of students 
selected.

If you are working in the active calendar, the 
Change Reason dropdown appears if change 
reasons are set up at the district. Change 
reasons may be required or optional. 
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To assign groups of students to classes:
1 Log on as a school administrator.

2 Open a class or homeroom roster. 

For more information about opening class rosters, see “Viewing Class Rosters” on 
page 349. For more information about opening homeroom rosters, see “Viewing 
Homeroom Rosters” on page 350.

3 On the class or homeroom roster, select the students you want to assign to classes. 

4 From the Actions menu, click Assign > Classes.

5 On the Assign Classes page, in the Class Search panel, search for classes you want to add 
to the students’ schedules.

6 If you are working in the active calendar and change reasons are set up at the district, in 
the Change Reasons dropdown, select a reason for the change.

7 In the Search Results panel, select the classes you want to add. Click Apply.

Transferring Homerooms
You can transfer students between homerooms from the Roster page. This method is 
particularly useful at the beginning of the school year when you are setting up schedules. 

Indicates the number of students 
whose schedules will be changed.
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To transfer students to different homerooms:
1 Log on as a school administrator. 

2 Open a homeroom roster.

For more information about opening homeroom rosters, see “Viewing Homeroom 
Rosters” on page 350.

3 On the Roster page, select the students you want to assign to another homeroom. From 
the Actions menu, click Transfer Homeroom.

4 On the Transfer Homeroom page, select the new homeroom you want to transfer the 
selected students to.

5 Click OK.

Check to see if the 
homeroom has enough 
space to accommodate 
the selected students.
An exclamation mark 
indicates the homeroom 
does not have enough 
space to accommodate 
the selected students.

The numbers correspond to 
the Ethnic Categories.
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6 If you are working in the active calendar, in the Change Options dialog, specify the date 
you want these students to be added, enter a comment, and, if available, select a change 
reason. Click OK.

If you are working an the active calendar, the 
Change Reason dropdown appears if change 
reasons are set up at the district. Change reasons 
may be required or optional. 
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